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About On Demand Migration

Quest® On Demand Migration cloud application lets you create migration projects to perform the following:

Accounts and User Data Migration

Account migration

» Analyze the structure of your Microsoft Azure Active Directory and get reports on the problems that might
adversely affect the migration.

« Migrate users, groups, and the related information between tenants.

» Migrate hybrid accounts synchronized with on-premises AD

» Provide robust project management interface and in-depth progress reporting.

« Provide coexistence services for transition period before migration process will be completed:

« Address Rewrite Service to change the message header as if the target mailbox is already
used by sender.

Mail migration

« Migrate Microsoft 365 mailboxes and share free/busy information between tenants.

Content Migration

OneDrive for Business
« Analyze OneDrive for Business on your source tenant
« Transfer OneDrive for Business data and settings.

Public Folders

« Analyze Public Folders on your source tenant and get hierarchy information, content information and email
addresses for mail-enabled public folders

« Migrate Public Folders and the related information between tenants

« Provide robust Public Folders migration management interface and in-depth progress reporting.

Microsoft SharePoint

« Analyze SharePoint on your source tenant

« Map existing SharePoint sites (previously site collections) in the source and target tenants for
further processing

On Demand Migration User Guide
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« Migrate SharePoint sites (previously site collections) to the target tenant

« Provide robust SharePoint migration management interface and in-depth progress reporting.
Microsoft Teams

« Analyze Microsoft Teams on your source tenant

» Create Microsoft 365 Groups with Teams functionality on the target tenant
« Provision Microsoft Teams on the target tenant

» Migrate Microsoft teams including content to the target tenant

» Provide robust Microsoft Teams migration management interface and in-depth progress reporting.
Power Bl

« Analyze Power Bl content on your source tenant
¢ Assign Connection Profiles

o Match Gateways

« Migrate Connections

« Migrate Workspaces

» Provide robust Power Bl migration management interface and in-depth progress reporting.

On Demand Migration is a part of Quest On Demand — a single SaaS console for managing your cloud environment
in Microsoft Azure. For more information, see Quest On Demand documentation.

Signing up for Quest On Demand

To get access to On Demand Migration, you must sign up for the Quest On Demand service.

1. Go to the web page quest-on-demand.

2. Onthe Welcome to Quest On Demand page, click Sign in with Microsoft. See Signing in to On Demand
for more information.

i NOTE: Signing in using your Microsoft MFA-enabled account

If your organization requires multi-factor authentication and you receive an authorization error, your
conditional access policy may not be configured correctly. You can take one of two actions:

« Contact your IT administrator to deactivate MFA during migrations.

« Contact "Azure Identity" support for help with configuring conditional access policies.

3. Accept the Software Transaction Agreement before using this product.

4. As part of the login process with Microsoft Entra ID, you must consent to the set of minimal permissions
required by the Quest On Demand application.

5. Create an organization. See Creating an organization for detailed steps.

On Demand Migration User Guide
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Product Licensing

IMPORTANT: Your Azure subscription must have an E3 or E5 enterprise plan. For more information see
Microsoft 365 Enterprise plans.

Use of this software is governed by the Software Transaction Agreement found at www.quest.com/legal/sta.aspx
and the SaaS Addendum at www.quest.com/legal/saas-addendum.aspx. This software does not require an
activation or license key to operate.

Trial subscriptions are available. Visit Quest® On Demand Migration page for more information and

pricing: https://www.quest.com/products/on-demand-migration/

In this topic:

Starting a trial subscription
Purchasing a commercial subscription
Viewing the license report

Exporting licenses consumption data
Searching for licenses consumed

Viewing the license summary

To start a trial subscription

> 0N

5.

NOTE: You can use the product free during the 30-day trial period with a limited number of users that can be
migrated.

Open https://www.quest.com/products/on-demand-migration/.

Scroll down to the module you want to try and click Try Online.

To proceed you should read and accept license agreement.

Select Sign In for your Free Trial option to use your existing Quest account, or Create a Trial account
option to create a new account.

You will receive an email containing step by step instructions on starting your trial period for the product.

The following table shows the trial license limits:

Feature License Limitation

Accounts 5 Accounts none

Email 5 Mailboxes 5 GB content per mailbox

OneDrive 5 Accounts 256 files or 256 MB per OneDrive account

SharePoint 5 SP sites 5 GB content per SharePoint site. ODMSP will not discover sites with

more than 5 GB.

Teams / M365 5 Teams or 5 GB content per Teams or M365 Groups
Groups Groups
1x1 Chats 5 Accounts The most recent 2 conversations and messages up to 30 days per

On Demand Migration User Guide
About On Demand Migration


https://www.microsoft.com/en-us/microsoft-365/compare-microsoft-365-enterprise-plans
http://www.quest.com/legal/sta.aspx
http://www.quest.com/legal/saas-addendum.aspx
https://www.quest.com/products/on-demand-migration/
https://www.quest.com/products/on-demand-migration/

Feature License Limitation

conversation

Power BI 5 Accounts none

To purchase a commercial subscription

1.
2.
3.

Open https://www.quest.com/products/on-demand-migration/.
Click Request Pricing and fill in the necessary details.

Click Contact Sales to request pricing and get help with your business needs.

The product licensing is based on the number of unique source accounts processed by the migration tasks. The
licenses are only consumed once the migration task is started.

The following object types do not consume any license,

Group mailboxes
AD Groups
Contacts
Exchange resource mailboxes
public folder mailboxes
room mailboxes or equipment mailboxes
shared mailboxes
Guest accounts
Computer accounts
NOTE: The license is permanently assigned to the source account may only be used for one migration

project, and you can use this account in any number of tasks (migration, re-matching, etc.) from one
environment to another environment.

The matching task will result in the error message shown in the image below, in case the number of users in
the task exceeds the number of available licenses.

Q. Todeym 75 Firled 12 maTEn BT Azgownt M Q Failed to match accounts

For commercial licenses, there are no content migration data limits for OneDrive, SharePoint, mailbox and
public folders.

To view the license report

License consumption data is available as you work through your migration project.

On Demand Migration User Guide
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5.

NOTE:License data before October 18th 2022 displays only the Licensed user email and the
corresponding Consumed On column value indicates the date when the data was uploaded.
Log in to Quest On Demand and choose an organization if you have set up multiple organizations.

From the navigation pane, click Migrate > Projects to open the migration dashboard. You must create at
least one project to view the dashboard.

Click View License Report to open the License Report workspace.
Click List View to open the list of consumed licenses. The columns in the table are as described below:
« Consumed On - date and time the license was consumed.
« Signed-in user - user name of the person who consumed the license.
» Licensed user email - User Principal Name (UPN) of the signed-in user
« Task name - name of the task that consumed the license.
« Task type - type of task that consumed the license
« Project - name of the project where the license was consumed.

Click Edit Columns to show or hide columns in the list.

To export licenses consumption data

1.
2.

Log in to Quest On Demand and choose an organization if you have set up multiple organizations.

From the navigation pane, click Migrate > Projects to open the migration dashboard. You must create at
least one project to view the dashboard.

Click View License Report to open the License Report workspace.
Click List View to open the list of consumed licenses.

Select the rows that you want to export. Then click Export. A CSV file will be downloaded to your default
download folder.

Open the downloaded CSV file to view the exported information.

To search for licenses consumed

Log in to Quest On Demand and choose an organization if you have set up multiple organizations.

From the navigation pane, click Migrate > Projects to open the migration dashboard. You must create at
least one project to view the dashboard.

Click View License Report to open the License Report workspace.
You can search for consumed licenses in two ways:
Use the following predefined filters:

a. License Consumption - filters the list based on the following consumption periods: Last 7 days,
Last 30 days, All

b. Task Type -filters the list based on the selected task type. The following values are available:
Account Migration, Mail Migration, OneDrive Migration, Teams, Chats, All

-0r-

c. Enter the full or partial name of the user in the search field. Click Search. The list of licenses
consumed by the user is displayed.

On Demand Migration User Guide
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To view the license summary

1. Login to Quest On Demand and choose an organization if you have set up multiple organizations.

2. From the navigation pane, click Migrate > Projects to open the migration dashboard. You must create at
least one project to view the dashboard.

3. Click View License Report to open the License Report workspace.

4. Click Summary to open the summary view of consumed licenses.

5. The two report tiles contain the following information:

a. Licenses Consumed

Last 7 days - number of licenses consumed in the previous 7 days.
Last 30 days - number of licenses consumed in the previous 30 days.

All - total number of licenses consumed.

b. Licenses

Total ODM licenses - total number of licenses from active migration subscriptions only.

Used ODM licenses - total licenses used that include active and expired migration
subscriptions.

Total Teams only licenses - total Teams migration licenses from active migration
subscriptions only.

Used Teams only licenses - total Teams licenses used that include active and expired
migration subscriptions.

Reserved by matches - number of licenses reserved but not consumed after accounts in
the source tenant are matched with accounts in the target tenant. You can release the
reserved licenses when you unmatch the accounts using the Clear matching task.

Organizations and Regions

When you sign up for the On Demand service for the first time, you create an organization and you are granted the
On Demand Administrator role. You can add additional organizations and administrators.

For more information about managing your organization see Managing organizations and regions in the On
Demand Global Settings User Guide.

Some common actions with Organizations are reproduced here for your reference:

» Creating an organization

« Switching to another organization

+ Renaming an organization

« Deleting an organization

On Demand Migration User Guide
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Creating an organization
1. Signinto Quest On Demand.

2. Ifyou have not yet created an organization, click Create Organization.

No Organizations Created

Before you begin either create an organization or ask to be invited to one.

Create Organization

If you have created one or more organizations, the Choose an Organization page opens. Click Create New
Organization.

If you have already selected an organization, click your email address at the top right-hand corner of the
page and the select Create Organization.

3. Inthe Create Organization page, specify the following information:
« Organization Name - name of your organization. For example, Big Box Inc.

+ Deployment Region - A Microsoft Azure region or geographic area where data centers are
deployed. Not all On Demand modules are available in all regions.

4. Click Create Organization.

Switching to another organization

If you have multiple organizations associated with your email address, you can select an organization from the
Choose an Organization page when you sign in. If you have already selected an organization but want to work with
another organization, you can switch to another organization.

1. Click your email address at the top right-hand corner of the page.
2. Select Switch Organization. The Choose an Organization page opens.

3. Highlight and click the organization to which you want to switch.

Renaming an organization

You can rename the organization to which you are currently signed in. You must be an On Demand Administrator to
rename an organization.

1. Sign in and select the organization that you want to change.

2. Click your email address at the top right-hand corner of the page.
3. Click the organization name. The Edit Organization page opens.
4. Inthe Organization Name field, enter the new name.
5

Click Update Organization Name. The organization name is updated.

Deleting an organization

Deleting an organization cannot be undone.

On Demand Migration User Guide
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1. Sign in and select the organization that you want to change.
Click your email address at the top right-hand corner of the page
Click the organization name. The Edit Organization page opens.

Click Delete Organization. A confirmation page opens.

o ~ w0 D

Select the following check boxes to confirm that you understand the impact of deleting an organization.
« All tenants will be removed
o All user information will be lost

6. Click Delete Organization.

Roles

Quest On Demand uses the Role-based Access Control (RBAC) security policy that restricts information system
access to authorized users. Subscribers can create specific roles based on job functions, with the permissions to
perform needed operations on the assets of the organization. When users are assigned to On Demand roles, they
inherit the authorizations or permissions defined for those roles. RBAC simplifies permission administration for
subscribers because permissions are not assigned directly to every user (which can be a significant number of
individuals for mid- to large-size organizations) but are instead acquired through role assignments.

The following are some key Quest On Demand and tenant roles that you will need to work with On
Demand Migration.

On Demand Administrator

This role is assigned to users who have full access to the Quest On Demand application. They can manage
organizations and tenants, initiate the migration of tenant assets, manage licenses, audit records and perform many
other functions through the Quest On Demand application. Some of the key permissions associated with this role
are as follows:

Permission Description Service
Scope
Can Export Data Permission to export data as well as download the premigration On Demand
report, comparison report and error report. Migration
Create, Rename and Delete Required permission to create, rename and delete migration On Demand
projects projects from the Projects Dashboard Migration
View projects and manage  This permission must be selected to activate the individual On Demand
selected services permissions to view and manage services. Services selected for Migration
this permission will be inherited by all child permissions.
View projects Required permission to be able to view objects tasks and events On Demand
for the selected services. Only the tiles for the selected services Migration

will be shown in the project dashboards.
Always inherited from parent permission

Edit project properties Permission to edit properties associated with project services. For  On Demand
example, this permission enables access to Accounts Configure Migration
Connections and SharePoint Configure Project.

On Demand Migration User Guide
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Permission Description Service

Scope
Run a full discovery Permission to enable the action that allows users to runthetask ~ Accounts,
that will discover all available objects. Teams,
SharePoint,
Public
Folders,
Power BI
Run a scoped discovery Permission to enable the actions that allows users to run the task ~ Accounts,
with C3V file that will discover objects based on a list contained in a prepared Teams,
csVfile. SharePoint
Run a scoped discovery Permission to enable the actions that allows users to run the task ~ Accounts
from security group that will discover objects based on selected security group.
Run content discovery tasks  Permission to enable the actions that allows users to discover Mailboxes,
content and statistics about selected objects. OneDrive,
SharePoint,
Power BI
Run match and map tasks  Permission to enable the actions that allows users to find Accounts,
matching objects on the target for selected objects and to map 'Sl'ﬁam% .
objects on source and target based on prepared CSV file. Posvfr B?Imt,

Run provision and migration  pPermission to enable the actions that allow user to provisionand ~ On Demand

tasks migrate selected objects to the target. Migration
Manage collections Permission to enable actions for creating and manage the On Demand
Collection feature. Migration
Update and delete Permission to enable the action that allows the user to remove On Demand
migration objects selected objects form the list of services object grid. Migration
Acknowledge and clear task  Permission to enable the action that allows the user to On Demand
events acknowledge and clear events from the Events grid. Migration
Manage Desktop Update Permission to enable all management actions in Desktop Update  Desktop
Agent Agent. Update Agent
View Reporting Dashboard ~ Permission to view reports from the project dashboard On Demand
Migration

On Demand predefined roles

Quest On Demand is shipped with many predefined roles. On Demand Administrator, Migration Administrator, Audit
Administrator, License Management Administrator and Recovery Administrator are some examples.

On Demand custom roles

You can create more roles with specific permissions to allow other users to work with On Demand Migration. See
the On Demand Global Settings Current User Guide for more information about setting up roles.

On Demand Migration User Guide
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Tenant Administrator

In this document the term Tenant Administrator refers to the Azure active directory user account for the source or
target tenant that is assigned the Global administrator security role and has full access to the tenant. Each tenant
that you add to a project requires the credentials of the Tenant Administrator. The Tenant Administrator may require
additional roles to grant the necessary consents to various On Demand service principals that are created in the
tenant to access various assets in the tenant during the migration lifecycle. See Consents and Permissions for more
details. For more information about user and service principals see the Microsoft article Application and service
principal objects in Azure Active Directory.

Tenant Administrator accounts must have a mailbox with a valid Microsoft Exchange Online license.

To use On Demand Migration, the Tenant Administrator for each tenant in a project must grant Azure consents and
permissions to the On Demand Migration service principals.

Migration Service account

You can use a temporary tenant user account to operate on tenant assets. In this document the term Migration
Service account refers to the source or target Azure active directory user account that has temporary access to the
tenant through the Global administrator security role. Depending on the tenant asset that is being migrated, this
temporary user account must grant specific consents. For example, when teams are migrated, the account that is
assigned the Migration Service role is added to the team. This temporary role is required for migrating teams by the
by the On Demand Migration service.

If you choose to work with this temporary account, you must login to the tenant as the Migration Service and grant
the consents and permissions to the On Demand service principal.

When you are done with the migration, it is recommended that you delete the temporary account for security
reasons. See Finalizing the Migration for more details.

On Demand Migration User Guide
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Working with On Demand Migration

On Demand Migrationprovides intuitive project management for migrating accounts and content from one tenant to
another. You can create a migration project that provides a full range of migration features, and track accounts and
content migration in one comprehensive migration project dashboard. You can create multiple migration projects
and use the My Projects list view for a summarized list of all your migration projects.

Migration steps

References to common migration steps are provided in the table below. There are many more activities that are
required to prepare and migrate Office 365 assets, and these are described in detail in the subsequent topics.

Stage

Step

Preparation

Account migration

Mailbox migration

OneDrive migration

Teams and Groups migration
Groups migration
SharePoint migration

Private Folders migration
Power Bl migration

Management

Add source and target tenants
Grant consents

Upgrade throttling policies, install a Desktop Update Agent, plan a test or
pilot migration

Create a migration project

(optional) Discover and match Sensitivity Labels
Discover accounts

Match source accounts with the existing target accounts
Migrate accounts

(optional) Start Address Rewriting for Domain Coexistence
Migrate mailboxes

Grant access to source user's resources to target users
Migrate OneDrive

Migrate Microsoft Teams

Migrate Microsoft 365 Groups

Migrate SharePoint objects

Migrate Public Folders

Migrate Power Bl objects

Monitor the progress and track issues

Finalize the migration

Troubleshooting

On Demand Migration User Guide
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Tenants

Each On Demand migration project needs a source and target tenant. These are Commercial tenants. Commercial
tenants are exclusively hosted and managed by Microsoft. For users in the United States deployment region, On
Demand Migration offers two options depending on the type of Microsoft 365 tenant that you want to add:

« Commercial or GCC Tenant - choose this option if you want to add either a Microsoft 365 commercial
tenant hosted on the Azure public cloud or a Microsoft 365 GCC (Government Community Cloud) tenant
with moderate cyber-security and compliance standards hosted on the Azure Government cloud. For more
information about worldwide endpoints, see Microsoft 365 Worldwide endpoints.

+ GCC High Tenant - choose this option if you want to add a Microsoft 365 GCC High tenant with advanced
cyber-security and compliance standards like NIST 800-171, FedRAMP High and ITAR hosted on the Azure
Government cloud. For more information, see Microsoft 365 U.S. Government GCC High endpoints.

i NOTE: When you create a migration project, a GCC or GCC High tenant can be used as the target tenant
only. Currently, only the On Demand Migration module supports GCC and GCC High tenants.

For more information about adding, removing and managing tenants, see Managing your Azure tenants and on-
premises domains in the On Demand Global Settings Current User Guide.

Adding a tenant

1. Login to On Demand using the credentials you used to sign up for On Demand.

2. If you have multiple organizations you must select an organization. If you have a single organization it will be
automatically selected.

3. Ifthere are no tenants in your organization, click Add Tenant.

No Tenant Added

No tenants have been added to On Demand. In order for us to provide you with valuable information a tenant needs to be added.

s Toan |
_or_
In the navigation panel on the left, click Tenants. The Office 365 Tenants page opens. Then click
Add Tenant.

4. The Add Tenant page opens.
« Ifyou are in the US region, you must select the type of tenant that you are adding:
« Click Add Commercial or GCC Tenant
-or-
« Click Add GCC High Tenant
You are redirected to the Azure sign in page.

« Ifyou are in any region other than the US region, such as Europe, United Kingdom, Canada, or
Australia, you are immediately redirected to the Microsoft login page.
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5. Enter your Azure AD Global Administrator credentials for the source tenant and click Next. A page opens
with the list of permissions that you are granting.

BN Microsoft
admin@democorp.onmicrosoft.com

Permissions requested
Review for your organization

Quest On Demand - Core - Basic
$ Quest Software, Inc. #§
This app would like to:
v View users' basic profile
v Read organization information
~~ Read all audit log data
v Read all usage reports
“ Read directory data
If you accept, this app will get access to the specified resources for

all users i) yaur org ization. No one else will be prompted to
review th ese permissions.

Accepting these pe"nissi:ns means that you allow this app to use

J:uL.lr data as specified in their terms of service and privacy
tatement, You can change these permissions at

htt[::a /myapps.m icrosoft.com. Show Is

Does this app look suspicious? Report it here

6. Click Accept to grant consent to the initial Core - Basic permission set to the On Demand service principal.
7. The Office 365 Tenants page opens with the tenant added as a new tile.

8. Repeat the steps to add a target tenant.

Consents and Permissions

The ability for On Demand service principals to access and operate with tenant assets requires explicit permissions.
The Tenant Administrator grants these permissions through consents. Multi-factor authentication (MFA) is
supported for tenant administrators when granting consents.

When a tenant is added, the initial Core - Basic permission set is granted consent to the On Demand service
principal. Additional consents are required to work with different features of On Demand Migration

While consents allow Quest On Demand Migrationto access tenant assets that are exposed to the application, you
can selectively restrict access to specific assets in your tenant and allow access to the other assets in the
environment. Granting selective access requires additional configuration in your tenant as described below.

In this topic:
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« Restricting access scope

e Granting Consents

o Consents for initial tenant setup

« Consents for Sensitivity Labels

« Consents for Account Migration

» Consents for Mailbox Migration

» Consents for Public Folder Migration

» Consents for OneDrive Migration

» Consents for Teams and M365 groups Migration

o Consents for SharePoint Migration

« Consents for Power Bl Migration
o Azure Portal Security Group Setup
o Power Bl Setup

Verifying Service Principals

Restricting access scope

You can use the following resource-scoped access control methods in your tenant:
Role Based Access Control for Exchange Online

RBAC for Applications in Exchange Online allows admins to grant permissions to Quest On Demand Migration for
Mailboxes which migrates data in Exchange Online. Exchange Online RBAC permissions must be set up in the
tenant for Exchange Web Services (EWS) to ensure that Quest On Demand Migration for Mailboxes can migrate
mailbox data for users within the scope of the RBAC configuration. See the Knowledge Base for more details or
contact Quest Technical Support for assistance.

Sites.Selected permission for specific SharePoint Online site collections

You can enhance the security of SharePoint Online (SPO), by ensuring that On Demand Migration for SharePoint
has access only to specific SharePoint sites, preventing unnecessary exposure to other sites in the environment. To
achieve selected access, you must configure the Sites.Selected permission which is part of the permissions model
for controlling access to specific SharePoint sites or site collections.

This permission can also be used to restrict On Demand Migration for Teams for migrating Teams and M365
Groups within the scope of the specific SharePoint sites that are exposed to the application.

Here’s a breakdown of what Sites.Selected means:

Purpose: The Sites.Selected permission is used primarily in the context of Microsoft Graph APl or Azure AD
permissions, where you want to restrict access to only specific SharePoint sites. It is part of the delegated or
application permissions model, which allows a service or app to interact with SharePoint on behalf of the user (in
delegated permissions) or as itself (in application permissions).

What it does: This permission gives an application or user the ability to access only selected SharePoint sites,
instead of granting broader access to all sites in the tenant. This is more granular compared to other permissions
like Sites.FullControl.All, Sites.Read.All, or Sites.Manage.All, which grant broader access.

Key Permissions in Comparison:
« Sites.FullControl.All: This allows full control of all SharePoint sites across the tenant.

» Sites.Read.All: This provides read access to all sites in the tenant.

« Sites.Selected: Access is restricted to a specific set of sites (only the ones specified).
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i NOTE: When implemented, Site.Selected replaces the Sites.FullControl.All and Sites.Read.All permissions.

Example Scenarios:

« Admin-level control: An administrator can use Sites.Selected to configure apps that need specific access to
particular sites for functions like document management, workflow integration, or customized solutions.

« Granular control: You could use it for limiting access to a few department-specific sites or a small set of
collaborative sites, instead of granting Quest On Demand access to the entire SharePoint Online
environment.

How it's implemented: The Sites.Selected permission, is typically granted during the registration of an Azure AD
app, or when configuring API permissions to interact with SharePoint via Graph API. It requires specifying the sites
the app will have access to, and this can be done by defining a list of URLSs or site identifiers. This permission
requires implementation through the Azure portal, PowerShell scripts and Graph explorer. See the Knowledge Base
for more details or contact Quest Technical Support for assistance with this implementation.

Granting Consents

1. Click Tenants from the navigation pane.

2. Selectatenant and click Edit Consents from the tenant tile.

3. Click Grant Consent or Regrant Consent for the permissions type.

4. Login as the tenant administrator of the source or target tenant. Then click Accept in the Microsoft consents

dialog.

This section lists the minimum consents and roles required by the various On Demand Migration service principals
for managing tenants, Microsoft 365 objects and other migration services.

i NOTE: The following permission sets are legacy and not available for new Quest® On Demand Migration
subscribers. If you already use them, they should be replaced with either the corresponding Minimal or Full
permission sets.

« Migration - Basic
« Migration - Mailbox Migration
« Migration - SharePoint

+ Migration - Teams

For more details about the permissions granted through consents for each service principal, see the On Demand
Migration Permissions Reference Guide.

For initial tenant setup

Task Minimum consents and permissions
Add and configure Core-Basic consent from both Source and Target tenant administrator accounts.
Leonnasr;tﬁt, and grant Global Administrator role from both source and target tenant administrator accounts.

Each tenant that is added is granted consent to the initial Core - Basic permission set to the On Demand service
principal. Additional consents are required to work with different features of On Demand Migration.
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For Sensitivity Label migration

Task

Minimum consents and permissions

All tasks

AIP protected content migration - Read consent from Source tenant administrator
accounts.
AIP protected content migration - Write consent from Target tenant administrator
accounts.

For Account migration

Task

Minimum consents and permissions

All tasks including
discover and migrate
accounts

Migrate hybrid
accounts

Migrate Guest Users

Migration - Basic - Minimalconsent from Source tenant administrator accounts.
Migration - Basic - Fullconsent from Target tenant administrator accounts.

Global Administrator role for both Source and Target tenant administrator accounts.

Guest Inviter role for both Source and Target tenant administrator accounts.

For Mailbox migration

Task

Minimum consents and permissions

All tasks

Migrate mailboxes

Migration - Basic - Minimalconsent from Source tenant administrator accounts.
Migration - Basic - Fullconsent from Target tenant administrator accounts.

Migration - Mailbox Migration - Minimalconsent from Source tenant administrator
accounts or Migration - Mailbox Migration - Custom RBACwith additional
consentsfrom Source tenant administrator accounts.

and

Migration - Mailbox Migration - Fullconsent from Target tenant administrator
accounts or Migration - Mailbox Migration - Custom RBACwith additional consents
from Target tenant administrator accounts.

For Public Folder migration

Task

Minimum consents and permissions

All tasks

Migrate Public
Folders

Migration - Basic - Minimalconsent from Source tenant administrator accounts.
Migration - Basic - Fullconsent from Target tenant administrator accounts.

Migration - Mailbox Migration - Minimalconsent from Source tenant administrator
accounts.

Migration - Mailbox Migration - Fullconsent from Target tenant administrator accounts.

Owner permission for the root Public Folder of the target tenant must also be granted to
the target tenant administrator account.
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Task Minimum consents and permissions

i IMPORTANT: You must explicitly provide the username of the root Public Folder
owner using Configure Connections.

For OneDrive migration

Task Minimum consents and permissions

All tasks Migration - Basic - Minimalconsent from Source tenant administrator accounts.
Migration - Basic - Fullconsent from Target tenant administrator accounts.

Migrate OneDrive Migration - OneDrive - Minimalconsent from Source tenant administrator accounts.

Provision OneDrive

Migration - OneDrive - Fullconsent from Target tenant administrator accounts.

SharePoint Administrator role for provisioning OneDrive on the target tenant.

.i IMPORTANT: You must provide explicit credentials using Configure
Connections. Multi-factor authentication (MFA) is not supported for accounts
whose credentials are entered explicitly.

For SharePoint migration

Task Minimum consents and permissions

All tasks Migration - Basic - Minimalconsent from Source tenant administrator accounts.
Migration - Basic - Fullconsent from Target tenant administrator accounts.

Migrate SharePoint Migration - SharePoint - Minimal consent from Sourcetenant administrator

accounts.
Migration - SharePoint - Full consent from Target tenant administrator accounts.

For Teams migration

Task

Minimum consents and permissions

All tasks

Migrate Teams and
Microsoft 365 Groups
with Teams functionality

Migration - Basic - Minimalconsent from Source tenant administrator accounts.
Migration - Basic - Fullconsent from Target tenant administrator accounts.

Migration - Mailbox Migration - Minimal for the Source tenant
Migration - Mailbox Migration - Full for the Target tenant

Migration - SharePoint - Minimal for the Source tenant

Migration - SharePoint - Full for the Target tenant.

Migration - Teams - Minimal for the Source tenant

Migration - Teams - Full for the Target tenant.

Global Administrator Entra ID role or both the Teams Administrator and
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Task Minimum consents and permissions

Exchange Administrator Entra ID roles for Source and Target tenant administrator
accounts. In addition to these roles, the tenant administrator account that grants the
consents to the Migration -Teams service also requires the following:

« an active Microsoft 365 license
« Microsoft Teams app enabled within the Microsoft 365 license

» the account must remain active for the duration of the migration

For Power Bl migration

Task Minimum consents and permissions

All tasks Migration - Basic - Minimalconsent from Source tenant administrator accounts.
Migration - Basic - Fullconsent from Target tenant administrator accounts.

View Power BI Migration - Power Bl consent from Source and Target tenant administrator accounts.
Global Administrator role from both source and target tenant administrator accounts.

Migrate Power Bl Additional manual setup is required for both source and target tenants through the
Azure portal. The steps required to grant additional permissions are described below.

Granting additional permissions for the source and target tenants

This is a two part process as described below:

Part 1: Azure Portal Security Group Setup

In this part, a new security group is created in Microsoft Entra ID for each source and target tenant, to associate the
service principal of the Quest On Demand - Migration - Power Bl enterprise application. Additional permissions can
be then be granted to the service principal to access and operate on Power Bl objects.

1. Login to https://portal.azure.com with your tenant credentials.
2. Open the Microsoft Entra ID service page.
3. Click Manage > Groups from the navigation panel. Then click New Group.

= Microsoft Azure £ Sesrch resources, senvices, and docs (G+/)

& Sroups | A groyes

L Download greups () Refresh €% Manage view ¥ Got feedback?

& Al groups

Azure Active Directary is now Micrasoft Entra ID. Leam more 12

and solve problems Seardl W Add fitter

Settings

& General
Expiration [] wame Object Id Group type
& Naming policy
| H All Company f22a6b75
Activity
All Employees 73b tribution
2 privileged identity Management B ©
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4. Inthe New Group page, setup the group as described below:

a
b.

C.

Group type = Security

Group name = name of the group. For example, ODMPBI

Group description = short description about the group. For example, ODM Power Bl Migration.
Under Members, click No members selected

In the Add members list that opens, search and select Quest On Demand - Migration - Power BI.
Then click Select at the bottom of the page.

= Microsoft Azure & Search resources, st

Home > Source Corp | Groups > Groups | All groups >

New Group

Q'j Got feedback?

Group type * (O

| Security pve |

Group name * (D

[ oomes -|

Group description @

| ODM Power BI Migration security group. s |

Microsoft Entra roles can be assigned to the group @
&= - )
Membership type * ©
Assigned %

Owners

MNo owners selected

Members

1 member selected

f. Click Create. The group is created with the Quest On Demand - Migration - Power Bl service

principal as a member.

5. Follow all the above steps to create a security group in both source and target tenants.

Part 2: Power Bl Setup

In this part, the security group created in each tenant is configured to allow the service principals to use Power Bl
APIs and create and use Power Bl profiles.

1. Log into the Power Bl service portal at https://app.powerbi.com with your tenant credentials.

2. Click the Settings icon in the top bar and then click Admin portal.

3. From the navigation panel, click Tenant settings.
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4. Scroll down to the Developer Settings section.
a. Expand the Embed content in apps option.
i. Setthe slider to Enabled.

ii. Forthe Apply to option, select Specific security groups, and specify the group name
created in Part 1 above. For example, enter ODMPBI.

iii. Click Apply to save the changes.

Developer settings

ntent in apps

@D :nabled

Apply te:

@ Specific security

© cowrel Enter security groups

Except specific security groups

Apply Cancel

b. Under Developer Settings, expand following options. Then enable each option and repeat the
above steps to associate the security group:

« Service principals can use Fabric APIs
« Allow service principals to create and use profiles
5. Scroll down to the Admin API settings section.

6. Expand following options. Then enable each option and repeat the above steps to associate the security
group:

« Service principals can access read-only admin APIs

« Enhance admin APIs responses with detailed metadata
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« Enhance admin APIs responses with DAX and mashup expressions
Admin APl settings

I Service principals can access read-only admin APls
Enabled for a subset of the organization

=4

Service principals can access admin APIs used for updates

Enabled for a subset of the organization

4 Enhance admin APIs responses with detailed metadata

Enabled for a subset of the organization

Users and service principals allowed to call Power Bl admin APls may get detailed
metadata about Power Bl items. For example, responses from GetScanResult APIs will

contain the names of semantic model tables and columns. Learn More

Note: For this setting to apply to service principals, make sure the tenant setting allowing
service principals to use read-only admin APls is enabled. Learn More

@D crabled

Apply to:
O The entire organization

@ Specific security groups

© oowes

D Except specific security groups

=4

Enhance admin APIs responses with DAX and mashup expressions
Enabled for a subset of the organization

7. Forthe source tenant, expand Export and sharing settings and verify the Download reports option is
Enabled and the option is either set to The entire organization or Specific security groups with the
group name created in Part 1 above.

Export and sharing settings

4 Download reports
Unapplied changes

Users in the organization can download .pbix files and paginated reports. Learn More

@D tnabled

Apply to:
(_:\ The entire organization

(_6) Specific security groups

© oowvesl

Except specific security groups

Apply Cancel

8. For the target tenant expand Workspace settings and verify the Create workspaces option is Enabled
and the option is either set to The entire organization or Specific security groups with the group name
created in Part 1 above.
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Workspace settings

4 Create workspaces
Unapplied changes

Users in the organization can create app workspaces to collaborate on dashboards,
reports, and other content. Even if this setting is disabled, a workspace will be created
when a template app is installed.

@D cnabled

Apply to:

(_) The entire organization

\., Specific security groups

© cowre

Except specific security groups

Apply Cancel

To migrate Power Bl data, the security group must also be granted explicit rights in all tenant Power Bl objects like
Connections, Gateways and Workspaces.

For Connections and Standard Gateways

1.
2.

Click the Settings icon in the top bar and then click Manage connections and gateways.

Under Manage connections and gateways, select each On-premises gateway and give Admin rights to
the group, created in Part 1.

Repeat the above steps for source and target tenant.

NOTE: The Service Principal in the source tenant must be assigned the Admin permission.

For each Workspace that you want to migrate (Source tenant only)

1.
2.

Open the Workspace and click Manage Access.

In the Add people page that opens, add the security group created in part 1 and assign the Admin role
to the group.

< Add people X
Corporate
o Admins, members, and contributors x

have edit and view access. Viewers only
have view access. Learn more [§

° ODMPEBI Enter name or email

€4 Admin m

NOTE: The Service Principal in the source tenant must be assigned the Owner/Admin permission.

Verifying Service Principals

When you have granted the consents, you can verify that the service principals were successfully created in the
tenant. You must verify both source and target tenants.
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1. Login to Microsoft Entra Admin Center.

2. Go to Identity > Applications > Enterprise applications from the navigation panel. Then click All
applications. Filter the list if necessary and verify the list of Quest On Demand service principals. Your list
depends on the subscriptions and consents that you have granted, and may differ from the image below.

- P : - = P
New application (_) Refresh + Download {Export) ﬂ Preview info Columns =]

View, filter, and search applications in your organization that are set up to use your Azure AD tenant as their Ide

The list of applications that are maintained by your organization are in application registrations.

2 Quest

Application type == Enterprise Applications < Application ID starts with X +7 Add filters
9 applications found

MName TJ Object 1D

Quest On Demand - Core - Basic b92ae286-0e5e-dach-9219-11...

Quest On Demand - Migration - Basic - Full 79744cc7-b320-4683-9198-429..,
Quest On Demand - Migration - Teams - Full 0fce63f3-7258f-4e86-8aff-30eb9...
Quest On Demand - Migration - Mailbox Migration - Full 7459f030-3d07-45f1-a545-36¢...
Quest On Demand - Migration - OneDrive - Full 28b7323e-bB8e3-4cbc-9bcf-699...
Quest On Demand - Migration - Power Bl 5af659e1-ea19-4906-937c-821...

Quest On Demand - Migration - SharePoint - Fu 5daad450-0bba-4f44-8b7c-41c...

0/0/0/0/0/0/0/0

Quest on Demand - Core - Exchange Online PowerShell 62b6004z-e8b3-4a0c-ad6f-51a...

Throttling

Microsoft service throttling limits the number of concurrent calls to a Microsoft service to prevent overuse of
resources. These limits are set by the Microsoft services and are dependent on the service type along with the
operations that are being completed by On Demand for the service. In addition, any throttling limits are subject to
change by Microsoft.

Microsoft Graph

Microsoft Graph is designed to handle a high volume of requests. If an overwhelming number of requests occurs,
throttling helps maintain optimal performance and reliability of the Microsoft Graph service. For more information,
see https://learn.microsoft.com/en-us/graph/throttling. Microsoft enforce throttling limits for Microsoft Graph based
on tenant size, including requests-per-minute and requests-per-day. Microsoft does not provide a method for
modifying these limits.

Microsoft Power Bl REST API

The Microsoft Power Bl REST API (Admin API) may experience throttling during usage, as concurrent APl access is
monitored for any ongoing tasks within a tenant. Discovery tasks are likely to be the most affected by this throttling.
We recommend that discovery or statistics collection be run as standalone tasks to minimize potential impacts.

For more information, please reference the following documentation from Microsoft: https://learn.microsoft.com/en-
us/rest/api/power-bi/#throttling
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« Limitations for reading of workspaces
« https://learn.microsoft.com/en-us/rest/api/power-bi/admin/groups-get-groups-as-admin#limitations
« Limitations for reading users in workspaces

o https://learn.microsoft.com/en-us/rest/api/power-bi/admin/groups-get-group-users-as-
admin?trylt=true&source=docs#limitations

Handling ODM Throttling

Quest On Demand Migration follows best practices provided by Microsoft when experiencing throttling. These
include reducing the number of operations of requests, reducing the frequency of calls and avoiding immediate
retries, since all requests accrue against the usage limits for the application.

For requests that an application makes, such as On Demand Migration, including Microsoft Graph, CSOM, or REST
calls, Microsoft can return error codes including HTTP status code 429 ("Too many requests") or 503 ("Server Too
Busy") which result in the requests to fail. In both cases, a Retry-After header is included in the response indicating
how long the calling application should wait before retrying or making a new request.

Upgrading Throttling Policies

Exchange Web Services (EWS) are throttled by Microsoft whenever large quantities of data flows through the EWS
platform. The On Demand Migration service throughput can be improved by upgrading the following throttling policy
parameter setting to Unlimited:

« EwsMaxBurst - Defines the amount of time that an EWS user can consume an elevated amount of
resources before being throttled. This is measured in milliseconds. This value is set separately for
each component.

« EwsRechargeRate - Defines the rate at which an EWS user's budget is recharged (budget grows by) during
the budget time.

« EwsCutoffBalance - Defines the resource consumption limits for EWS user before that user is completely
blocked from performing operations on a specific component.

Tenant administrators can upgrade the throttling policies by making a service request with Microsoft.
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Desktop Update Agent

To complete a migration project, a lightweight user desktop application called Desktop Update Agent (DUA) must be
configured and deployed by administrators and run on users workstations. DUA provides enhanced support, helps
ensure the success of cross-tenant migration projects, makes agent delivery easier, and status reporting more
informative.

DUA features:

» Ability to manage user’s application reconfigurations activities from a single view within On
Demand Migration.

o Support for OneDrive for Business and Microsoft Teams.
» Support for Microsoft 365 application license reset.

« Support for various client authentication mechanisms.

For more information about downloading, administration and use of DUA, see the Quest On Demand Migration
Update Agent Guide.

Test and Pilot Migrations

Any full scale migration should be preceded by test and pilot migrations, to confirm that your migration processes
and procedures will accommodate the organization requirements.

» Atest migration uses real users and real data in a segregated test environment, or dummy users and
dummy data in your live production environment.

« A pilot migration uses a small portion of real users and real data in the live production environment.

In either case - a test or pilot migration - the data to be migrated should be a representative sample of the production
data, and the test or pilot migration should be run with the Quest applications set for the same configuration and
process options that you intend to use for the production migration. it is recommended to select test or pilot users
whose usage and data types make them representative of the total user population. Then create and run matching /
migration tasks for those accounts, including all range of tasks you are planning to perform. When the tasks are
completed, review errors and warnings, if any. See Event Management section for more information.

Quest recommends that you use both test and pilot migrations:

Perform one or more test migrations in a separate test environment, migrating test copies of real users and their real
data. The separate test environment ensures that no test process will affect the data or configurations of your
production environment. If a test exposes any problems under migration, you can make amendments and then
repeat the test by simply dumping the test environment and recreating it from scratch.

When you are confident that your test migrations have sufficiently refined your planned migration, perform a pilot
migration for 20 or 30 users to verify if your planned migration is satisfactory for your "real world."
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Project Management

A migration project contains the full set of migration features and provides a summary of all the migration activities in
the project dashboard. You can work with a single migration project for small migrations or you can set up multiple

migration projects to split larger migration plans into manageable projects.

In this topic:

Creating a new migration project
Viewing migration projects
Renaming a migration project
Deleting a migration project

On Demand Migration Workspaces

Creating a new migration project

1.

Sign in to Quest On Demand.

2. From the navigation pane, click Migrate > Projects to open the Migration projects view.

= ‘ Quest ©OnDemand Al Systems Operational (@) administratort

Migration @

O

( \ fe)

Create a new migration project.

To learn more about setting up your migration project, watch our Video Tutarials.

Create Project  [NESTRERIT

To use the new project management user interface, turn on the Try the new project wizard toggle.

Click Create Project.
_or-
If you have already created one or more projects, click Create Project as shown below.
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Quest OnDemand Al Systems Operational (@) administrator@universal.com @

il Project Migration @ Submit Idea &

Vivaldi 3 Mozart

Project Type:
Source:
Target

Project Type:

AR e o allaB A Ha o alalB

Open Projec Open Project

5. The New Project wizard starts. Each step is described below:

6. Project Detail
Enter the information in the fields as described below:

a. Title - Specify a meaningful name for the project. Maximum number of characters is 128.
b. Description - Enter a description about the project. Maximum number of characters is 200.
c. Source Tenant - Select a source tenant from the dropdown list.

d. Target Tenant - Select a target tenant from the dropdown list.

e. Click Save and Continue.

New Project

o Project Detail

Provide project and tenant information

Title

If you don't see your tenants in the dr
to Quest On Demand. Manage Tenan!

SAVE & CONTINUE CANCEL

n. you must add your tenants

7. Assets

Select one or more assets from the set of information assets that you want to migrate. The Account asset is
mandatory because all other assets are directly or indirectly linked to active directory accounts in your
source and target tenants.

Each asset is treated as an application for migration purposes and automatically assigned a
service principal.
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Migration ®

New Project

1 Project Detai e Assets
Select the assets that you want to migrate.
Select all
Accounts
a8
Teams
Consents

3 Consents

B

Mailboxes

]

e

Public Folders

4 Overview

O

OneDrive

al

Power BI

-
¥ =
L =

SharePoint

Most Microsoft 365 objects can be migrated when the service principals for each asset have been granted

the consent. See Consents and permissions for more information.

To grant consent the service principals:

a. Click Grant Consent to grant the consents to the service principal if the tenant consents were not

granted when you added the tenants.

_Or_

Click Regrant Consent to refresh the consents granted to the service principals. It is recommended
that you regrant consent to ensure that the consent to the service principals are refreshed.

b. Migration of some Microsoft 365 objects require a user principal with the Global Administrator or
other specific roles and you must provide additional authorization. Typically, the tenant administrator
credentials are provided. You can provide the credentials for authorization in the Features step.
Select Yes. Proceed to activate the Features step. Select No. Skip to ignore the Features step.

c. Click Save and Continue.

On Demand Migration User Guide
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New Project

Q rorvan @ hses @) comsens

Grant all consents to On Demand Migration.

Tenants Details Source tenant
Tenant name Source Corp
Tenant primary domain sourcecorp.onmicrosoft.com
Consent Type Source consents
Basic @ Granted

Aug 4, 2022-3:42 PM View Details
SharePoint © Granted

Aug 4. 2022 - 3:41 PM View Details

Do you plan to use migration features that require additional credentials?

Will require additions! credentials)

(O ves, Proceed

@ no. skip

SAVE & CONTINUE BACK CANCEL

Features

Target tenant

Target Corp

targetcorp.onmicrosoft.com

Target consents

@ Granted
Aug 4, 2022 - 3:42 P View Details
@ Granted
Aug 4, 2022 - 3:41 PM View Details

NOTE: This step is available if you select Yes. Proceed in the previous step.

To grant additional authorization with a source and target user principal:

Enter the email address of the target user accounts.

a.
b. Enter the password of the target user accounts.

134

Click Save Credentials. The verification must succeed to proceed.

d. Click Save and Continue, or click Skip this page to avoid entering and verifying user

principal accounts.

New Project

1 Project Detail 2 Assets 3 Consents

Tenant name: Target Corp

Tenant domain: targetcorp.onmicrosoft.com

° Features 5 Overview

Enter the credentials of the tenant administrator or another Azure AD administrator with additional roles for the following feature:

* Provision OneDrive accounts

Enter Target credential for special use cases

Account
admin@targetcorp.onmicrosoft.com x
Password
@ X
Save Credentials
Skip this page —

Cancel Back Save & Contin

On Demand Migration User Guide
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10. Overview

a. Verify the information you have provided for each step. Click Edit to return to the step and revise the
information as needed.

b. Select Open Projectto open the project dashboard.
c. Click Finish to activate the project.

d. Click Open Project to open the project workspace.

Viewing migration projects
1. Signinto Quest On Demand.
2. From the navigation pane, click Migrate > Projects to open the Migration projects view.
3. You can view the projects in two formats:

a. Tile view

« This view presents each project as a tile. Click ® from the view selector in the actions menu
to select this view.

« Itis the default view and contains links to the migration workspaces from the set of icons
in the tile.

« You can sort the tiles by Date Created or Alphabetical from the sort criteria dropdown in the
actions menu.

b. List View

« This view displays the projects as alist. Click “ from the view selector in the actions menu
to select this view.

« This view is useful when you have a large number of projects. Click on a column header to
sort the list by its column values.

Renaming a migration project

1. Signinto Quest On Demand.

2. From the navigation pane, click Migrate > Projects to open the Migration projects view.

3. From the top right-hand corner of the project panel, click the More icon (3 dots). Then click Edit.
4. Revise the project name or description as needed.
5

Click Save to save the changes and close the dialog.

Deleting a migration project
1. Signinto Quest On Demand.

2. From the navigation pane, click Migrate > Projects to open the Migration projects view.

3. From the top right-hand corner of the project panel, click the More icon (3 dots). Then click Delete.
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Quest OnDemand Al Systems Operational (@) bobby.dey@questcom @
Migration @ Submit Idea &
oject Date Created

Vivaldi 3 Mozart

Project Type: o
T oa B & EH e O allal

Open Project Open Project

Project Type:
ou 3

]
&
i]
o
B

4. You can also delete projects from the list view when you select one or more projects and click Delete.

5. Inthe confirmation dialog that opens, click OK to confirm the deletion.

On Demand Migration Workspaces

Click Open Project in the tile view or click a project name in the list view, to open its project workspace. The
project workspace displays important information about your project and associated reports. The project workspace
contains the following tabs:

« Dashboard

* Reports

In each project, On Demand Migration also creates migration workspaces for each asset class selected for
migration. These migration workspaces are logical collections of migration tools for the Office 365 assets and
information about the assets in the source and target tenants.

You can go directly to the migration workspace of any asset by clicking the asset icon in the project tile. The icons
you see will depend on your role, licenses and the assets selected when the project was created. You can hover
over an icon to see the name of the asset type.

Project 365 :

Project Type: Office 365 Services
Source: M365x37671238.onmicrosoft.com
Target: M365x11878883.onmicrosoft.com

A XK = O & a B

Open Project
Teams
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Project Dashboard

Information about the migration project is summarized on the project dashboard. The tiles that you can see and the
features that you can access through the project dashboard depend on your subscription. For information about
subscriptions, see On Demand Global Settings Current User Guide.

Quest  OnDemand All Systems Operational (@ Administrator@democorp.com (i ]

Migration > New Project Submit Idea &

DASHBOARD  REPORTS

Accounts Migration

Welcome Accounts Events Tasks

® Gr

Open Refresh Refresh

Content Migration

Mail SharePoint OneDrive Public Folders

[ [}
o
Open Open Open Open
Teams Active Directory Domain Move Directory Sync
o
0
o
Open Open Open Open

Domain Rewrite Power BI

2 O Open

Each tile on this dashboard presents a summary of the migration activities and lets you navigate to the respective
migration service dashboards or list views as described below:

Welcome

Quick start your migration activities from this tile. The following activities can be performed here:

On Demand Migration User Guide
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Welcome

@ Grant Consent

Discover Accounts DISCOVER
Match Accounts SELECT
Migrate Accounts SELECT

Grant Consent - If you see a green icon, you have granted the necessary consents to the source and target tenants
associated with this project. Otherwise the Grant link is displayed and you can click the link to complete the
authorization process for the source or target tenants.

Discover Accounts - If you see a green icon, you have already discovered one or more accounts in the source
tenant. Otherwise, click Discover to open the Accounts List view and start a discovery process.

Match Accounts - If you see a green icon, you have matched one or more accounts between the source and target
tenants. Otherwise, click Select to open the Accounts List view and start a matching process. You must discover
one or more accounts before you can start the matching process.

Migrate Accounts - If you see a green icon, you have migrated one or more accounts from the source to the target
tenant. Otherwise, click Select to open the Accounts List view and start a migration process. You must match one or
more accounts before you can start the migration process.

Accounts, Mail, OneDrive and Teams

These tiles present information about the objects that were discovered or migrated in addition to other
pertinent information. These objects are managed through the Account and User Data migration workspace
and share a common dashboard. Click Open from the Accounts, Mail, OneDrive, and Teams tiles to access
the common dashboard.

Public Folders

Displays information about the discovered and migrated public folders. Click Open to access the dashboard in the
Public folder migration workspace.

SharePoint

This tile presents information about the discovered and migrated SharePoint objects. Click Open to access the
dashboard in the SharePoint migration workspace.

Active Directory, Domain Move, Domain Rewrite and Directory Sync

Click Open from the respective tiles to access the Active Directory migration workspace, Microsoft 365 domain
move and rewrite services, or directory synchronization services for Microsoft Active Directory and Microsoft Entra
ID. For more information see the Active Directory User Guide.

Power Bl

This tile presents information about discovered and migrated Power Bl objects. Click Open to access the dashboard
in the Power Bl migration workspace.

On Demand Migration User Guide
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Tasks

Displays the five most recent tasks that were completed in the Accounts and User Data migration workspace. Click
Show All to open the Tasks List view in the Accounts and User Data migration workspace.

Events

Displays the five most recent events that were completed in the Accounts and User Data migration workspace. Click
Show All to open the Events List view in the Accounts and User Data migration workspace.

On Demand Migration User Guide
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Reports

On Demand Migration offers two types of reports:

» Premigration Reports
o Comparison Reports

« Migration Reports

Activating Premigration and Comparison reports

Premigration reports are protected by Role-based Access Control (RBAC). To activate the premigration reports

dashboard, follow the steps below:

1. From the On Demand navigation pane, go to Settings > Access Control > Roles.

2. Edita custom role or create a new role. You cannot edit a predefined On Demand role.

3. Scroll down to the Migration section and select the View reporting dashboard check box. Granting this

permission exposes a Reports tab in the project workspace

Ouest On Demand All Systems Operational @ administrator@globalcorp.com ~ o

PSRRIl -olcs > Create Role @ CANCEL CREATE ROLE

Roles
Users Update and delete migration objects
B Subseriptions Selected Services: (/7] Accounts Mailboxes OneDrive Teams SharePoint Public Folders Desktop Update Agent
Migrate
5 [B) Activity Trai Acknowledge and clear task events
T
necaver L\ Notibcation Selected Services: (7 Accounts | | Mailboxes | OneDrive |~ Teams | SharePoint  Public Folders | Desktop Update Agent
Manage Desktop Update Agent
Selected Services: ( Desktop Update Agent

View migration reports

Selected Services: (55 Accounts Mailboxes OneDrive Teams SharePoint Public Folders &
)9 View reporting dashboard
Settings Selected Services: (55 ( Accounts | | Mailboxes ' | OneDrive | Teams ' ( SharePoint | &

Support

r

s

4. By default, all asset types are included with the permission. You can remove one or more asset types to

restrict access those reports.

5. Click Create Role to save the settings for a new role or click Save to save the settings for an existing role.
Users who are assigned this role can see the Reports tab in the project workspace and access the reports

for the permitted asset types.
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Premigration Reports

Premigration reports provide detailed information about discovery tasks which get information about the various
assets in the source tenant which you plan to migrate to the target tenant. These reports can be downloaded as
Microsoft Excel files for offline inspection and migration planning.

Premigration reports are generated every time you run a discovery task for an Office 365 asset. The following is a
list of discovery task commands that support report generation:

Accounts

« Discover All

« Discover From File

o Discover From Security Groups

« Refresh Selected Accounts

» Collect Statistics
Mailbox

» Collect Statistics
OneDrive

» Collect Statistics
SharePoint

« Discover All Sites

« Discover Sites from File

« Discover Site Contents

e Collect Statistics

These reports are accessible from two places:

+ Task details pane

Migration > New Migration Project > SharePoint

OINTCONTENTS  EVEN TASKS

& sTaRT ZEDT  @ODELETE | £ EDITCOLUMNS
Tide Tasktatus Type

©  Discover AllStes Task Completed

Teams

Discover All
Discover From File
Collect Statistics

Provision

M365 Groups

Discover All
Discover From File

Collect Statistics

Power Bl

Discover All Contents
Collect Statistics
Discover Workspaces
Discover Gateways

Discover Connections

F Select Collectio

@

©  metesn proje Completed Prejectietiesn
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To download a premigration report from the task details pane:

1. Select any discovery task that is completed.

2. From the task details pane, click Download premigration report.

Reports tab in the project workspace
Migration > New Migration Project

DASHBOARD REPORTS
Any Al Type: premigration x

T DELETE ¢ EDIT COLUMNS 6 reports, 1 selected | Q

Task Name Asset Type Content Created v Expiration
Mailbox Collect Statistics Mailbox premigration Download Today at 5:14 PM
O OneDrive Collect Statistic OneDrive premigration Download Today at 5:11 PM
D Discover Teams Teams premigration Download Today at 5:09 PM 01/07/2024 4:09 PM
Discover All Sites Task SharePoint premigration Download Today at 5:09 PM 01/07/2024 4:09 PM
O Discover Groups Teams premigration Download Today at 5:09 PM 01/07/2024 4:09 PM
Account Discovery Task Account premigration Download Today at 4:39 PM 01/07/2024 3:39 PM

The Reports list view has the following columns:

+ Task Name - name of the discovery task. The names indicated here are default names and may be
different from task names that you have specified.

« Asset - name of the Microsoft 365 asset that is discovered in the source tenant.

« Type - type of report. This value should be premigration.

« Content - link to the Microsoft Excel file that will be downloaded when you click the link.
o Created - date and time when the report is created.

« Expiration - date and time when the report will expire and the download link will be deactivated.
Reports are retained for 90 days.

To download a premigration report from the project workspace:

1. Filter the list using the predefined filters: Asset Type and Report Type.
a. SetReport Type = premigration

b. Set Asset Type = Asset you want to get the report, or select 'Any'. The Asset Type filter
dropdown also indicates the number of reports in the list for each asset type.

2. From the Content column click Download.
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Analyzing premigration reports

Reports are downloaded as a compressed ZIP file. You must extract the Microsoft Excel report.

Each report has a Summary worksheet. Helpful information about the objects discovered by the discovery task are
presented in this worksheet.

File Home Insert Draw Page Layout Formulas Data Review  View Automate Help | +* Comments | | 17 Share V|

Baz7 - f v
A B c D E F G H 1 ]

1 Name ~ value ~

2 |Total Number of Sites Excluding Teams 17

3 Total Number of Subsites 0

4 |Total Size of Sites GB 0.8799

5 |Average site size GB 0.0518

6 |List of Site Templates discovered sitepagepublishing#0; srchcen#0; srcheenterlite#0; sitepagepublishing#0

7 |Classic Site Templates in use True

8 Total Lists/Libraries 0

9 |Count of Workflows OOB o

10

1

12

13

14

15

16

17

18

19

20 | |

21

22 [~]

Summary | Sites ‘Wehs ‘ Lists | @ [4] J

Ready [@ 70 Accessibility: Good to go BH -+ 100%

If the asset type has related objects associated with each item, then more worksheets are added. For example, a
SharePoint site discovery report will have additional worksheets like Webs and Lists. You may have to run
additional discovery tasks to access information about related objects.

File Home Insert Draw Page Layout Formulas Data Review  View Automate Help 2 Comments ‘ | 1% Share V‘
B58 - b3 9
A B (8 D [~]
1 |Site ID| ~ | Site URL ~ |Display Name - | Owner ~ Root
2 https://globalcorp.sharepoint.com/sites/cecconnection CEO Connection CEO Connection Owners GRO!
3 https://globalcorp.sharepoint.com/sites/GlobalSales Global Sales MOD Administrator SITEl
4 https://globalcarp.sharepaint.com/sites/entsearch Enterprise Search MOD Administrator SRCH
5 https://globalcorp.sharepoint.com/sites/contosoteam Contoso Team Contoso Team Owners GRO
6 https://globalcorp.sharepoint.com/sites/Remoteliving Remote living Remote living Owners GRO/
i https://globalcorp.sharepoint.com/sites/Design Design Design Owners GRO
8 https://globalcorp.sharepoint.com/sites/SOCTeam S0C Team SOC Team Owners GRO/
9 https://globalcarp.sharepaint.com/sites/ThePerspective The Perspective MOD Administrator SITE
10 https://globalcorp.sharepoint.com/sites/Contosomarketing Contoso marketing Contosa marketing Owners GRO
1 https://globalcorp.sharepoint.com/sites/contosolife Contoso Life Contoso Life Owners GRO|—
12 https://globalcorp.sharepoint.com/sites/GlobalMarketing Global Marketing MOD Administrator SITE!
13 https://globalcorp.sharepoint.com/sites/newemployeeonboarding New Employee Onboarding MNew Employee Onboarding Owners GRO/
14 https://globalcarp.sharepaint.com/sites/RetailOperations Retail Operations MOD Administrator SITE
15 https://globalcorp.sharepoint.com/sites/Contoso511 Contoso Contoso Owners GRO!
16 https://globalcorp.sharepoint.com/sites/safety Safety Safety Owners GRO/
17 https://globalcorp.sharepoint.com/sites/parentsofcontoso Parents of Contoso Parents of Contoso Owners GRO
18 https://globalcorp.sharepoint.com/sites/Retail Retail Retail Owners GRO/
19 https://globalcarp.sharepaint.com/sites/leadership-connection Leadership Connection MOD Administrator SITE
20 https://globalcorp.sharepoint.com/sites/ContosoWorks Contoso Works MOD Administrator SITEI
21 https://globalcorp.sharepoint.com/sites/Communications Communications Communications Owners GRO
22 https://globalcorp.sharepoint.com/sites/ProjectFalcon-Uxtest Project Falcon - UX test MOD Administrator SITEl ]
| summary | Sites | webs | Lists | ® [ | [»]
Ready [E§ T0 Accessibility: Good to go BH M -+ 100
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Comparison Reports

Comparison reports provide detailed information about various assets in the source and target tenants. These
reports can be downloaded as Microsoft Excel files for offline inspection, migration planning and verification.
Comparison reports are generated every time you run a Collect Statistics task on a target tenant for an Office 365
asset. The following is a list of task commands that support comparison report generation. Generating comparison
reports requires the selection of a specific option in the task wizard. See the topic about the collect statistics task
wizard from the links provided in the list below.

Accounts SharePoint

» Collect Statistics « Collect Statistics
Mailbox Teams

« Collect Statistics o Collect Statistics
OneDrive M365 Groups

« Collect Statistics o Collect Statistics

These reports are accessible from two places:

+ Task Details pane

TasKs

Z M . 'V o - 'm“ . u o -‘ o Collect OneDrive Statistics Task
To download a comparison report from the task details pane:
1. Select any discovery task that is completed.
2. From the task details pane, click Download comparison report.
On Demand Migration User Guide 28
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+ Reports tab in the project workspace
The Reports list view has the following columns:

« Task Name - name of the discovery task. The names indicated here are default names and may be
different from task names that you have specified.

« Asset - name of the Microsoft 365 asset that is discovered in the source tenant.

o Type - type of report. Valid value are comparison and premigration. Select comparison in the
filter for premigration reports.

« Content - link to the Microsoft Excel file that will be downloaded when you click the link.
« Created - date and time when the report is created.

« Expiration - date and time when the report will expire and the download link will be deactivated.
Reports are retained for 90 days.

To download a comparison report from the project workspace:

1. Filter the list using the predefined filters: Asset Type and Report Type.
a. SetReport Type = comparison.

b. SetAsset Type = Asset for which you want to get the report, or select 'Any'. The Asset Type
filter dropdown also indicates the number of reports in the list for each asset type.

2. From the Content column click Download.

Analyzing comparison reports

Reports are downloaded as a compressed ZIP file. You must extract the Microsoft Excel report. If the asset type has
related objects associated with each item, then more worksheets are added. For example, a SharePoint site
discovery report will have additional worksheets like Webs and Lists.

Notice that there are column pairs: one for the source and another for the target tenant. Discrepancies in the
statistics between source and target are highlighted in red.
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:Snurl:e Owner

Global Administrator

MOD Administrator

New Employee Onboarding Owners
MOD Administrator
Communications Owners

MOD Administrator

MOD Administrator

Retail Owners

W (B~ o kW[

=

Contoso marketing Owners
MOD Administrator

MOD Administrator

MOD Administrator
Remote living Owners.

U.S. Sales Owners

il

J

M

N

AA

AB

AC

~ Source Root Web Template - Target Root Web Template ~ Source Site Type | ~ | Target Site Type ~ Source File Count| v Target File Count ~ Source Sub Sil

SRCHCEN#0
SITEPAGEPUBLISHING#0
GROUP#H0
SITEPAGEPUBLISHING#0
GROUP#0
SITEPAGEPUBLISHING#0
SITEPAGEPUBLISHING#0
GROUP#0

GROUP#0
SITEPAGEPUBLISHING#0
SITEPAGEPUBLISHING#0
SITEPAGEPUBLISHING#0
GROUP#0

GROUP#0

16 |Digital Initiative Public Relations Owners GROUP#0

17 |Sales and Marketing Owners
18 |MOD Administrator

19 |All Company Owners

20 Contoso Team Owners

21 |MOD Administrator

22 MOD Administrator

MOD Administrator

24 |MOD Administrator
Leadership Owners

26 |SOC Team Owners

27 Contoso Owners

Design Owners

29 |MOD Administrator

30 |Mark 8 Project Team Owners
Global Administrator

32 MOD Administrator

~
w

r~
o

o
&

w

Sites | Webs | Lists

Ready [E8 Y% Accessibility: Good to go

GROUP#0
SITEPAGEPUBLISHING#0
GROUP#0
GROUPH0
SITEPAGEPUBLISHING#0
SITEPAGEPUBLISHING#0
SITEPAGEPUBLISHING#0
SITEPAGEPUBLISHING#0
GROUP#0
GROUP#0
GROUP#0
GROUPH0
SITEPAGEPUBLISHING#0
GROUP#0
SITEPAGEPUBLISHING#0
SITEPAGEPUBLISHING#0

SITEPAGEPUBLISHING#0
GROUP#0
SITEPAGEPUBLISHING#0
GROUP#0
SITEPAGEPUBLISHING#0
SITEPAGEPUBLISHING#0
GROUPHD
GROUPHO
SITEPAGEPUBLISHING#0
SITEPAGEPUBLISHING#0
SITEPAGEPUBLISHING#0
GROUP#0
GROUP#0
GROUPHD
GROUP#0
SITEPAGEPUBLISHING#0
GROUP#0
GROUPHD
SITEPAGEPUBLISHING#0
SITEPAGEPUBLISHING#0
SITEPAGEPUBLISHING#0
SITEPAGEPUBLISHING#0
GROUP#0
GROUP#0
GROUP#0
GROUPHD
SITEPAGEPUBLISHING#0
GROUP#0
SITEPAGEPUBLISHING#HO
SITEPAGEPUBLISHING#0

SharePoint
SharePoint
M365 Groups
SharePoint
Teams
SharePoint
SharePoint
Teams
Teams
SharePoint
SharePoint
SharePoint
Teams
Teams
Teams
Teams
SharePoint
M365 Groups
M365 Groups
SharePoint
SharePoint
SharePoint
SharePoint
M365 Groups
Teams
Teams
Teams
SharePoint
Teams
SharePoint
SharePoint

SharePoint
M365 Groups
SharePoint
Teams
SharePoint
SharePaint
Teams
Teams
SharePoint
SharePoint
SharePoint
Teams
Teams
Teams
Teams
SharePoint
M365 Groups
M365 Groups
SharePoint
SharePoint
SharePoint
SharePoint
M365 Groups
Teams
Teams
Teams
SharePoint
Teams
SharePoint
SharePoint

23
115
97
6
27
81
53
3
73
47
18
6
14

54
230
238

12

54
162
140

6
146

Migration Reports

Migration Reports display error reports about migration tasks. Additionally, each migration workspace has its own
Reports tab.

= Quest OnDemand

Migration > ST main project > Accounts and User Data = select Collection -
& DASHBOARD ACCOUNTS MA ES ONEDRIVE REPORTS EVENTS TASKS
ay - Ay - Ay v

g

start Time. Completed Time v Source Name T Targethame T ObectType T  ObjectState T  Processeditems  FaledMems  ErorLog Expiry Date
3 Todayat 201 PH Today 545562 OnMicrosofcom  admin@MISIXS1080798 camicrosoR Mailsox Migrates 3 13
Vesterday st Z Yesterday 1229 M K79545562.0nmicrosoR.com adMINEM355XS 1080 microsoft.com OneDrive Migrated 2 0
Yesterday at 9:35 A crosoftcom  admin@MISSXSI0878.0nmicrosoftcom  OneDrive Migrated 2 o 0811372023 10
) Vestarday at 5:44 Ak ncrosolcom  admin@MISSSI0ETO8camcrosoRcom  OneDrive Migrates 2 o 0512023 3148 A
i 202311 crosoft.com InEM355XE1080 icrosoft.com OneDrive Migrated 2 2023
ow22 ad 55151080706 onmicrosoft.com Migrated 2 oar2172023 847 P11
037222023 1131 AM crosfcom  admin@MISHXSIORTO8cnmicrosofcom  OneDrive Migrates 2 042172023 11:32 AN
2310 crosoft.com ad icrosoft.com oneDrive Migrated 2 1 Downlozd oa21/2023 10
23603 M 353151060796 cnmicro Migrated 2 Next Thus 12,
e Show | 100
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About Migration Reports

The error report for a migration job is a CSV file with one or more rows. The maximum number of rows in the
CSV file is 50K. You can download a report by clicking the Download link in the Error Log column. If there
are no migration errors, a download link is not available.

Error reports are retained for 30 days. You cannot modify this global setting. After 30 days the download link
is replaced with the label Expired and you can no longer download the report.

You can select one or more reports and delete them with the Delete action. If the reports are active
when they are deleted, the row in the table will be removed and the report will be automatically purged
after 30 days.

Access to reports are secured with Role Based Access Control (RBAC). For example, if you have access to
only Mail migration, the OneDrive reports are not visible.

If a migration project is deleted, all associated data will be deleted, and any active reports will be purged
after 30 days.

The columns in the reports list are as described bellow:

Start Time - the date and time the migration task was started.
Completed Time - the date and time the migration task completed.
Source Name - name of the source tenant.

Target Name - name of the target tenant.

Object Type - name of the asset that is migrated.

Object State - the state of the migration. Values are: Migrated, Partially Migrated,Migrated
with Issues,Migration FailedandMigration Stopped.

Processed Items - the number of asset items from the source tenant that were included in the migrattion.
Failed Items - the number of asset items that could not be migrated successfully.

Error Log - link to the report if available. If there are no migration errors, a download link is not available.
After 30 days the download link is replaced with the label Expired.

Expiry Date - date and time when the report will expire.

Exporting Reports

You can download a single report by clicking the Download link in the Error Log column. If there are no
migration errors, a download link is not available.

You can select multiple rows and download the reports as a ZIP file when you click Error Log Export.

You can select multiple rows and download the reports list when you click Export. Only rows are exported
but not the report CSVs.

Filtering the Reports List

You can use the following predefined filters to retrieve a subset of the reports:

Object Type - name of the asset that is migrated.

Object State - the state of the migration. Values are: Any, Migrated, Partially Migrated, Migrated
with Issues,Migration FailedandMigration Stopped.

On Demand Migration User Guide
Working with On Demand Migration



« Has Failed Items: whether or not the migration has any failed items. Values are Yes or No. If there are one
or more items that match a Yes or No value, the number of items are indicated as well.

Working with Lists

Details of assets discovered, their migration states and other pertinent details are displayed in lists.

v sy Name » T etype T TargetType oDM Licensed A T

& Bianca Pisani

e P o

(
)

e &

o
P
)

Non-Mail-Ena & Non-Mail-Ena MateBPM36. AutomateB8OMI5.

o Bianca Pisani Nor-Maik-Ena & Non-MaikEn. No Matc. BiancaPEMIESI3 BiancaP@MEsK1

A Mai

D

=)
o ©¢ 0o 0 0 0 © 0 0 0 0o O

Each list has multiple columns that display properties of the list items. The first column in the list is the list selector.
All lists have this column and cannot be hidden.

The list header contains the list selector and column headers.

To select the columns to display

1. Click Edit Columns.

2. From the drop-down, select the columns you want to display, or clear the check boxes of columns you want
to hide. The list will be automatically updated to reflect your choices.

To configure the number of list items displayed on a page

Large lists can be better managed with paging. A long list is divided into smaller subsets called pages. Each page
contains a fixed number of items or records. Only one page of data is displayed at a time, with navigation controls
allowing users to move between pages.

& Conf Room Crystal & Room Mailbox & Room Mailbox Not required Matc.. Crystal@M365x37 Crystal@M365x11
[} Conf Room Hood & Room Mailbox & Room Mailbox Not required Matc.. Hood@M365x%376... Hood@M365x118...
1-25 of 81 Results Show | 25 v 4

At the bottom of lists, the count of items displayed in a page is indicated on the left-hand side, and page controls are
available on the right-hand side.

1. Click the Show dropdown. Then select the predefined number of items (25, 50 or 100) to display one page.

2. Use the navigation controls to move between pages. The current page number is displayed as you scroll
through the pages.

To select or deselect specific list items
When you want to perform an action on one or more list items, you must select the items.

On Demand Migration User Guide
Working with On Demand Migration



1. Select the corresponding check box in the list selector column of each list item that you want to select, or
clear the check box to deselect the list item. Details of the most recently selected list item is displayed in the
details pane that opens.

2. Click anywhere in a specific list item to view the details of the item. Although you can view the list item
details, the item is not considered as selected unless you select the check box in the corresponding list
selector column.

To select or deselect multiple list items automatically

~ DISCOVERY ~ MATCH = MIGRAT

v Sync.. Name a T
SELECT ALL
SELECT ALL ON PAG

RESET SELECTION

« Select the check box in the list selector column header. All list items across all pages are selected.
Alternatively, click the drop down icon in the list selector column header, and then click Select All.

o Click the drop down icon in the list selector column header. Then click Select All on Page to select all list
items on the current page.

« Click Reset Selection to clear all previously selected list items across all pages.

Searching

Lists could be large and hard to manage. You cannot scroll past 10,000 items or rows in a view. Use the Search box
above this list to look for items that match your custom criteria.

80 accounts | Q Search

To start a search:

1. Use words, phrases, and special queries in your search.

2. Click Search to get the search results. The search is performed across all fields. You can add search criteria
to the search using facet filters on the left pane.

3. Clickthe X icon in the filter box to clear the search criteria.
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= | TIP: Add * to the end of the search query to match all items starting with the search term. Otherwise, you will
only get the exact matches. For example, john* could return John Denver, Johnson Smith, and john.denver.

Search expressions are case-insensitive.

Advanced search

You can refine your results by using the advanced search operators. See Lucene Tutorial for the full information on

search syntax.

To search  Operators Examples Result

for

Partof a *serv* Matches items containing "serv".

word *

Exclude -, NOT (case- -mail* (NOT Excludes items that contain the word starting with “mail”.

specified sensitive) mail*)

content

Include + +mail* Matches items containing “mail” along with the basic search

specified query.

content

Multiple Space, OR mail user, Matches items that contain either “mail” or “user” in case of OR.

keywords f&:ﬁsbe-sen5|tlve), mail OR i Matches items that contain both “mail” and “user”. in case of

.(_case— user, mal AND. This is the default search behavior for phrases.

sensitive) AND user

Exact Quotation marks  "item hard Matches items that contain the exact phrase "item hard

phrase deleted" deleted".

Search by date range

You can select period or use Custom range link to specify desired data range for events.

Filtering

You cannot scroll past 10,000 items or rows in a view. To see relevant records, you can filter lists based on
predefined or custom criteria. The steps to filter a list is the same across all lists.

Quick Filter

These are predefined filters that display the count of items for each value available in the dropdown list. These
values take into consideration any other filter that is already applied.

To apply afilter, select a value from the filter dropdown. You can select values from other dropdown filter lists to
apply a combined filter. Filters are applied immediately when selected.
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Migration > Migration > Accounts and User Data

DASHBOARD ACCOUNTS MAILBOXES ONEDRIVE DESKTOP AGENTS EVENTS TASKS

List View Any - Any - Any - Any - Any -

@ New o
G, DISCOVER ACCOUNTS In Progress 0 ~ MORE ACTIONS
O Sync Status Type © Failed i Name & Status Source UPN Target UPN
O stopped 0

& completed o

To clear afilter, click the ¥ icon in each filter that was applied, or click Clear All to clear all filters.

List View N Account State: Discovered x Any - Source Type: Mailbox-Enabled x Any - Any - Any v CLEARALL

Column Filter
You can apply filters to one or more columns by clicking the filter icon in the column header.

To apply afilter, select a comparison operator from the dropdown and enter a valid value in the search field. Then
click Filter.

To clear afilter, click the filter icon in the column header where a filter was applied. Click Clear to clear the filter.

0 Type Name 4 T Mailbox State T Source Mailbox T Target N
O E8 Adele Vance © Discovered Show items with value that: 38.0... -
O = Alex wilber € Discovered contains M- -
O >_—| Allan Deyoung & Discovered Discovered 380 -
Filter Clear
O B4 Brian Johnson (... & Discovered B 830... -
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Templates

Templates are named task configurations that you can save and reuse to repeat common tasks like migrating mail,
teams, SharePoint content and more. Every migration workspace has a Templates tab. The Templates tab has the
following components:

TEMPLATES EVENTS TASKS

Any -

&5 EDIT COLUMNS 1 template | Q

O ~ Template Name a T Template Type T

O Mail Migration template Mail Migration

Template Type - You can filter the Templates list view with this filter. To apply a filter, select a value from the filter
dropdown that lists the various template types available in the Templates list view. Migration workspaces may have
one or more template types that are specific to he workspace. For example, Mail Migration is a template type in the
Accounts and User Data migration workspace, and Migrate SharePoint Contents is a template type in the
SharePoint migration workspace.

Templates list view - Displays the list of templates saved for reuse from various task wizards that support
templates. The columns are as follows:

+« Template Name - name of the saved template.

« Template Type - type of the template.

Deleting Templates
1. Select one or more templates from the list view that you want to delete.
2. Click Delete in the actions menu.

3. Click Yes in the Delete Templatespopup to confirm the action.

Editing Templates
1. Select a template that you want to edit
2. Click Edit the actions menu. the Edit <template-type> template wizard starts.

3. Review and revise the task configurations. You can also change the name of the template if needed. See the
associated task wizard for a detailed description about the configuration details.

4. Click Next to iterate through each step of the wizard.

5. Click Finish to save the template.

Searching for Templates

Use the Search box above the Templates list to look for items that match your search criteria. See Searching for
more details about entering search criteria.
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Task Management

In this topic:

» Viewing the task list
» Viewing task details
o Scheduling tasks
« Editing Tasks

o Stopping and restarting tasks

Viewing the task list

Each On Demand Migration dashboard has a Tasks tab.

Click the Tasks tab to see the Tasks list. The Tasks list displays all the tasks that are initiated throughout the
migration process. From the Tasks list you can:

« Track the progress of a task and view the results of finished tasks. When you select a task, the task details
pane appears and displays the details the detailed information and statistics of the task.

« Filter and search to quickly navigate through the list of tasks.

« Start, stop, and delete tasks.

Edit tasks

The columns in the Tasks list are as described below:

Title - name of the task that is initiated. You can specify custom names for task when they are created from

the various task wizards.

State - state of the task as it transitions from initiation to completion.

Type - type of the task. For example, the following are some of the task types that are used in On Demand

Migration:
Account Mailbox PowerBI
Discovery Mailbox Assessment TestPowerBlConnection
Matching Mail Migration DiscoverAllContents
Migration Mailbox Switch CollectStatistics
Map From File Address Rewriting DiscoverWorkspaces

Assign ODM License

Meeting Link Migration

DiscoverGateways

Collect Account Statistics ~ Calendar Sharing DiscoverConnections

Collect Mailbox Statistics ImportGatewaysMapping
OneDrive MatchGateways
OneDrive Assessment SharePoint CreateNewConnectionProfile
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OneDrive Migration ProjectRefresh EditConnectionProfile

DiscoverSiteCollections AssignConnectionProfile
DiscoverSharePointContents DeleteConnectionProfiles
MatchSharePointContents MigrateConnections

MappingFromFileSharePointContents MapWorkspacesFromFile

MigrateSharePointContents MigrateWorkspaces

Created - date and time the task is started.
Operation - description of what the task accomplished.
NOTE: Depending on selected task options and content volume, batch processing is used increase the

efficiency of the task. It can take a while before processing of the submitted batches is completed. To help
track the task, the task status is updated every 5 minutes approximately.

Viewing task details

The task details pane provides the following information:

Name - name of the task used as the title of the details pane.

Type - type of the task.

Created - date and time the task is started.

Modified - date and time the most recent operation in the task is performed.

State - state of the task as it transitions from initiation to completion. Valid values are New, In Progress,
Failed, Stopped, Completed and Completed with Issues. The state of an object is set to Stopped when a
task is stopped by the user.

Last Operation - most recent operation that the task accomplished.
Schedule - how the task is started. The values are:

+ Now - if the task is started immediately after the task wizard is completed.

« On Demand - if the task is started manually.

« <timestamp> - if the task is scheduled to start at a scheduled date and time.
Events - number of events that occurred during the task.

Priority - where available, this property indicates the precedence level of this object if it is included in a
migration task where the priority is set in the Schedule step of the migration wizard. Values are: Highest,
High, Medium, Low and Lowest. The default priority is Medium. If the system is busy, the objects are
queued. When the system accepts new migration work, objects are taken from the queue based on the
assigned priority and age in the queue.

Click Copy Diagnostics to copy relevant task properties to the clipboard. You can then paste the properties in a
text file and provide the information to Technical Support for troubleshooting or use the properties in PowerShell
commands. The information that is copied to the clipboard is described below:

Organization ID - unique identifier of the Quest On Demand organization.

Deployment Region - Azure region code. Each Azure geography contains one or more regions that are
used for specific data residency and compliance requirements.
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« Organization Name - name of the Quest On Demand organization.
« Project ID - unique identifier of the migration project.

o Task ID - unique identifier of the task.

Scheduling tasks

To optimize performance you can select scheduling options for all tasks in the Schedule step of task wizards. This
is reasonable for the task that may take a considerable amount of time. The following options are available:

* Run now - task runs immediately.
* Run later - task must be started manually.

« Schedule - task will be started at a future date and time entered in the corresponding calendar field.

Editing tasks

From the Tasks list you can edit previously created tasks to reuse them in one of three ways:
» Editing a completed task
» Editing a running task

« Editing a task that has not started

Editing a completed task
You can edit a completed task. Depending on the schedule option selected you can:

« Automatically restart changed task in case Run now option is selected.

« Manually start changed task in case Run later option is selected. All changes will be applied after the task
is restarted.

« Schedule the start for the changed task in case Schedule option is selected. All changes will be applied
after the task is restarted.

i NOTE: You cannot undo this operation after the wizard is finished to reset the edited task to initial settings.

Editing a running task
You can edit a running task to reuse or restart it. Depending on the schedule option selected you can:

« Automatically restart changed task in case Run now option is selected.

« Manually start changed task in case Run later option is selected. All changes will be applied after the task
is restarted.

« Schedule start for changed task in case Schedule option is selected. All changes will be applied after the
task is restarted.

i NOTE:
« Your changes cannot affect the task that is currently running.

« You cannot undo this operation after the wizard is finished to reset the edited task to initial settings.
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Editing a task that has not started

You can edit task in case it is not started to change your settings. Depending on the schedule option

selected you can:

« Automatically start changed task in case Run now option is selected.

« Manually start changed task in case Run later option is selected.

« Schedule start for changed task in case Schedule option is selected.

i NOTE: You cannot undo this operation after the wizard is finished to reset the edited task to initial settings.

Stopping and restarting tasks

TASKS

Any B Task name : W Rk i g

0O sToP # EDIT

Title State Type Created v

e 0% OneDrive Migration Today at 4:45 PM

To stop a running task:

1. Open the On Demand Migration Tasks tab.

Click Stop.

> 0N

A confirmation dialog appears. Click Stop

i NOTE: The task may take a few minutes to change state.

To restart a stopped task:

1. Open the On Demand Migration Tasks tab

Click Start.

0D

A confirmation dialog appears. Click Start.

Event Management

Each On Demand Migration dashboard has a Events tab.

Operation

Started by user

From the tasks list, click the running task. The Stop button is activated.

Select a task where the State is "Stopped". The Start button is now enabled.

NOTE: The task will restart from the beginning using the same settings.
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Click the Events tab to see the Events list. The Events list displays all the events related to tasks that are initiated
throughout the migration process. It lets you:

« View all events related to a task. Use search or filtering to quickly retrieve events of interest.
+ View details related to the event on the right hand pane when you select an event.

« Hide certain alerts from the list by using the Acknowledge option. This might be useful if you don’t want to
be distracted by the accidental warning or “expected” error.

« Export selected events into comma-separated values (CSV) file for analytic or archival purposes.

« Look for resolutions to error events. In the event detail pane, click Find a Possible Resolution to look for a
solution from among the applicable Knowledge Base (KB) articles in the Quest website. If there is no
solution found, the KB article search page is displayed.

Q Failed to match accounts

s

Object

Task Account Matching Task

Time Friday, Movermber 17, 2023 11:30 AM
Category Matching

The number of selected accounts exceeds the license limit.

Select fewer accounts or purchase additional licenses.
Accounts that require licenses in task: 29,
Total licenses: 2,

Available licenses: 2

Find a Possible Resolution

Sensitivity Labels

Sensitivity labels in Azure are part of a broader information protection strategy to ensure that sensitive data is
identified, classified, and appropriately protected, enhancing security and compliance across your organization.
Sensitivity labels are a feature within the Microsoft Purview Information Protection solution (formerly part of Azure
Information Protection).

The primary goal of sensitivity labels is to ensure that sensitive information is properly protected throughout its
lifecycle. This includes:

« Classifying data based on its sensitivity level (e.g., "Confidential", "Highly Confidential").
» Protecting data by applying security settings, such as encryption, rights management, or watermarking.

« Governance of how sensitive data is shared, accessed, and retained.

Sensitivity labels are integrated into various Microsoft 365 apps, such as Outlook, Word, and Teams, and protect
sensitive information across Microsoft 365 services (like Word, Excel, PowerPoint, SharePoint, and OneDrive) and
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other cloud services. They allow seamless classification and protection of emails, documents, and other content
directly from within the apps.

For more information about Sensitivity labels, see the Microsoft article Get started with sensitivity labels.

Sensitivity label definitions are not migrated. After you create the labels in the target tenant, you can discover and
match the labels between your tenants to prepare On Demand Migration to migrate items with these labels across
your tenants.

The Sensitivity column on migrated files with sensitivity labels may not be immediately updated. The population of
the Sensitivity column is performed by a SharePoint timer job. Sensitivity labels can also be confirmed in the file
details or by downloading and opening the file in the appropriate Office application.

+ | IMPORTANT: The Sensitivity column (a system column that can be added to the view in a SharePoint
Library) for migrated files with sensitivity labels may not be immediately updated. The population of the
Sensitivity column is performed by a SharePoint timer job. Sensitivity labels can also be confirmed in the file
details or by downloading and opening the file in the appropriate Office application.

In this topic:

o Prerequisites

o Sensitivity Labels List View

» Discovering Sensitivity Labels
+ Matching Sensitivity Labels

« Exporting Sensitivity Labels

o Deleting Sensitivity Labels

« Migrating data with sensitivity labels

Prerequisites

The following application consents must be granted:
AIP protected content migration - Read

This application is required for the source tenant to migrate Sensitivity Labels applied to emails, calendar items,
Office files and PDFs in Mail, OneDrive, SharePoint and Teams migrations. It cannot be used for the target tenant.
The consent granted with this application is the minimal consent required to allow On Demand Migration to read
from the Microsoft Information Protection Sync Service and the Azure Rights Management Service.

AIP protected content migration - Write

This application is required for the target tenant to migrate Sensitivity Labels applied to emails, calendar items,
Office files and PDFs in Mail, OneDrive, SharePoint and Teams migrations. It cannot be used for the source tenant.
The consent granted with this application is the consent required to allow On Demand Migration to read from the
Microsoft Information Protection Sync Service and write to the Azure Rights Management Service.

Sensitivity Labels List View

The Sensitivity Labels List View is comprised of the following components:

Notification panel - presents relevant information and shortcuts to migration activities. It appears only when there
is a notification.

Filter panel - consists of predefined filters for the Sensitivity List view. The predefined filters are:

« Status - tracks the state of the account from discovery to migration from source to target tenant. See the
Status column description below for a description of each status:

On Demand Migration User Guide
Working with On Demand Migration


https://learn.microsoft.com/en-us/purview/get-started-with-sensitivity-labels

List View Actions Menu - contains links to sensitivity label activities and the search box. Each action is explained
in greater detail in subsequent topics. See Searching for more information about working with the search box.

List View Columns - displays information about sensitivity labels in the source and target tenant. Some
columns may be hidden by default. Use Edit Columns to show or hide columns in the list. The columns are as
described below:

« Source Label - Sensitivity Label discovered in the source tenant.
« Target Label - Sensitivity Label in the target tenant.

o Status - tracks the state of the sensitivity label from discovery to migration from source to target tenant. The
description of each status is provided in the table below:

Column Value Description

Discovered Sensitivity Labels have been discovered in the source tenant.
Matching Sensitivity Labels are being matched.
Matched Sensitivity Labels have been successfully matched.

Match Failed Sensitivity Labels matching task encountered one or more errors and did not complete.

Stopped Sensitivity Labels matching task was stopped by a user.

« Source Active - indicates whether or not the label is active in the source tenant.
« Source Description - description for the label in the source tenant defined by the administrator.
« Target Active - indicates whether or not the label is active in the target tenant.

« Target Description - description for the label in the target tenant defined by the administrator.

Discovering Sensitivity Labels

1. Loginto Quest On Demand and choose an organization if you have set up multiple organizations.
2. From the navigation pane, click Migrate > Projects to open the My Projects list.

3. Create a new project or open an existing project.
4

From the Sensitivity Labels tile on the project dashboard click Open. Then select the
Sensitivity Labels tab.

5. Click Discover Allin the menu. The New Discover Sensitivity Labels Task wizard starts. Each step is
described below:

6. Start
a. Task Name - You can specify a custom name. The default name is Discover Sensitivity
Labels Task.
b. Click Next.

7. Notification

a. Send notification email once the task is completed - select this option to send a notification
email when a discovery task completes.

« Only in a case of failure - Select this option to send the email if the discovery task fails to
complete successfully.
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b. Recipients - enter the email address of the recipients of this email. You can specify multiple
recipient email addresses separated by semicolon.

8. Schedule

a. Choose from one of three options to schedule the task. The scheduler will be activated after you
complete the task wizard.

* Run now - task runs immediately.
« Run later - task must be started manually.

« Schedule - task will be started at a future date and time entered in the corresponding
calendar field.

b. Click Next.
9. Summary
a. Verify the task specifications as described below:

i. Name - name of the task. The default name is Discover Sensitivity Labels Task. You can
specify a custom name.

ii. Source tenant - name of the source tenant.

iii. Scheduled start - date and time when the task will start. Now indicates that the task will start
immediately.

b. Click Back to revise or review a previous step or click Finish to complete the task wizard and start
the task as scheduled.

10. When the task completes, the Sensitivity Labels list is updated.

Matching Sensitivity Labels
There are two ways you can match sensitivity labels from the source to sensitivity labels in the target tenant:

« Matching labels selected from the list

o Matching label from a CSV file

Matching labels selected from the list

1. Login to Quest On Demand and choose an organization if you have multiple organizations.
2. From the navigation pane, click Migrate > Projects to open the My Projects list.

3. Create a new project or open an existing project.
4

Click the Sensitivity Labels tile, or click Open from the Sensitivity Labels tile to open the Sensitivity
Labels workspace.

5. Select the Sensitivity Labels tab and click Match > Match Selected. The New Sensitivity Labels Matching
Task wizard starts. Each step is described below:

6. Start

a. Task Name - You can specify a custom name. The default name is Sensitivity Labels
Matching Task.

7. Matching

a. Clear existing matches - select this option to clear previous matches of the selected sensitivity
labels. The task clears only the match information stored in the On Demand repository, and does not
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impact the tenants.

b. Match by path attribute - select this option to match labels based on the relative path of the
selected sensitivity labels.

c. Click Next.
8. Notification

a. Send notification email once the task is completed - select this option to send a notification
email when a discovery task completes.

« Only in a case of failure - Select this option to send the email if the discovery task fails to
complete successfully.

b. Recipients - enter the email address of the recipients of this email. You can specify multiple
recipient email addresses separated by semicolon.

9. Schedule

a. Choose from one of three options to schedule the task. The scheduler will be activated after you
complete the task wizard.

* Run now - task runs immediately.
+ Run later - task must be started manually.

« Schedule - task will be started at a future date and time entered in the corresponding
calendar field.

b. Click Next.
10. Summary
a. Verify the task specifications as described below:

i. Name - name of the task. The default name is Sensitivity Labels Matching Task. You can
specify a custom name.

ii. Source tenant - name of the source tenant.
iii. Target tenant - name of the target tenant.

iv. Scheduled start - date and time when the task will start. Now indicates that the task will start
immediately.

b. Click Back to revise or review a previous step or click Finish to complete the task wizard and start
the task as scheduled.

11. When the task completes, the Sensitivity Labels list is updated.

Matching labels from a CSV file

The CSV file lets you specify the labels that you want to match and ignore the rest. You can then use this file in the
New Sensitivity Labels Matching from File Task wizard to match labels from the source to the target tenant.

The steps are as follows:

o Download the relevant CSV template.
o Prepare the CSV file.
» Start the Sensitivity Labels Matching from File Task.
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Download the relevant CSV template

1. Loginto Quest On Demand and choose an organization if you have multiple organizations.
2. From the navigation pane, click Migrate > Projects to open the My Projects list.

3. Create a new project or open an existing project.
4

Click the Sensitivity Labels tile, or click Open from the Sensitivity Labels tile to open the Sensitivity
Labels workspace.

5. Select the Sensitivity Labels tab and click Match > Match from file. The New Sensitivity Labels Matching
from File Task wizard starts. Each step is described below:

6. Start

a. Task Name - You can specify a custom name. The default name is Sensitivity Labels Matching
from File Task.

7. Matching File

a. Click Download Example File for the template that you want to use: One uses label ids and the
other uses path and label names.

b. Click Cancel to exit the wizard.

Prepare the CSV file

1. Create a CSV file and add the attributes of the sensitivity label that you want to use to match the source with
the target tenant labels. You can use any of the two formats shown below:

a. Format 1Using sensitivity label ids

a. SourceSensitivityLabelld - GUID of the label from the Microsoft Purview portal of the
source tenant.

b. TargetSensitivityLabelld - GUID of the label from the Microsoft Purview portal of the
target tenant.

b. Format 2Using label paths and names
a. SourcelabelPath - relative path and name of the sensitivity label in the source tenant.
b. TargetLabelPath - relative path and name of the sensitivity label in the target tenant.

2. Save the CSV file that you created.

Start the Sensitivity Labels Matching from File Task

1. Loginto Quest On Demand and choose an organization if you have multiple organizations.
2. From the navigation pane, click Migrate > Projects to open the My Projects list.

3. Create a new project or open an existing project.
4

Click the Sensitivity Labels tile, or click Open from the Sensitivity Labels tile to open the Sensitivity
Labels workspace.

5. Select the Sensitivity Labels tab and click Match > Match from file. The New Sensitivity Labels Matching
from File Task wizard starts. Each step is described below:

6. Start

a. Task Name - You can specify a custom name. The default name is Sensitivity Labels Matching
from File Task.
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7. Matching File
a. Click Browse and select the CSV file with the sensitivity label specifications that you prepared.
b. Click Next.

8. Notification

a. Send notification email once the task is completed - select this option to send a notification
email when a discovery task completes.

« Only in a case of failure - Select this option to send the email if the discovery task fails to
complete successfully.

b. Recipients - enter the email address of the recipients of this email. You can specify multiple
recipient email addresses separated by semicolon.

9. Schedule

a. Choose from one of three options to schedule the task. The scheduler will be activated after you
complete the task wizard.

* Run now - task runs immediately.
+ Run later - task must be started manually.

« Schedule - task will be started at a future date and time entered in the corresponding
calendar field.

b. Click Next.
10. Summary
a. Verify the task specifications as described below:

i. Name - name of the task. The default name is Sensitivity Labels Matching from File
Task. You can specify a custom name.

ii. Source tenant - name of the source tenant.
iii. Target tenant - name of the target tenant.

iv. Scheduled start - date and time when the task will start. Now indicates that the task will start
immediately.

b. Click Back to revise or review a previous step or click Finish to complete the task wizard and start
the task as scheduled.

11. When the task completes, the Sensitivity Labels list is updated.

Exporting Sensitivity Labels
1. Select one or more sensitivity labels from the list view that you want to export.

2. Click Export the actions menu.

3. Open the CSV file by extracting it from the ZIP file that is downloaded to your computer.

Deleting Sensitivity Labels

1. Select one or more sensitivity labels from the list view that you want to delete.
2. Click Delete in the actions menu.

3. Click Yes in the Delete Sensitivity Labelpopup to confirm the action.
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Migrating data with sensitivity labels

Sensitivity Labels are not migrated. On Demand Migration migrates your Microsoft 365 data assets like Mailboxes,
OneDrive, and SharePoint files that are tagged with sensitivity labels. You can control what happens to the labels
when the data is migrated through the following migration wizards:

+ New Mail Migration Task wizard
+ New OneDrive Migration Task wizard
+ New Teams Migration Task wizard

« New SharePoint Migration Task wizard
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In this chapter:

« Account and User Data Migration Workspace

 What We Migrate
o Preparation
« Configuring Connections
o Calendar Sharing
» Discovering Accounts
« Exporting Accounts
e Managing Accounts with Collections
« Premigration Assessment
o Migration
« Matching and Mapping Accounts
» Migrating Accounts
o Post-migration

« Domain Coexistence

What We Migrate

Account Migration

The On Demand Migration service for Accounts migration support for the listed attributes of user account types is

indicated in the table below:

Attribute Non Mail Mail Mailbox Notes
Enabled Enabled Enabled
User User User
AccountStatus v v N4
Alias X v v
City v v v
Country v v v
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Attribute Non Mail Mail Mailbox Notes

Enabled Enabled Enabled
User User User
Department v v v
DisplayName v v v
ExternalEmailAddress v v v
Fax v v v
HomePhone v v v includes
Business Phone
and Mobile
Phone.
LastName v v v
MailNickname v v v
Name v v v
PhysicalDeliveryOfficeName v v v
PostalCode v v v
PreferredDatalocation v v v
RecipientTypeDetails v v v
StateOrProvince v v v
StreetAddress v v v
TelephoneNumber v v v
UserPrincipalName v v v
Visibility v v v
Usagelocation v v v

The On Demand Migration service for Accounts migrates discovered user accounts and the following types of
discovered groups:

¢ Microsoft 365 Groups
« ownership (for accounts that have a pair on the target tenant )
« membership (for accounts that have a pair on the target tenant )

+ email address for migrated Microsoft 365 Groups will be created in default target domain.
See Microsoft Teams Migration for details on how to migrate Microsoft 365 Groups
associated with Teams.

» Security groups
« ownership (for accounts that have a pair on the target tenant )

« membership (for accounts that have a pair on the target tenant )
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+ Mail-enabled security groups
« ownership (for accounts that have a pair on the target tenant )
« membership (for accounts that have a pair on the target tenant )
« membership approval
« delivery management
* message approval
« MailTip
« group delegation
« visibility in GAL
« Distribution lists
« ownership (for accounts that have a pair on the target tenant )
* membership ( for accounts that have a pair on the target tenant )
* membership approval
« delivery management
« message approval
« MailTip
« group delegation
« SendAs and SendOnBehalf group delegates
o visibility in GAL

Migrating distribution lists with group delegations

On Demand migrates distribution lists with group delegations like SendAs and SendOnBehalf, including scenarios
where the distribution list in the target exists or does not exist, or exists and does or does not have group
delegations. When the distribution list with group delegations exists in the target then only newly added group
delegations are migrated, and group delegations are ignored if anything is deleted at the source. Existing SendAs
and SendOnBehalf group delegations on the target, either preexisting before On Demand migration or migrated by
On Demand will be left intact and merged with the one migrated from the source.

Delegated accounts are migrated as follows:

Mail User Mail Box Mail Enabled Security Distribution List
Group
SendAs Y Y Y
SendOnBehalf Y Y Y Y

i NOTE: Microsoft does not support the following delegated account types so they do not apply to the
migration.

« For SendAS: AAD User, External/Guest User, Distribution List, Security Group
« For SendOnBehalf: AAD User, External / Guest User, Security Group
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= | NOTE: The temporary Migration Service account of the target tenant will be added as an owner to all target
mail-enabled security groups, distribution groups and Microsoft 365 Groups.

Accounts and User Data Migration
Workspace

In this topic:

o Dashboard

e Accounts List View

¢ Accounts Assessment

¢ Account Details

i NOTE: The Accounts and User Data migration workspace is common for the Accounts, Mailbox and
OneDrive migration services, and the Desktop Agents.

Dashboard

Migration > Starz Corp = Galaxy Corp > Accounts and User Data

DASHBOARD ACCOUNTS MAILBOXES

@ ote: Setec the accounts

4 CONFIGURE CONNECTIONS

Getting Started

ONEDRIVE

Q@ DISCOVER ACCOUNTS

QUICK HELP

10 OneDrive users

Mrew
M stopped 0
In Progress 0 0%
Mrailed ]
M completed 0

SHOW ALL

DESKTOP AGENTS

&3 ENABLE CALENDAR SHARING

@ wigration

&

counts

7 tasks

© Discovery Task

© Onebrive Collect Statistics Task
© Mailb
© Disco

SHOW ALL

TEMPLATES

&8 BROWSE ACCOUNTS & DOWNLOAD AGENT

14 accounts

Mnew

In Progress
|
M completed

SHOW ALL

No errors

nt of 1 accounts. Che

SHOW ALL

The components of the dashboard are as described below:

F Select Collection -

10 mailboxes

W New

M stopped 0
In Progress 0 (0%)

W csiled 0

M completed 0

SHOW ALL

Notification panel - presents relevant information and shortcuts to migration activities.
Dashboard Menu - contains the following links to common activities in the migration process.

« Configure connections - You can configure granular permissions for the source and target tenants in
addition to advanced configurations such as concurrent PowerShell connections and custom EWS URL
specification. For more information see Configuring Connections.
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Discover accounts - Starts the New Account Discovery Task wizard to collect information about accounts
in the source tenant. For more information see Discovering Accounts.

Enable calendar sharing - Starts the New Calendar Sharing Task wizard to allow users to retrieve
calendar availability information after migration. For more information see Calendar Sharing.

Browse accounts - Opens the Accounts List view where you can search and filter for accounts, and
manage all the account migration activities. For more information see

Download agent - Allows you to download a lightweight user desktop application (update agent) for users
workstations that is needed to complete a migration project.

Dashboard Tiles

Getting Started - Presents quick start links to the various actions for preparing and migrating accounts.

Accounts - Presents a summary of the accounts in various migration states. Click Show All to open the
Accounts List view to inspect the accounts.

Mailboxes - Presents a summary of the mailboxes in various migration states. Click Show All to open the
Mailboxes List view to inspect the mailboxes.

OneDrive - Presents a summary of users with OneDrive in various migration states. Click Show All to open
the OneDrive List view to inspect the OneDrive information.

Tasks - Displays the five most recent tasks that were completed in the Accounts and User Data migration
workspace. The title displays the total number of tasks. Click Show All to open the Tasks List view.

Events - Displays the five most recent events that were completed in the Accounts and User Data migration
workspace. The title displays the total number of events. Click Show All to open the Events List view .

Accounts List View

Migration > New Migration Project > Accounts and User Data T Select Collection -
ACCOUNTS
© Mote: Selectshe accourt
m Assessment - A - -

Name & T

Source Type T

TargetType T ODMLicensed AccountState T  SourceUPN T TargetUPN T SourceGroupType  TargetGroup Type Title Depa

o © 0 0 ¢ © © © © © ©
o s o o o o ’

The Accounts List View is comprised of the following components:

Notification panel - presents relevant information and shortcuts to migration activities.
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Filter panel - consists of predefined filters for the Accounts List view and tabs to switch between the Accounts
List view and the Assessment view. See Filtering for more information about working with filters. The predefined
filters are:

« Account State - returns a list of Accounts by specific state values. See Account State column description
in the List View below for a list of values.

+ Matching - returns a list of Accounts by source accounts that are matched with a target account. Valid
values are Any, Matched and Not matched.

+ Source Type and Target Type - search by specific account types as defined in Active Directory.
* Any
o User accounts like Guest, Mailbox-enabled, Mail-enabled and Non-mail-enabled.
e Resource mailboxes like Equipment, Room, Scheduled and Shared.

« Groups like Distribution, Mail-enabled-security, Microsoft 365 Group - Dynamic, Microsoft 365 -
Assigned, Security - Dynamic, Security - Assigned, Teams - Dynamic and Teams - Assigned.

« Environment - returns a list of Accounts by location of the Active Directory with which the account is
synchronized. Valid values are Synced with Active Directory (synchronized with on-premise Active
Directory) and In Cloud (synchronized with Azure Active Directory). This filter corresponds to the Sync
Status column in the Accounts list.

+ ODM Licensed - returns a list of Accounts by license utilization. Valid values are Yes, No, Not required.

List View Actions Menu - contains links to account migration activities and the search box. Each action
is explained in greater detail in subsequent topics. See Searching for more information about working with
the search box.

List View Columns - displays information about accounts in the source tenant and the migration status of each
account. Some columns are hidden by default. Use Edit Columns to show or hide columns in the list. The columns
are as described below:

NOTE: If you don't see the Sync Status or object description in the Type column, rerun the account discovery
task as indicated in the Notification panel.

« Sync Status - indicates whether the account is synchronized with the on-premise Active Directory or Azure
Active Directory. The tool tip displays the status value.
« Name - name of the account

« Source Type - account type defined in Microsoft Active Directory for the source tenant. The account type
can be one of the following:

o Any

« Useraccounts like Guest, Mailbox-enabled, Mail-enabled and Non-mail-enabled.

* Resource mailboxes like Equipment, Room, Scheduled and Shared.

» Groups like Distribution, Mail-enabled-security, Microsoft 365 Group, Security Group, Teams.

« Target Type - account type defined in Microsoft Active Directory for the target tenant. The account type can
be one of the following:

* Any

o Useraccounts like Guest, Mailbox-enabled, Mail-enabled and Non-mail-enabled.
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e Resource mailboxes like Equipment, Room, Scheduled and Shared.
« Groups like Distribution, Mail-enabled-security, Microsoft 365 Group, Security Group, Teams.

+ ODM Licensed - indicates whether or not an On Demand Migration license has been consumed when the
migration task is started. Values are Yes, No, Not required.

« Status - status of the most recent task that was run for this account. Valid values are New, Stopped, In
Progress, Failed and Completed. The Status column displays a progress bar that tracks the update for each
account when the Matching and Migration tasks are running.

« Account State - tracks the state of the account from discovery to migration from source to target tenant.
The column values are as follows:

Column Value

Description

Discovered Account has been discovered in the source tenant.
Match failed Account matching failed

Matched Account has been successfully matched.
Matching Account is being matched.

Matching Stopped Account matching task was stopped by a user.
Mapped Account mapping is complete and successful.
Mapping Account mapping of this object has started.

Mapping Failed
Mapping Stopped
Migrated

Account mapping did not succeed.
Account mapping task was stopped by a user.

Account migration is complete and successful.

Migrated with Issues Account migration completed with errors.
Migrating Account migration of this object has started.
Migration failed Account migration did not succeed

Migration stopped Account migration canceled by the user

« Source UPN - account name in the source tenant in the format of an email address based on the Internet
standard RFC 822.

« Target UPN - account name in the target tenant in the format of an email address based on the Internet
standard RFC 822.

« Source Mailbox - account mailbox in the source tenant.
« Target Mailbox - account mailbox in the target tenant.

e Source Group Type - group membership type in the source tenant. Valid values are Assigned
or Dynamic.

+ Assigned - indicates that members are manually added or removed from the group.

+ Dynamic - indicates that users are added or removed dynamically once the membership rules
are defined.
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« Target Group Type - group membership type in the target tenant. Valid values are Assigned or Dynamic.
« Assigned - indicates that members are manually added or removed from the group.

+ Dynamic - indicates that users are added or removed dynamically once the membership rules
are defined.

« Title - Job title of the user account. Does not apply to group accounts.

« Department - department of the user account. Does not apply to group accounts.
« Country - country of the user account. Does not apply to group accounts.

« City - city of the user account. Does not apply to group accounts.

« Collections - indicates the most recent collection where the account is added and the number of additional
collections that also contain this object.

Accounts Assessment

Contains summary reports about the discovered data to analyze your domain structure and track potential
problems, misconfiguration, and risks that might adversely affect the migration. For more information see
Assessment.

Account Details

When you select an account from the List View, the Account Detail pane opens. The information in the pane is
described below:

« Source Email - email address of the selected account in the source tenant.

« Target Email - email address of the selected account in the target tenant.

« Source Type - account type defined in Microsoft Active Directory for the source tenant.

« Target Type - account type defined in Microsoft Active Directory for the target tenant.

» Status - status of the selected account. Valid values are New, In Progress, Failed and Completed.

« Account State - tracks the state of the account from discovery to migration from source to target tenant.
« Events - count of the events that occurred during account processing through one or more tasks.

« Collections - list of collections that contain the selected account.

o Tasks - list of tasks invoked for the selected account.

Configuring Connections

You can re-configure connections from the account migration Dashboard as described below.

NOTE: Multi-factor Authentication (MFA) is not supported for accounts whose credentials are entered
explicitly when configuring connections for provisioning OneDrive on the target tenant.

To configure connections for source and target tenants:
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1. Log in to Quest On Demand and choose an organization if you have set up multiple organizations.
From the navigation pane, click Migrate > Projects to open the My Projects list.

Create a new project or open an existing project.

P w0 DN

Click Accounts. The Accounts and User Data migration workspace opens.. Then click Dashboard.

= Quest OnDemand

Migration > New Project > Accounts and User Data

A
foms DASHBOARD ACCOUNTS MAILBOXES ONEDRIVE DESKTOP AGENTS EVENTS TASKS
SR
&
Tenants
& CONFIGURE CONNECTIONS ~ DISCOVERY .'::| ENABLE CALENDAR SHARING £ BROWSE ACCOUNTS
=

5. Click Configure Connections from the Dashboard menu.

6. From the Configure Connection wizard select the source or target tenant that you want to configure. Then
click Edit.

Configure Connections

I Connections Q
Conn.. Y Organization Name T Tenant T Type T
Source Source Corp sourcecorp.onmicrosoft.com AzureAD
Target Target Corp targetcorp.onmicrosoft.com AzureAD

1-2 of 2 Results Show | 25 v 1 Il

7. Configure the settings as described below:

« Specify the credentials of a user with the Global Administrator or SharePoint Administrator
role (for target tenant only) - enter the credentials of a user account that has the Global Administrator
or SharePoint Administrator role to activate the ability to provision OneDrive accounts in the target
tenant.
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Configure Connection

Microsoft Entra ID Tenant: targetcorp.onmicrosoft.com

Specify the credentlals of a user with the Global Administrator or SharePoint Administrator role for the following operation
* Automatic OneDrive target provisioning before migration

UserPrincipalName Specif

Password Specif]

Specify the UserPrincipalName of an active user account

This account is required for the following operations. The account does not need any permissions, and must not be deactivated or deleted
* Accounts (Discovery, Matching, Migration, Collect Statistics)
= Mail (X500, Permissions, Forwarding, Collect Statistics, Auto Replies, Calendar Sharing, Litigation Hold, Enable Archive)

S

UserPrincipalName admin@targeteorp.onmicrosoft.co

Use specified EWS endpoint, e.g., https//outlook.offic com/EWS/Exchange. asmx.
If the EWS URL is not specified, the Autodiscover service will be used to locate the endpoint.

Custorm EWS URL

m

+ Specify the UserPrincipalName of an active user account - The account does not need any
permissions. It cannot be an external or guest account, and must not be deactivated or deleted. The
UserPrincipalName should not have any special characters. Allowed characters are (atoz, AtoZ,0
t0 9, ._-@). This account is required for the following operations.

» Accounts (Discovery, Matching, Migration, Collect Statistics)

» Mail (X500, Permissions, Forwarding, Collect Statistics, Auto Replies, Calendar Sharing,
Litigation Hold, Enable Archive)

« Custom EWS URL - specify custom EWS endpoint for connecting to Exchange Web Services
(EWS), if you do not want to use EWS endpoint located by the Auto-discover service automatically.

8. Click Save to commit your changes.

9. When both source and target connections are configured, click Finish.

Discovering Accounts

Discovering accounts is a critical first step before a migration to enumerate, update and retrieve relevant information
about accounts from the source tenant. The discovery task collects the necessary account data and statistics on
connected mailboxes from your source tenant to avoid misconfiguration and prevent possible issues.

NOTE: Account discovery is deactivated if basic migration consents are missing from either the source or
the target tenant.

If there are user or group accounts from a previous discovery task that you don't want anymore, you can
manually delete the accounts from the Accounts list (Accounts tab > List View). If there are changes to an
account from a previous discovery, the account will be updated if the account is rediscovered by the task.
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In this topic:
» Discovering all accounts automatically
» Discovering accounts from a file
» Discovering accounts from a file using security groups
+ Refreshing Selected Accounts
+ Reviewing the Account Discovery Task

+ Reviewing the Account Discovery Task Events

Discovering all accounts automatically

1. Loginto Quest On Demand and choose an organization if you have set up multiple organizations.
2. From the navigation pane, click Migrate > Projects to open the My Projects list.

3. Create a new project or open an existing project.
4

From the Accounts tile on the project dashboard click Open. The Accounts and User Data migration
workspace opens.

5. Open the Accounts tab . From the List View menu, click Discovery and then select Discover All. The New
Account Discovery Task wizard starts.

6. Notification

a. Send notification email once the task is completed - select this option to send a notification
email when a discovery task completes.

+ Only in a case of failure - Select this option to send the email if the discovery task fails to
complete successfully.

b. Recipients - enter the email address of the recipients of this email. You can specify multiple
recipient email addresses separated by semicolon.

c. Click Next.
7. Schedule

a. Choose from one of three options to schedule the task. The scheduler will be activated only after you
complete the task wizard.

* Run now - task runs immediately.
* Run later - task must be started manually.

« Schedule - task will be started at a future date and time entered in the corresponding
calendar field.

b. Click Next.
8. Summary
a. Verify the task specifications as described below:

+ Name - name of the task. You can specify a custom name. Default name is Account
Discovery Task.
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« Source tenant - name of the source tenant in this project.
« Discover Type - discovery option that is selected. Value is set to All.

« Scheduled start - date and time when the task will start. Now indicates that the task will start
immediately.

b. Click Back to revise or review a previous step or click Finish to complete the task wizard. The task
will start as scheduled.

The migration task is created. You can track its progress from the Tasks tab, view the summary on the Dashboard
or monitor alerts and notifications from the Events tab. When the discovery task is complete, a summary about the
accounts discovered in the source tenant is available on the project dashboard.

Discovering accounts from a file

When you have a large set of accounts but you want to discover a subset of those accounts, the CSV file lets you
specify the accounts (users and Microsoft 365 groups) that you want to discover and ignore the rest. You can then
use this file in the New Account Discovery Task wizard.

To prepare the CSV file:

1. Login to the Microsoft 365 admin center (https://admin.microsoft.com) with the credentials of your source
tenant administrator.

2. Export Users:
a. From the navigation pane, click Active users.

b. If needed, you can filter the set of users that you want to export. Then click Export. A
Users_<timestamp>.csv file will be downloaded to your computer.

[sl ::  Microsoft 365 admin center £ search
Stz Corp

n

+ (I
- Active users

Recommended actions (1)

3. Export Groups:
a. From the navigation pane, click Active teams and groups.
b. Select the Microsoft 365 tab in the Active teams and groups page.

c. Ifneeded, you can filter the set of groups that you want to export. Click Export and then click Export
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groups in this list. A Groups.csv file will be downloaded to your computer.

Active teams and groups

Microsoft 365 Distribution list  Mail-enabled security  Security Search all groups

4. Create anew CSV file and add the user accounts and groups with accounts you want to discover. You can
use any of the two formats shown below:

i NOTE:
« You can download a CSV template for either of the two formats when you start the New
Account Discovery Task wizard and click Download Example File from the Discovery
Options step.

o CSV file names with non-ASCII characters are not supported.

Format 1

A B
UserPrincipalName Type
AdeleV@M365x347366.0nMicrosoft.com  user
Alex\Wi@M385x34786060.0nMicrosoft.com user
4 |BiancaP@M365x347866.0nMicrosoft.com  user

LEE R ]

UserPrincipalName - Column header for the login name for a user account based on the Internet
standard RFC 822. Do not use a mail nickname or proxy address.

Format 2

A E
Objectld Type
1326a5ch-413f-4287-bd3a-6b27531aalbc  user
belcl2ch-b2b6-4d31-8508-95a0527deee?  group
309b06b1-dBaf-41bd-88e2-f842cdbeacldy  group
lefdal6e-2051-4f69-963d-8a5fadecf5bl  group
6 |47ed2c7f-c4fd-4c86-8ebd-bfadScb29a457 user

[ T S FS B L

Objectld - Column header for the globally unique identifier (GUID) of the user or group object.
When you use Objectld as the column header, you must specify object GUIDs only. You cannot
specify UPNs.

Type - Column header for the type of account: user or Microsoft 365 group.

5. Save the CSV file. You may rename the file if needed.
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To run the account discovery task:

1. Login to Quest On Demand and choose an organization if you have set up multiple organizations.
From the navigation pane, click Migrate > Projects to open the My Projects list.

Create a new project or open an existing project.

P 0N

From the Accounts tile on the project dashboard click Open. The Accounts and User data migration
workspace opens.

5. Open the Accounts tab . From the List View menu, click Discovery and then select Discover From File.
The New Account Discovery Taskwizard starts.

6. Discovery Options

New Account Discovery Task

I Discovery Options Select a comma-separated values (C5V) file that lists the accounts to be discovered.

Nosification Example 1 CSV File Download Example File

UserPrincipalName, Type
iAdeleV@7viwf8 onmicrosoft.com,user
FutwfB.onmicrosoft.com,user

B onmicrosoft.com,user
HenriettaM@7vtwi3.onmicrosoft.com,user

Example 2 CSV File

Objectid Type
22014a32-64be-4c46-2b52-Bc06482d 4 user
0723F35e-baec-4T73b-00b6-B36827651 32 user
71508740-317f-47e0-02e6-e38e0b851 28, group
2d367541-50c5-43dz-abe6 bEfledafalel user

Browse...

a. Click Browse to choose the comma-separated values (CSV) file that contains the lists of user
accounts and group identifiers.

b. Click Next.
7. Notification

a. Send notification email once the task is completed - select this option to send a notification
email when a discovery task completes.

« Only in a case of failure - Select this option to send the email if the discovery task fails to
complete successfully.

b. Recipients - enter the email address of the recipients of this email. You can specify multiple
recipient email addresses separated by semicolon.

c. Click Next.
8. Schedule

a. Choose from one of three options to schedule the task. The scheduler will be activated only after you
complete the task wizard.
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* Run now - task runs immediately.
* Run later - task must be started manually.

o Schedule - task will be started at a future date and time entered in the corresponding
calendar field.

b. Click Next.
9. Summary
a. Verify the task specifications as described below:

+ Name - name of the task. You can specify a custom name. Default name is Account
Discovery Task.

« Source tenant - name of the source tenant in this project.
« Discover Type - discovery option that is selected. Value is set to Using CSV file.

« Scheduled start - date and time when the task will start. Now indicates that the task will start
immediately.

b. Click Back to revise or review a previous step or click Finish to complete the task wizard. The task
will start as scheduled.

The migration task is created. You can track its progress from the Tasks tab, view the summary on the Dashboard
or monitor alerts and notifications from the Events tab. When the discovery task is complete, a summary about the
accounts discovered in the source tenant is available on the project dashboard.

Discovering accounts from a file using security groups

When you need to limit an application's access to a specific set of mailboxes, use this option to include the security
groups in a CSV file. You can then use this file in the New Discovery Task as described in this topic to discover the
accounts from the source tenant. Application access policies can be assigned to these discovered groups to restrict
access to the group members only.

To prepare the CSYV file:

1. Login to the Microsoft 365 admin center (https://admin.microsoft.com) with the credentials of your source
tenant administrator.

2. Export Security Groups:
a. From the navigation pane, click Teams and groups.
b. Selectthe Mail-enabled security tab in the Active teams and groups page.

c. Ifneeded, you can filter the set of groups that you want to export. Click Export and then click Export

On Demand Migration User Guide
Account Migration



groups in this list. A Groups.csv file will be downloaded to your computer.

= Home > Active teams & groups

<) Dark mode

) Home

Active teams and groups

R users v

' Teams & groups ~

1 Active teams & groups
Deleted groups
Shared mailboxes e e e

B silling v

> Microsoft 365 Distribution list ~ Mail-enabled security  Securit D Search all teams and gro
& Setup ’ ° 9

*+ Showall litem =

Export all groups

Network Administrators

Plant Administrators

Security Team

Data Center Group

3. Create anew CSV file and add the email ids of the security groups with the member accounts you want to
discover.
L] .
i NOTE:
« You can download a CSV template when you select Discover From Security Groups and
start the New Account Discovery Task wizard.

o CSV file names with non-ASCII characters are not supported.

A
MailEnabledSecurityGroupEmailID

netadmin@destinycorp.onmicrosoft.com
plantadmin@destinycorp.onmicrosoft.com

securityldestinycorp.onmicrosoft.com

L5 I S WE T U B

datacenter@destinycorp.onmicrosoft.com
MailEnabledSecurityGroupEmaillD - Column header for email IDs of the security groups.

4. Save the CSV file that you created.

To run the account discovery task:

1. Log in to Quest On Demand and choose an organization if you have set up multiple organizations.
2. From the navigation pane, click Migrate > Projects to open the My Projects list.

3. Create a new project or open an existing project.
4

From the Accounts tile on the project dashboard click Open. The Accounts and User data migration
workspace opens.

5. Open the Accounts tab . From the List View menu, click Discovery and then select Discover From
Security Groups. The New Account Discovery Taskwizard starts.
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6. Discovery Options

New Account Discovery Task

I Discovery Options Provide a CSV file with the list of mail enabled security group(s) to be used to discover the accounts.

Notification Example CSV File

MallEnabledSecurityGroupEmalllD

Browse...

step 1 ofd m

a. Click Browse to choose the comma-separated values (CSV) file that contains the list of email IDs of
the security groups.

b. Click Next.
7. Notification

a. Send notification email once the task is completed - select this option to send a notification
email when a discovery task completes.

« Only in a case of failure - Select this option to send the email if the discovery task fails to
complete successfully.

b. Recipients - enter the email address of the recipients of this email. You can specify multiple
recipient email addresses separated by semicolon.

c. Click Next.
8. Schedule

a. Choose from one of three options to schedule the task. The scheduler will be activated only after you
complete the task wizard.

* Run now - task runs immediately.
« Run later - task must be started manually.

« Schedule - task will be started at a future date and time entered in the corresponding
calendar field.

b. Click Next.

On Demand Migration User Guide
Account Migration



9. Summary
a. Verify the task specifications as described below:

+ Name - name of the task. You can specify a custom name. Default name is Account
Discovery Task.

« Source tenant - name of the source tenant in this project.

« Discover Type - discovery option that is selected. Value is set to Using Mail-enabled
Security Group(s).

« Scheduled start - date and time when the task will start. Now indicates that the task will start
immediately.

b. Click Back to revise or review a previous step or click Finish to complete the task wizard. The task
will start as scheduled.

The migration task is created. You can track its progress from the Tasks tab, view the summary on the Dashboard
or monitor alerts and notifications from the Events tab. When the discovery task is complete, a summary about the
accounts discovered in the source tenant is available on the project dashboard.

Refreshing Selected Accounts

For all source and target accounts , the task will refresh the UPN, Primary Email Address and Object Type of
selected accounts. The task will not modify the migration state of the accounts.

To start the refresh task:

1. Loginto Quest On Demand and choose an organization if you have set up multiple organizations.
2. From the navigation pane, click Migrate > Projects to open the My Projects list.

3. Create a new project or open an existing project.
4

From the Accounts tile on the project dashboard click Open. The Accounts and User data migration
workspace opens.

o

Open the Accounts tab . From the List View menu, click Discovery and then select Refresh Selected
Accounts. The New Refresh Selected Accounts Task wizard starts.

6. Notification

a. Send notification email once the task is completed - select this option to send a notification
email when a discovery task completes.

« Only in a case of failure - Select this option to send the email if the discovery task fails to
complete successfully.

b. Recipients - enter the email address of the recipients of this email. You can specify multiple
recipient email addresses separated by semicolon.

c. Click Next.
7. Schedule

a. Choose from one of three options to schedule the task. The scheduler will be activated only after you
complete the task wizard.

* Run now - task runs immediately.

* Run later - task must be started manually.
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« Schedule - task will be started at a future date and time entered in the corresponding
calendar field.

b. Click Next.
8. Summary
a. Verify the task specifications as described below:
+ Name - name of the task. You can specify a custom name. Default name is Refresh
Selected Accounts Task.
« Source tenant - name of the source tenant in this project.
« Discover Type - discovery option that is selected. Value is set to Refresh Selected.
« Scheduled start - date and time when the task will start. Now indicates that the task will start
immediately.
b. Click Back to revise or review a previous step or click Finish to complete the task wizard. The task

will start as scheduled.

Reviewing the Account Discovery Task

1.

Open the Tasks tab.

2. Select the account discovery task that you want to review.

3.

In the task details pane that opens, the information presented is as described below:

a
b.

c
d.

Type - Type of the task. The type is Discovery Task.

Created - Date and time when the task was created.

Modified - Date and time when the task was last updated.

State - State of the task.

Last Operation - The action that was most recently performed in this task.

Schedule - Date and time when the task started. Now indicates that the task started immediately
after the task was created.

Accounts (number) - The number of accounts that were selected for matching and the number of
accounts passing through the various states of the task from New to Completed..

Events (number) - Number indicates the count of events that the task encountered. The values
indicate the type of the events and the event count for each type.

Reviewing the Account Discovery Task Events

1.
2.
3.

Open the Tasks tab.

Select the account discovery task for which you want to review the events.

In the task details pane that opens, click Events (number). The Events tab opens with a filtered list of events
for the selected task.

Select an event that you want to review. In the task details pane that opens, the information presented is as
described below:

a.
b.

C.

Object - name of the account object if applicable.
Task - name of the task.

Time - date and time when the event occurred.
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d. Category - type of task. For account discovery tasks, the category is Discover.

e. Summary - a descriptive statement about the event.

You are now ready for the Premigration Assessment.

Exporting Accounts

1. Loginto Quest On Demand and choose an organization if you have multiple organizations.
2. From the navigation pane, click Migrate > Projects to open the My Projects list.

3. Create a new project or open an existing project.
4

Click the Accounts tile, or click Open from the Accounts tile to open the Accounts and User
Data dashboard.

o

Select the Accounts tab and select List View if not already selected.
6. Select the accounts to export.

7. Click More > Export.

Migration > New Migration Project > Accounts and User Data T Select Collection
ACCOUNTS AAILBOXES NEDR ESKTOP AGENT
- 0
m Assessment - - - -
CUDISCOVER  [IMATCH =+ MIGRATE (5 MAPFROMFILE D3 NEWCOLLECTION v MOREACTIONS & EDIT COLUMNS qQ
Sync..  Mamea Source Type Target Type ODM Licensed Target UPN SourceGroupType  TargetGroupType  Title Depa..  C.
[a) & Mailbox-Enabl.. e ¥ IMPORT COLLECTIONS & e
o € PROCESS RESOURCES
o 2 EXPORT
o quire @ DELETE Assigned
o [ 6549 agmin u
O © ne ssigrex
o Q ne
o Q ne espe u
“ No O ne aria
o O ne 3l u
o Q ne ssigne

8. Open the CSV file by extracting it from the ZIP file that is downloaded to your computer.

Removing Accounts

To manage large lists of accounts in a project, you can remove one or more accounts from the accounts list that you
don't need for migration processes. The accounts that are removed will remain in the source tenant and you must
re-discover the accounts in the project when you need them for migration.

If these accounts are listed in other projects, they will be displayed in those projects.
1. Loginto Quest On Demand and choose an organization if you have multiple organizations.

2. From the navigation pane, click Migrate > Projects to open the My Projects list.
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3. Create a new project or open an existing project.

4. Click the Accounts tile, or click Open from the Accounts tile to open the Accounts and User
Data dashboard.

5. Select the Accounts tab and select List View if not already selected.

6. Select the accounts you want to clear.

i TIP: Use filters, search or collections to quickly navigate through the list of accounts.

7. Click More > Delete.

Migration » New Migration Project » Accounts and User Data T select Collection
DASHBOARD ACCOUNTS MAILBOXES ONEDRIV DESKTOP AGENTS EVENTS TASKS

Q,DISCOVER  (GIMATCH  G+MIGRATE (5 MAPFROMFILE 3 NEWCOLLECTION MOREACTIONS & EDIT COLUMNS : ed |Q
Sync..  Mames Saurce Type Target Type ODM Licensed Source Group Type Target Group Type Title Depa... C.
o Adele Vance & walbox-Enabl & wmalboxEnsbl.  Yes u IPORTCOWECTONS B Retal Ma. Retai
o Alex Wilber & Mai £ PROCESS RESOURCES Marketin. Marke. U
“ 2 EXPORT Assigned
o Notreaured g e e E Assigned
o O N T Admin u u..
o Aok HR Not required © new Assigned
o tom o O ne
[a) No o n 3 u..
o Johnson ¢ No oW
o Q mew CameronWEM3S. Salespers. Sales [
o (@) microsoft 35! ed O Hew . . Assigned
9 2 >

8. The Remove Objects confirmation dialog opens.

Remove Objects

Are you sure you want to permanently delete 14 accounts from the project?

Remove Cancel

9. Click Remove to remove the selected accounts from the list.

Managing Accounts with Collections

Migrating large numbers of accounts requires careful planning. The accounts could belong to different offices and
geographical locations or sensitive departments. Migrating groups of employees in top management, Finance or
Legal departments require special care. Organize the accounts into collections to make large account lists more
manageable.
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+ | NOTE: The actions and steps described below are the same for managing Mailboxes or OneDrive accounts
with Collections.

In this topic:

« Adding Accounts to Collections

« Working with the Collections Dashboard

Adding accounts to Collections
You can add accounts to collections in three ways:

« Select the accounts and create a new collection
o Select the accounts and add to an existing collection.

« Use a CSV file to add accounts to one or more collections.

To add selected accounts to a new collection:

1. From the project dashboard, click Open in the Accounts tile to open the Accounts and User Data
migration workspace.

2. Openthe Accounts tab and select List View if not already selected.
3. Select the accounts you want to add to a collection.

4. From the actions toolbar, click Collections > Create New Collection. The New Collection dialog opens.

x

New Collection

20 Accounts have been selected to be added to the new collection

Collection name Quality Assuranc

5. Enter a collection name in the Collection name field and click Save to add the selected accounts to the
collection.

To add selected accounts to an existing collection:

1. From the project dashboard, click Open in the Accounts tile to open the Accounts and User Data
migration workspace.

2. Ifyou need to create a new collection:
a. From the top-right corner of the migration workspace, click Select Collection >+ New Collection
b. Enter a collection name and click Save to add this collection to the project.

3. Click the Accounts tab and select the accounts that you want to add to the collection.

4. From the actions toolbar, click Collections > Add to Collection. The Add to existing collection dialog
opens.
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Add to existing collection

20 Accounts have been selected to be added to the new collection.

Collection name

5. Select your collection from the Collection name dropdown and click Save to add the selected accounts to
the collection.

To add accounts to one or more collections with a CSYV file:

Using a CSYV file provides the following additional benefits:
o Multiple collections can be created with the same CSV file.
« Existing collections can be specified in the CSV file to add additional accounts.
« Accounts can be listed in multiple collections.

This is a two-step process as described below:
Step 1: Prepare the CSV file
1. From the actions toolbar, click Collections > Import Collections. The New Import Collections from File
Task wizard starts.

2. From the Mapping File step, click Download Example File to download the format you want. A ZIP file is
downloaded.
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Populate the collection with accounts from a comma-separated values (CSV) file.
Example 1 CSV File Download Example File

UserPrincipalName,Collection
WdeleV@ w8 onmicrosoft.com,Finance
DiegoS@7vbwfd onmicrosoft.com,Sales
fGradyA@Tvtwfs onmicrosoft.cormn, Sales
HenriettaM@7vtwf2.onmicrosoft.com, Finance

Example 2 CSV File Download Example File

IObjectld, Collection
B2014a3a-64be-4c46-8b58-8r96482dd4f 1, Finance
[7a3f33e-bdec-478b-90b6-836827651318,Sales
[71508740-a17f-47ed-9206-238e0b851 28, Sales

Rd3afed1-50c5-43da-abea-bEfYedafal e Finance

Example 3 CSV File Download Example File

Emall, Collection

IWdeleV@7Pvtwfl onmicrosoft.com, Finance
DiegaS@7vbwid onmicrosoft.com,Sales
faradyA@Fvtwfa onmicrosoft.com,Sales

HenriettabM@7vtwf2 onmicrosoft.com, Finance

Note: The accounts in the CSV file must already be discovered in the project.

Provide accounts as a list of Objectlds

Browse...

3. Extract the CSV file and use it to prepare your import file in one of three formats described below:

not been discovered cannot be added to a collection.

Format 1: Use the Objectld to identify accounts

s I ) R SR CE I L% B

A B
|Objectid Collection
|e49e00f-d726-4d08-b14a-d5444b9060fd  Finance
|3a9c1b97-8242-47d5-a053-856c096a3e63  Finance
| 04d0e5de-1c82-4c53-9322-fad4ffdefadd Finance
| 54609662-21bb-459d-b2bl1-b5b0acfad49d  Sales
| fh3cf3oa-3d99-460b-87d0-5dolddeddob2  Sales

NOTE: CSV file names with non-ASCII characters are not supported. Accounts in the CSV that have

« Objectld - Column header for the globally unique identifier that represents a discovered account.
The following variations of Objectld are supported: ObjectId, objectid, objectId, OBJECTID

« Collection - Column header for the collection name

Format 2: Use the UserPrincipalName to identify accounts
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A B

UserPrincipalMName Collection
MestorW@starz.OnMicrosoft.com  Management
PattiF@starz.OnMicrosoft.com Management

DiegoS@starz.OnMicrosoft.com Management
AlexW@starz.OnMicrosoft.com Marketing
MeganB@starz.OnMicrosoft.com  Marketing

[ I TR S R I L%

« UserPrincipalName - Column header for the login name of an account based on the Internet
standard RFC 822. Do not use a mail nickname or proxy address. The following variations of
UserPrincipalName are supported: UserPrincipalName, userprincipalname,
USERPRINCIPALNAME

e Collection - Column header for the collection name

Format 3: Use the Email to identify accounts

A B
Email Collection
2 | AdeleV@Vviwfs. onmicrosoft.com Finance
3 DiegoS@7viwf8.onmicrosoft.com Sales
4 | GradyA@/vitwi8. onmicrosoft.com Sales
5 HenriettaM@7viwfS. onmicrosoft.com  Finance
6

¢ Email - Column header for the email of an account user.

¢ Collection - Column header for the collection name
Step 2: Import the CSV file

1. Open the Accounts tab (or the Mailbox or OneDrive tab if you're importing mailboxes or OneDrive accounts
respectively).

2. From the actions toolbar, click Collections > Import Collections. The New Import Collections from File
Task wizard starts.

3. Mapping File

a. Click the Provide accounts as a list of drop-down and select either Objectlds,
UserPrincipalNames or Emails depending on the format of the CSV file that you have prepared.

b. Click Browse and select the CSV file. The selected CSV file name appears.
4. Schedule

a. Choose from one of three options to schedule the task. The scheduler will be activated after you
complete the task wizard.

* Run now - task runs immediately.
* Run later - task must be started manually.

« Schedule - task will be started at a future date and time entered in the corresponding
calendar field.
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5.

b. Click Next.
Summary
a. Verify the task specifications as described below:

i. Name - name of the task. The default name is Import Collections From File. You can
specify a custom name.

ii. Scheduled start - date and time when the task will start. Now indicates that the task will start
immediately.

b. Click Back to revise or review a previous step or click Finish to complete the task wizard and start
the task as scheduled.

c. Click Finish.

NOTE: Identifiers of accounts that are not discovered are ignored without generating an event.

To verify the addition of the account to a collection:

1.

Check the Collections column in the Accounts List View that indicates the most recent collection where the
account has been added and the number of additional collections that also contain the account.

Select an account from the Accounts List View to open the Account Detail pane. Check the Collections
property that lists all the collections where the account has been added.

Working with the Collection Dashboard

The Collection Dashboard shows the collection-specific summary that includes the accounts, mailboxes and
OneDrive users added to it, create tasks for them, and monitor the progress of tasks.

To view the collection dashboard for an existing collection:

a
b.

o

Log in to Quest On Demand and choose an organization if you have multiple organizations.
From the navigation pane, click Migrate > Projects to open the My Projects list.
Create a new project or open an existing project.

From the project dashboard, click Open in the Accounts tile to open the Accounts and User Data
migration workspace

From the top-right corner of the migration workspace, click Select Collection and then select the collection
to view. The collection Dashboard is displayed.

Click Browse Accounts from the collection Dashboard menu or open the Accounts tab. You will see the
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list of accounts that belong to the collection.

Migration > New Project > Accounts and User data ~ @ Submit Idea &

DASHBOARD

@ Note:To cresse a discovery task gront s9m

“ DISCOVERY &2 BROWSEACCOUNTS “ COLLECTIONS

2 accounts 2 mailboxes 2 OneDrive users No tasks

M completed

SHOW ALL SHOW ALL SHOW ALL

No errors

To remove items from a collection:

a. From the actions toolbar, click Collections > Remove from Collection.

b. Inthe confirmation dialog click Remove to remove the selected accounts from the collection.

To rename the collection:

a. Click Collections > Rename Collection in the Actions toolbar of the collections dashboard.

To delete the collection:

a. Click Collections > Delete Collection in the Actions toolbar of the collections dashboard.

To see the tasks for collection-specific account objects:

a. Openthe Tasks tab.

To see the events related to the collection:

a. Open the Events tab.

To return to the Accounts and User Data migration workspace:

a. Click the collection dropdown at the top-right corner of the page, and select Show All.

Matching and Mapping Accounts

Before migrating user or group accounts, check if the target tenant already contains accounts from the source
tenant to avoid duplication. You can match accounts from the Account List View. Alternatively, you can use a CSV
file to manually match or map accounts with the New Account Mapping from File Task wizard, including those with

different attributes or those not yet present in the target tenant.

You can match source accounts with existing target accounts that have the same attributes directly in the Account
List View. For accounts with different attributes, use a CSV file to specify the match. When you match accounts, the
target account information is displayed in the Account List View. During migration, the target account will be updated

if it already exists or created if it does not exist.
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For mapping source accounts to new target accounts, use a CSV file. When you map accounts, the target account
information is displayed in the Account List View. During migration, new target accounts will be created based on
the mappings.

If needed, you can reset all existing matches and mappings to start over.

+ | NOTE: If a source account is not matched or mapped, and a target account exists with the same Name,
UserPrincipalName or PrimarySmtpAddress, then the account migration will fail.

Example 1: Matching accounts

Jordan Davis is a user in the source tenant. If Jordan Davis exists in the target tenant as well, you can match the
accounts by display name directly from the Accounts List View by using the New Account Matching Task wizard.
Some users in the source may have one set of matching attributes like display name, while others may have
another set of matching properties like email, mail nick name, immutable id or employee id. You can run the
Account Matching Task multiple times, and each time you can specify a different matching attribute for the
selected set of users.

When accounts are successfully matched, the Account State column value in the Accounts List View will change to
Matched. When matched accounts are migrated, the target account will be updated with the attribute values of the
source, and permissions are merged.

When accounts cannot be matched, the Account State column value in the Accounts List View will remain as
Discovered. When unmatched accounts are migrated to the target tenant, then On Demand Migration
automatically uses the source account information to create this account in the target tenant.

Example 2: Merging accounts

Group A and Group B are two groups in the source tenant that must be merged with Group C that exists in the target
tenant. You can match one or more accounts from the source tenant to a single account in the target tenant by using
a CSV file in the New Account Mapping from File Task wizard. When the task completes successfully, the Account
State column value in the Account List View will change to Matched for both Group A and Group B. Information
about group C will also be displayed.

The order in which the two groups from the source are migrated will determine the outcome for the target group in a
merger. If Group A is migrated first, then Group C is renamed as Group A in the target. The permissions of Group C
are retained, and permissions from Group A that were not in Group C are added (permissions are merged). When
Group B is migrated, Group C that was renamed to Group A in the target will be renamed again to Group B, and the
permissions are merged once more.

Example 3: Creating new accounts

Group X in the source tenant must be mapped to a new Group Z that does not yet exist in the target tenant. You can
accomplish this by using a CSV file with the New Account Mapping from File Task wizard. After successfully
completing the task, the Account State column in the Account List View will indicate Mapped for Group X, and
information about Group Z will also be displayed.

When Group X is migrated, a new Group Z will be created in the target tenant based on the attributes specified in the
CSV file. All the permissions and details from Group X will be transferred to Group Z. The values provided in the
CSYV file that are used to create Group Z will remain unchanged even if you update Group X before migration.

Avoid mapping multiple accounts from the source tenant to non-existent accounts in the target tenant, as this will
cause the migration to fail.

In this topic:

« Matching accounts selected from the accounts list
» Matching or mapping accounts with a CSV file
» Reviewing the Account Matching Task

» Reviewing the Account Matching Task Events
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Matching accounts selected from the accounts list

1. Login to Quest On Demand and choose an organization if you have multiple organizations.
2. From the navigation pane, click Migrate > Projects to open the My Projects list.

3. Create a new project or open an existing project.
4

Click the Accounts tile, or click Open from the Accounts tile to open the Accounts and User
Data dashboard.

o

Go to the Accounts tab and select List View if not already selected.

6. Select the accounts you want to match and then click Match > Match Selected from the List View menu.
The New Account Matching Task wizard starts. Each step is described below:

7. Start
a. Task Name - You can specify a custom name. The default name is Account Matching Task.

8. Account Matching

New Account Matching Task

s The matching associates source accounts with the existing target accounts based on specified criteria.
tart
Clear existing matches

@ Macch by atwributes

Account matching

Notification

attribute displayName ~

Target attribute displayName e

a. Select and configure the options as described below:
« Clear existing matches - all matches are cleared.

« Match by attribute - use the specified attribute pairs to match accounts in the source and
target tenants. Select the same matching attribute for the Source attribute and Target
attribute. The matching attributes are as described below:

« displayName - the attribute of the account as specified in the same active
directory property.

+ mail - username of source email address and default target domain is used to
construct the email address for matching.

« mailNickname - email alias used in Exchange servers.
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« Immutableld - a specific attribute for a Microsoft 365 account object that is
synchronized from on premise Active Directory. When AAD Sync is used with the
default settings on Uniquely Identifying your users, the Active Directory objectGUID
is used as the immutableld.

« employeeld - the identifier of an employee in active directory.
b. Click Next.
9. Notification

a. Send notification email once the task is completed - select this option to send a notification
email when a discovery task completes.

« Only in a case of failure - Select this option to send the email if the discovery task fails to
complete successfully.

b. Recipients - enter the email address of the recipients of this email. You can specify multiple
recipient email addresses separated by semicolon.

10. Schedule

a. Choose from one of three options to schedule the task. The scheduler will be activated only after you
complete the task wizard.

* Run now - task runs immediately.
+ Run later - task must be started manually.

« Schedule - task will be started at a future date and time entered in the corresponding
calendar field.

b. Click Next.
11. Summary
a. Verify the task specifications as described below:

+ Name - name of the task. The default name is Account Matching Task. You can specify a
custom name.

« Source tenant - name of the tenant where the statistics will be collected.
« Target tenant - name of the target tenant in this project.
+ Assign Licenses - value is Yes.

« Scheduled start - date and time when the task will start. Now indicates that the task will start
immediately.

b. Click Back to revise or review a previous step or click Finish to complete the task wizard and start
the task as scheduled.

Matching or mapping accounts with a CSV file

Use this method to match or map accounts from the source to accounts in the tenant that have different attributes.
The CSV file lets you specify the accounts that you want to map and ignore the rest. You can then use this file in the
New Account Mapping from File Task wizard to match or map the accounts from the source to the target tenant.

The steps are as follows:

1. Download the relevant CSV template.

2. Prepare the CSV file.
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3. Start the Account Mapping from File Task.

TIP: You can get a list of users or groups for your CSV file along with pertinent information directly from the
Microsoft 365 Admin Center.

1. Log in to the Microsoft 365 admin center with the credentials of your source tenant administrator.
2. Export Users:
a. From the navigation pane, click Active users.

b. If needed, you can filter the set of users that you want to export. Then click Export. A Users_
<timestamp>.csv file will be downloaded to your computer.

2 searcn

Active users

Recommanded actions (1)

......

3. Export Groups:
a. From the navigation pane, click Active groups.
b. Select the Microsoft 365 tab in the Active Groups page.

c. If needed, you can filter the set of groups that you want to export. Click Export and then click
Export groups in this list. A Groups.csv file will be downloaded to your computer.

Active teams & groups

Active teams and groups

R users v
A Teams & groups ~

I Active teams & groups

Deleted

Microsoft 365 Distribution list  Mail-enabled security  Security

All Company

Contoso

Starz Events

Starz Finance D StnFnence@MIBSO2s2 enmicreaften S L

4. Repeat steps 1-3 for the target tenant.

Download the relevant CSV template

1. Login to Quest On Demand and choose an organization if you have multiple organizations.

2. From the navigation pane, click Migrate > Projects to open the My Projects list.
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Create a new project or open an existing project.

Click the Accounts tile, or click Open from the Accounts tile to open the Accounts and User
Data dashboard.

Select the Accounts tab and select List View if not already selected.

From the List View menu click Match > Map From File. The New Account Mapping from File Task wizard
starts. Each step is described below:

Start

a. Task Name - You can specify a custom name. The default name is Account Mapping
from File Task.

Mapping File

a. Match with existing account - select this option to match the source account with an existing target
account.

New Account Mapping from File Task

Start .
= . Match with existing account

Mapping File - . .
I Viapping Map to new account (account will be created during migration)

Notification Selert a comma-separated values (CSV) file with custom mapping of source and target accounts

Example 1 CSV File Download Example File

SourceUPN,TargetUPN
[AdeleVi@source.com AlexW@target.com
DiegaS@source.com,Delia
GradyA@source.com,Gerha
HerriettaM@source.com,Lynne

Example 2 CSV File Download Example File

SourceObjectld, TargetObjectld

becsB786-738e-d4fe-a304-5f02743c5edd, 2538091 8-2440-4eac-Seed-26135e5fa15b
baf608da-1437-4643-ad00-8039c04eb52c,e6af9d1d-c815-4107-96f2-83e1 7fb938c9
126070f2-5f67-40a3-9ac2-02de 7 79386f0,1671673a-bfdb-4828-bd69-f720a97a1d9d
2¢91a6b1-50b5-4927-95¢ce-Tc a7 b28cde, c6dbe208-38c4-4007-9788-3c30f06efb69

b. Map to new account - select this option to prepare a new user or group account with the specified
information. The new user or group will be created during migration.

On Demand Migration User Guide
Account Migration



New Account Mapping from File Task

Start .
= Match with existing account
Mapping File - . .
I Viapping . Map to new account (account will be created during migration)
Notification

Select a comma-separated values (CSV) file with custorm mapping of source and target accounts
Required parameters for target USER accounts are SourceUPN and TargetUPN. Rest is optional.
User Example CSV File Dowr

SourceUPN,TargetUPN, TargetDisplayName, TargetAlias, TargetPrimaryEmail TargetFirstName, TargetLastName
|AdeleVidsource.com Adele Vance@target.com Adele Vance Adele Vance Adele Vane rget.com Adele Vance
GradyA@source.com,Grady Archie@target.com, G Archie, Grady. Archie, Grady Arc target.com,Grady Archie

Required parameters for target GROUP accourts are SourceGroupharne and TargetGrouphlarme. Rest
Group Example CSV File Down

s optional

SourceGroupName,TargetGroupName,TargetAllas, TargetPrimaryEmall
Helpdesk-Source, Helpdesk-Target, Helpdesk-Target, helpdesk target@target.com
Marketing-Source Marketing-Target Marketing Target, marketing. target@target.com

Browse...

et m

c. Click Download Example File.

d. Click Cancel to exit the wizard.

Prepare the CSV file

1. Create a CSV file and add the attributes of the users and groups you want to match or map from the source
to the target tenant. You can use any of the two formats shown below:

i NOTE:
« User account pairs in which one of the accounts is a guest account are not supported.
e CSV file names with non-ASCII characters are not supported.

CSV formats to match with an existing target user or group account

You can prepare the CSV in one of two formats to match the source account with an existing target account.
If a match is not found, the source account is created in the target tenant during migration.

Format 1 Using the SourceUPN and TargetUPN

¢ SourceUPN - Source account name in the format of an email address based on the Internet
standard RFC 822. Do not use a mail nickname or proxy address.

« TargetUPN - Target account name in the format of an email address based on the Internet standard
RFC 822. Do not use a mail nickname or proxy address.

Format 2 Using the SourceObjectld and TargetObjectid

» SourceObjectld - Globally unique identifier (GUID) of the source account.

« TargetObjectld - Globally unique identifier (GUID) of the target account.

CSV formats to map to a new target user or group account
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You can prepare the CSV in one of two formats as described below. The values specified in the CSV are
used to create the new account and these values will persist even if you update the source account. If you
don't specify the optional attributes, these values will be copied from the source account. The new user or
group account will be created during migration.

Format 1 For mapping to a new target user account

e SourceUPN - User’s login name in the format of an email address in the source tenant.

o TargetUPN - User’s login name in the format of an email address that will be created in the
target tenant.

« TargetDisplayName - (optional). This is the name that is shown in various Microsoft services and
applications (e.g., John Doe). It typically includes both the first and last names of the user and is
used for user identification in the directory and email communications.

« TargetAlias - (optional). Alternative email address or identifier for the user. It allows users to receive
emails sent to different addresses that point to the same mailbox.

« TargetPrimaryEmail - (optional). Main email address associated with the user account. It is used for
logging in, receiving emails, and as the main identifier for the user.

« TargetFirstName - (optional). Given name of the user (e.g., John). It's part of the user’s full name
and is used in personal settings and directories.

« TargetLastName - (optional). Surname or family name of the user (e.g., Doe). Like the first name, it
is part of the user’s full name and is used in personal settings and directories.

Format 2 For mapping to a new target group
« SourceGroupName - Name of the group in the source tenant.
« TargetGroupName - Name of the group in the target tenant.

« TargetAlias - (optional). Alternative email address or identifier for the group. It allows the group to
receive emails sent to different addresses that point to the same mailbox.

« TargetPrimaryEmail - (optional). Main email address associated with the group.

2. Save the CSV file that you created.

Start the Account Mapping from File Task
1. Log in to Quest On Demand and choose an organization if you have multiple organizations.
2. From the navigation pane, click Migrate > Projects to open the My Projects list.
3. Create a new project or open an existing project.
4

Click the Accounts tile, or click Open from the Accounts tile to open the Accounts and User
Data dashboard.

o

Select the Accounts tab and select List View if not already selected.

6. From the List View menu click Match > Map From File. The New Account Mapping from File Task wizard
starts. Each step is described below:

7. Start

a. Task Name - You can specify a custom name. The default name is Account Mapping
from File Task.

8. Mapping File
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a. Match with existing account - select this option to match the source account with a target account
specified in the CSV file. During migration, if a match is found, the source account is updated, and
permissions are merged. If a match is not found, the target account including permissions is created
from the source.

b. Map to new account - select this option to create a new user account or group specified in the CSV
file. The user account or group will be created in the target tenant during migration with information
provided in the CSV file. During migration, the attributes of the new target specified in the CSV will be
retained and all other attributes and permissions will be copied from the source account.

c. Click Browse and select the CSV file with the account maps that you prepared.
d. Click Next.
9. Notification

a. Send notification email once the task is completed - select this option to send a notification
email when a discovery task completes.

« Only in a case of failure - Select this option to send the email if the discovery task fails to
complete successfully.

b. Recipients - enter the email address of the recipients of this email. You can specify multiple
recipient email addresses separated by semicolon.

10. Schedule

a. Choose from one of three options to schedule the task. The scheduler will be activated only after you
complete the task wizard.

* Run now - task runs immediately.
* Run later - task must be started manually.

« Schedule - task will be started at a future date and time entered in the corresponding
calendar field.

b. Click Next.
11. Summary
a. Verify the task specifications as described below:

i. Name - name of the task. The default name is Account Mapping from File Task. You can
specify a custom name.

ii. Source tenant - name of the tenant where the statistics will be collected.
iii. Target tenant - name of the target tenant in this project.

iv. Scheduled start - date and time when the task will start. Now indicates that the task will start
immediately.

b. Click Back to revise or review a previous step or click Finish to complete the task wizard and start
the task as scheduled.
Reviewing the Account Matching Task

1. Open the Tasks tab.

2. Select the account discovery task that you want to review.
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3. Inthe task details pane that opens, the information presented is as described below:
a. Type - Type of the task. The type is Matching.
b. Created - Date and time when the task was created.
c. Modified - Date and time when the task was last updated.
d. State - State of the task.
e. Last Operation - The action that was most recently performed in this task.

f. Schedule - Date and time when the task started. Now indicates that the task started immediately
after the task was created.

g. Accounts (number) - The number of accounts that were selected for matching and the number of
accounts passing through the various states of the task from New to Completed.

h. Events (number) - Number indicates the count of events that the task encountered. The values
indicate the type of the events and the event count for each type.

Reviewing the Account Matching Task Events

1. Open the Tasks tab.
2. Select the account discovery task for which you want to review the events.

3. Inthe task details pane that opens, click Events (number). The Events tab opens with a filtered list of events
for the selected task.

4. Select an event that you want to review. In the task details pane that opens, the information presented is as
described below:

a. Object - name of the account object if applicable.

b. Task - name of the task.

c. Time - date and time when the event occurred.

d. Category - type of task. For account mapping tasks, the category is Matching.

e. Summary - a descriptive statement about the event.
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Collecting Statistics

A Collect Account Statistics Task conducts an assessment of all accounts in the source tenant and matching
accounts in the target tenant.

Each Collect Account Statistics Task generates events. Events are milestones that a task achieves as it runs.
For example, when an Collect Account Statistics Task starts, an event is logged and it appears in the events list.
When the number of accounts that are selected for assessment is large, the Collect Account Statistics Task
divides the total number of accounts into manageable sets. Each set is called a batch. When a batch of accounts is
assessed, another event occurs.

s | NOTE: Before you proceed, verify that the source tenant accounts have been discovered. For more
information see Discovering Accounts

In this topic:

¢ Create and run a Collect Account Statistics Task
« Review the Collect Account Statistics Task
« Review the statistics collected

+ Review the events for the Collect Account Statistics Task

Create a Collect Account Statistics Task

1. Loginto Quest On Demand and choose an organization if you have multiple organizations.
From the navigation pane, click Migrate > Projects to open the My Projects list.

Create a new project or open an existing project.

> D

Click the Account tile, or click Open from the Account tile to open the Accounts and User Data
migration workspace.

5. Select the Accounts tab and then select List View if not already selected. Then select any account in the
list to activate the menu options.

6. From the Actions menu, click More> Collect Statistics. The New Collect Account Statistics Task wizard
starts. Each step is described below:

7. Description

a. Retrieve external sender permissions for distribution groups - retrieves the permissions set for
external users who are allowed to send email to distribution groups.

b. Collect statistics from target - select this option to collect statistics from the target tenant and
generate the Comparison Report.

c. Retrieve group membership details - select this option to retrieve group memberships of group
type accounts.

d. Click Next.
8. Notification

a. Send notification email once the task is completed - select this option to send a notification
email when a discovery task completes.

« Only in a case of failure - Select this option to send the email if the discovery task fails to
complete successfully.
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b. Recipients - enter the email address of the recipients of this email. You can specify multiple
recipient email addresses separated by semicolon.

c. Click Next.
9. Schedule

a. Choose from one of three options to schedule the task. The scheduler will be activated only after you
complete the task wizard.

* Run now - task runs immediately.
« Run later - task must be started manually.

« Schedule - task will be started at a future date and time entered in the corresponding
calendar field.

b. Click Next.
10. Summary
a. Verify the task specifications as described below:

i. Name - name of the task. You can specify a custom name. The default name is Collect
Account Statistics Task.

ii. Source tenant - name of the tenant where the statistics will be collected.

iii. Scheduled start - date and time when the task will start. Now indicates that the task will start
immediately.

b. Click Back to revise or review a previous step or click Finish to complete the task wizard and start
the task as scheduled.

Review the Collect Account Statistics Task

1. Open the Tasks tab.
2. Select the Collect Account Statistics Task that you want to review.
3. Inthe task details pane that opens, the information presented is as described below:

a. Type - type of the task. The type is Account Assessment.

b. Created - date and time when the task was created.
c. Modified - date and time when the task was last updated.
d. State - state of the task.

e. Last Operation - action that was most recently performed in this task.

f. Schedule - date and time when the task started. Now indicates that the task started immediately
after the task was created.

g. Accounts (number) - number of accounts processed and their task status.

Events (number) - number of events that the task encountered.
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Migration > New Migration Project > Accounts and User Data = Select Collectio

TASKS

- START FEOT  @OELETE  } EOITCOLUMNS Q Search
ride Created eranios x

State Type

Completed Aceourt Assessment Today at 929 P Collected 1 account seatisties.

o Collect Account Statistics Task

Completed Discower Today at 808 PM

Review the statistics collected

1. Open the Tasks tab.
2. Select the Collect Account Statistics Task that you want to review.

3. From the task details pane, click Download Premigration Report. If comparison reports were generated,
click Download comparison report.

4. Download and save the ZIP file to a suitable folder, and extract the report.

NOTE: Premigration reports are also available from the following tasks:

« DiscoverAll
» Discover From File
« Discover From Security Groups

« Refresh Selected Accounts

Review the Collect Account Statistics Task Events

1. Open the Tasks tab.
2. Select atask named Collect Account Statistics Task that you want to review.

3. Inthe task details pane that opens, click Events (number). The Events tab opens with a filtered list of events
for the selected task.

4. Select an event that you want to review. In the task details pane that opens, the information presented is as
described below:

a. Object - name of the account object if applicable.

b. Task - name of the task.
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c. Time - date and time when the event occurred.

d. Category - type of task. the value is Account Assessment.

Assessment

The On Demand Migration account service analyzes your domain structure and tracks potential problems,
misconfiguration, and risks that might adversely affect the migration. Switch to Assessment view to see the
summary reports about the discovered data.

Migration > New Migration Project > Accounts and User Data = Select Collection

ACCOUNTS ONEDRIVE ESKTOP AGENT EVENTS

Clean Up Inventory Adjustments

Disabled accounts 0 Number of users

ron expiring passwords

Users by Type Licenses

Guest user accounts

The following reports are available for Accounts:

+ Clean Up
« Disabled accounts
« Users with non expiring passwords
* Adjustments
« Duplicate group names
« Duplicate user names
« Users without first name
« Users without last name
* Inventory
e Number of users
o Number of groups
+ User by Type
» External Accounts

e« Tenant members
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Licenses
« Available ODM licenses
» Used ODM licenses
o Available Teams only licenses

o Used Teams only licenses

Migrating Accounts

Don’t start a migration before the discovery task is finished. Running a matching task is
recommended.

In this topic:

Considerations for Guest User Migration
Preferred Data Location

Starting an Account Migration Task
Reviewing the Account Migration Task

Reviewing the Account Migration Task Events

Considerations for Guest User Migration

[y
TIP: Guest user accounts have a specific icon E'ﬁ to distinguish them from other domain members.

On Demand migration can process all guest user types supported by Microsoft. Before adding a guest user account
to the migration task, consider the following:

Guest user account cannot be migrated if an original account for this guest user is already in the target
tenant. The guest user account should be matched but not migrated.

Guest user account cannot be migrated in case a guest user account of the same original account is already
in the target tenant. To update the target guest user account properties create a matching task to pair these
guest user accounts and then migrate the source guest user account again

Guest user account cannot be migrated in case the invitation procedure in source domain is not finished yet.
In case acceptance procedure was skipped (this case is deprecated now, but such guest users still exist),
and the acceptance status is empty, guest user can be migrated successfully.

A regular source user mapped to a target guest user during migration, will be converted to a regular user. If
the target guest user was created in an on-premise environment, you must manually convert the target
guest user to aregular user.

Preferred Data Location

For multi-geo enabled tenants, each account could be assigned a Preferred Data Location (PDL) property in
Azure Active Directory. During account migration the property is migrated from source to target tenant. If the
preferred data location is set in the source account then the same setting can be migrated to the target. If the
preferred data location is absent in the source tenant then it will either not be set on the target or it will use the
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default location of the target tenant. This applies only for general tenant to multi-geo tenant and multi-geo tenant to
multi-geo tenant migrations.

Starting an Account Migration Task

1.

2
3.
4

o

Log in to Quest On Demand and choose an organization if you have multiple organizations.
From the navigation pane, click Migrate > Projects to open the My Projects list.
Create a new project or open an existing project.

Click the Accounts tile, or click Open from the Accounts tile to open the Accounts and User Data
migration workspace.

Click the Accounts tab and select List View if not already selected.

Select the accounts you want to migrate. If you are planning to migrate Microsoft 365 Groups including
content, see Microsoft 365 Groups Migration.

Click Migrate from the Actions menu. The New Account Migration Task wizard starts. Each step is
described below:

Custom Target Domain

New Account Migration Task

I Custom Target Domain Custom Azure AD domain name allows you to assign corporate names to the migrated users, such as

user@sitraka.com instead of user@sitraka.onmicrosoft.com.
Custom Source Dom.

Important: Selected option does not affect Office 365 group migration. Email address for Office 365 group will be
created in the default target domain.

M365x734828.onmicrosoft.com v

Tip: To updare the infarmation on available target domain names, re-run the discovery task
Choose how the Preferred Data Location (PDL) will be assigned to target accounts created in multi-geo tenants. This

applies only for general tenant to multi-geo tenant and multi-geo tenant to multi-geo tenant migrations.

a. Configure the options as described below:

« Custom target domain name - select the domain you want to use for the UPN and primary
SMTP address of accounts created during the migration process.

= | NOTE: Accounts that already exist in the target tenant will not have their current UPN
1 ) . o
or primary SMTP email address modified.

o Set target PDL - choose how the Preferred Data Location (PDL) will be assigned to target
accounts created in multi-geo tenants. This applies only for general tenant to multi-geo
tenant and multi-geo tenant to multi-geo tenant migrations. The Microsoft 365 multi-geo
feature must be available and enabled in the target tenant, otherwise this option is ignored.
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« Migrate PDL value from source account - assign the same PDL value as
the corresponding source account, or use the default location specified in the
target tenant.

« Select PDL value to assign - assign a specific PDL value to target accounts.
Choose a PDL from the Location dropdown. See Microsoft 365 Multi-Geo availability
for location codes.

b. Click Next.
9. Custom Source Domain
a. Configure the setting as described below:

+ Custom source domain for routing - select the custom source domain name for
forwarding mail from the target account. If the domain is omitted, the primary SMTP address
of the source tenant will be used as the forwarding address for the mail enabled user created
by this task. Optionally, you can select the custom SMTP domain here that will be used as
the forwarding address.

b. Click Next.

10. Guest Users
This option is used when guest users are migrated. For all other account types, this option is ignored.

Send invitation email - select this option to send an invitation email to migrated guest users. Guest users
can either accept the invitation or authenticate with Microsoft to access secured applications. If this option is
not selected, guest users must authenticate with Microsoft to access secured applications.

11. Notification

a. Send notification email once the task is completed - select this option to send a notification
email when a discovery task completes.

« Only in a case of failure - select this option to send the email if the discovery task fails to
complete successfully.

b. Recipients - enter the email address of the recipients of this email. You can specify multiple
recipient email addresses separated by semicolon.

12. Schedule

a. Choose from one of three options to schedule the task. The scheduler will be activated only after you
complete the task wizard.

* Run now - task runs immediately.
* Run later - task must be started manually.

« Schedule - task will be started at a future date and time entered in the corresponding
calendar field.

b. Click Next.
13. Summary
a. Verify the task specifications as described below:

i. Name - name of the task. You can specify a custom name. Default name is Account
Migration Task.

ii. Source tenant - name of the source tenant in this project.

iii. Target tenant - name of the target tenant in this project.
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iv. Custom target domain name - domain name of your target tenant.

v. Custom domain for forwarding - custom source domain or primary SMTP address of the
source tenant used as the forwarding address for the mail enabled user created by this task.

vi. Scheduled start - date and time when the task will start. Now indicates that the task will start
immediately.

b. Click Back to revise or review a previous step or click Finish to complete the task wizard and start
the task as scheduled.

You can track its progress in the Tasks tab, view the summary on the Dashboard or monitor alerts and notifications
in the Events tab. When accounts are matched successfully, the Status changes from New to Completed.

= | IMPORTANT: The account migration service does not synchronize end-user passwords as part of the data
migration process. The migration administrator will need to reset or synchronize end-user passwords from
the source tenant to the target tenant using native Microsoft 365 tools or third-party Single Sign On tools.

Reviewing the Account Migration Task

1. Open the Tasks tab.
2. Select the account discovery task that you want to review.
3. Inthe task details pane that opens, the information presented is as described below:
a. Type - Type of the task. The type is Migration.
b. Created - Date and time when the task was created.
c. Modified - Date and time when the task was last updated.
d. State - State of the task.
e. Last Operation - The action that was most recently performed in this task.

f. Schedule - Date and time when the task started. Now indicates that the task started immediately
after the task was created.

g. Accounts (number) - The number of accounts that were selected for matching and the number of
accounts passing through the various states from Migrating to Migrated.

h. Events (number) - Number indicates the count of events that the task encountered. The values
indicate the type of the events and the event count for each type.

Reviewing the Account Migration Task Events
1. Open the Tasks tab.

2. Select the account discovery task for which you want to review the events.

3. Inthe task details pane that opens, click Events (number). The Events tab opens with a filtered list of events
for the selected task.

4. Select an event that you want to review. In the event details pane that opens, the information presented is as
described below:

a. Object - name of the account object if applicable.
b. Task - name of the task.

c. Time - date and time when the event occurred.
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d. Category - type of task. For account migration tasks, the category is Migrate.

e. Summary - a descriptive statement about the event.

Migrating Group Membership

You can migrate group members with the Group Membership Migration Task for Distribution Groups, Security
Groups, and Mail-Enabled Security Groups. Teams and M365 groups are not supported by Group Membership
Migration Task.

Membership is migrated for all group members that have been matched.
Unmatched members will be skipped.
Matched accounts in the target tenant are appended to the target group.

Existing group members in the target tenant are not removed.

Starting the Group Membership Migration Task

1.

2
3.
4

o

10.

Log in to Quest On Demand and choose an organization if you have multiple organizations.
From the navigation pane, click Migrate > Projects to open the My Projects list.
Create a new project or open an existing project.

Click the Accounts tile, or click Open from the Accounts tile to open the Accounts and User Data
migration workspace.

Select the Accounts tab and select List View if not already selected.
Select Distribution Groups, Security Groups, and Mail-Enabled Security Groups from the list.

From the actions toolbar, click More > Migrate Group Membership. The New Migrate Group Membership
Task wizard starts. Each step is described below:

Description
a. Read the description to understand the implications of group membership migration.
b. Click Next.

Notification

a. Send notification email once the task is completed - select this option to send a notification
email when a discovery task completes.

+ Only in a case of failure - select this option to send the email if the discovery task fails to
complete successfully.

b. Recipients - enter the email address of the recipients of this email. You can specify multiple
recipient email addresses separated by semicolon.

Schedule

a. Choose from one of three options to schedule the task. The scheduler will be activated only after you
complete the task wizard.

* Run now - task runs immediately.

« Run later - task must be started manually.
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Schedule - task will be started at a future date and time entered in the corresponding
calendar field.

b. Click Next.

11. Summary

a. Verify the task specifications as described below:

Name - name of the task. You can specify a custom name. Default name is Group
Membership Migration Task.

Source tenant - name of the source tenant in this project.
Target tenant - name of the target tenant in this project.

Scheduled start - date and time when the task will start. Now indicates that the task will start
immediately.

b. Click Back to revise or review a previous step or click Finish to complete the task wizard and start
the task as scheduled.

Reviewing the Group Membership Migration Task

You can track a task's progress from the Tasks tab, view the summary on the Dashboard or monitor alerts and

notifications in Events.

You can track the migration state from the Account State column in the Accounts list view. The column values
during and after a task is run are as follows:

Column value

Description

Migrating

Migrated

Migrated with Issues

Migration failed

Migration of this object has started.

» For each source member object (user or group), the matched target
account is added to the matched target group

« If the matched target account is already a member in the group, the
member will not ne processed.

Migration is complete and successful. Matches were found for all source group
members and the target members were added to the target group.

Migration has completed with errors. At least one member was migrated, but
not all. Possible reasons:

» Source member did not matched a target account. Runthe Account
Matching Task or Account Mapping Task for this member, or ignore
if the member is not in scope.

» Source member was matched to a target account, but an error
occurred when trying to add the member to the target group. The
member that failed is listed in the task event. Review error details.

Migration of members did not succeed. Possible reasons:

» Source group did not match a target group. Run the Account
Matching Task or Account Mapping Task, or perform a standard
Account migration.
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Column value Description

« Selected object was a User, Team, or M365 Group. Group
Membership migration is not supported for these objects.

« An error occurred that prevented migrating any members to the
matched target group. Review error details.

Migration stopped Migration canceled by the user.

Domain Coexistence

Mergers and acquisitions are often accompanied by the unification of brands and corporate identities, including the
consolidation of email addresses. However, the transition from source to target tenant might take considerable time.
On Demand Migration offers domain coexistence services to close this gap, allowing your employees to send mail
from new addresses and access cross-tenant data before the migration is finished. The following services are
currently available on the account migration dashboard:

« Address Rewrite Service seamlessly changes the source users' email flow as if they're already fully migrated
to the target tenant. Outgoing email addresses are replaced with the recipient's email address in the target
tenant, while all incoming mail is automatically redirected to the source mailbox. Address rewriting can be
started once the account is matched or migrated, giving you time to prepare and migrate mailboxes. The
Address Rewrite Service requires additional licensing.

o Calendar Sharing allows users from the source and target tenants to see each other's free or busy
information.

Address Rewrite Service

The Address Rewrite Service substitutes the From, To, and Cc addresses in the outgoing emails with the
addresses from the target or source tenant depending on the selected address rewriting scenario. Emails are
automatically redirected to the source or target mailbox. You can specify the users processed by the service. For
example, you can turn on the service for only Sales and Marketing team members.

= | IMPORTANT: Address Rewrite Service requires additional licensing. The service only works with accounts
that have been matched in the target tenant. See matching accounts for more information. Mailbox
provisioning is not required.

Address Rewrite Service Message Flow

Address Rewrite Service is intended for creating a coexistence space for domains in which all the email messages
coming from the source or target mail domain will look like they were sent from the unified mail domain according to
the selected settings. The Address Rewrite Service will take all the necessary steps to create this coexistence
space in the Exchange online environment, including creating and managing all the required connectors, mail flow
rules, mail-enabled users, and groups in source and target environments. The administrator should add or remove
source mail users to this coexistence space and activate or deactivate the Address Rewrite Service.

The mail message flow in a unified domain with an activated Address Rewrite Service is as described below:
Unified mail domain in the source tenant
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1. When a user sends an email as user@target.domain mail user, it is redirected to the Address Rewrite
Service server if it is addressed to external recipients.

2. When the Address Rewrite Service receives an email from user@target.domain, it checks user eligibility to
for the address rewriting service and then processes the email by rewriting @target.domain to
@source.domain for every user address that is found in the coexistence space. The addresses in "From",
"To" and "Cc" fields of the email message are rewritten for all external recipients. Then Address Rewrite
Service passes the processed email message to the source Exchange Online. Internal recipients that reside
in the source receive this email message with unchanged addresses.

3. Exchange Online at the source sends a message to external recipients as if it was sent by a user from
@source.domain, and all addresses of users added to coexistence scope in From, To and Cc are rewritten
for external recipients.

4. The External recipient is not aware about @target.domain and replies (or create a new email) to the
user@source.domain

5. When the reply or a new mail arrives to the source mail domain it will be forwarded to the target. Target
recipient gets the message as if it was forwarded from the Exchange online at the source from
user@source.domain

Rewrite Senders’ Address To:
Source Primary Email Address

. 0ODM components located in Quest Azure

@ Quest Azure AD Azure EE
T T ot Moo B e = - Transport Rules
Domain Name Coexistence Resource Groups |
| | .
Rule From
Load Balancer B Scale s o Quest Coexkstence
‘ cer Azure Scale Set 2 Rule ToCc
| ﬂ iy [ W . | S -
| 5 > ‘ )
. Postfix-based Mail | SMIPS Domain Coexistence |
‘ . Relay Servers . Inbound Connector
s v 5
| L . L [ SMTPS] Domain Coexistence
.. _ T/ oocs6wo Bopoc000000 ] . . . T OQuthound Connector

If the message...

Is sent outside the organization from a member of the coexistence group

Do the following...

Route the message using the connector Quest Coexistence Connector Outbound.
Except if...

Sender IP address belongs to one of Mail Relay IP addresses.

If the message...

Is sent outside the organization and is received by a member of the coexistence group specified in the
To or CC field
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Do the following...

Route the message using the connector Quest Coexistence Connector Outbound.
Except if...

Sender IP address belongs to one of Mail Relay IP addresses.

Mail flow scenario

From: Mail Relay Servers

To: Microsoft 365

How to identify email sent from Mail Relay Servers

Identify incoming messages from Mail Relay Servers by verifying that the sending server's IP address is
within Mail Relay IP address ranges and the sender's email address is an accepted domain in your
organization.

Mail flow scenario

From: Microsoft 365

To: Mail Relay Servers
When to use the connector

Use only when there is a transport rule (Quest Coexistence Rule From and Quest Coexistence Rule
ToCc) is set up that redirects messages to this connector. Routing method Route email messages
through Mail Relay Servers.

Mail flow scenario

From: Mail Relay Servers

To: Microsoft 365

How to identify email sent from Mail Relay Servers

Identify incoming messages from Mail Relay Servers by verifying that the sending server's IP address is
within Mail Relay IP address ranges and the sender's email address is an accepted domain in your
organization.

Unified mail domain in the target tenant

1.

When a user sends an email as user@source.domainit is redirected to Address Rewrite Service server if it is
addressed to external recipients.

When the Address Rewrite Service receives email from user@source.domain, its checks user eligibility for
the address rewriting service and then processes it by rewriting @source.domain to @target.domain for
every user found in the coexistence space. The addresses in "From", "To" and "Cc" of the email message
are rewritten for all external recipients. Then Address Rewrite Service passes the processed email message
to the target Exchange Online. Internal recipients that reside in the source receive this email message with
unchanged addresses.

Exchange Online at the target sends the message to external recipients as if it was sent by
user@target.domain, and all addresses of the users added to the coexistence scope in "From", "To" and
"Cc" are rewritten for external recipients.

External recipient is not aware about @sourcedomain and replies (or create a new email) to
user@target.domain.

When the reply or a new mail arrives to the target mail domain it will be forwarded to the source. Source
recipient gets the message as if it was forwarded from the target Exchange online from user@target.domain
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Rewrite Senders’” Address To:
Target Primary Email Address

Il 0DM components located in Quest Azure
M Exterr
gs| - Azure gs
Transport Rules Domain Name Coexistence Resource Groups Connectors
Domain Coexistence
Woady e . i

Quest Coexistence 1
Rule From

Postfix-based Mail
Relay Servers

Al Domain Coexistence s
[BM] Inbound Connector

|:| If the message...
Is sent outside the organization from a member of the coexistence group

Do the following...

Route the message using the connector Quest Coexistence Connector Outbound.
Except if...

Sender IP address belongs to one of Mail Relay IP addresses.

|Z| If the message...

Is sent outside the organization and is received by a member of the coexistence group specified in the
To or CC field

Do the following...

Route the message using the connector Quest Coexistence Connector Outbound.
Except if...

Sender IP address belongs to one of Mail Relay IP addresses.

IZI Mail flow scenario
From: Microsoft 365
To: Mail Relay Servers
When to use the connector

Use only when there is a transport rule (Quest Coexistence Rule From and Quest Coexistence Rule
ToCc) is set up that redirects messages to this connector. Routing method Route email messages
through Mail Relay Servers.

IZI Mail flow scenario
From: Mail Relay Servers
To: Microsoft 365
How to identify email sent from Mail Relay Servers
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Identify incoming messages from Mail Relay Servers by verifying that the sending server's IP address is
within Mail Relay IP address ranges and the sender's email address is an accepted domain in your
organization.

Mail flow scenario

From: Mail Relay Servers

To: Microsoft 365

How to identify email sent from Mail Relay Servers

Identify incoming messages from Mail Relay Servers by verifying that the sending server's IP address is
within Mail Relay IP address ranges and the sender's email address is an accepted domain in your
organization.

i TIP: If Exchange Server Integration fails, click Try to fix and Quest will try to help you resolve the issue.

Using the Address Rewrite Service requires following steps:

# Step

1 Select Scenario for Address Rewriting

2 Provision Address Rewrite Service

3 Add mailboxes to address rewriting

4 Optional: Add Address Rewrite Service's IP address to the target DNS SPF record

5 Activate address rewriting. You can deactivate address rewriting at any time or turn off

address rewriting for individual mailboxes

Address Rewrite Service Considerations

Each customer has a dedicated environment and inbound IP address for Address Rewrite Service.

Do not edit or remove the groups, connectors and rules related to Address Rewrite
Service otherwise the service may fail. These rules can be removed manually only if address
rewriting no longer needed.

The following groups, connectors and rules appear in Exchange Admin Centers after Exchange Server Integration
is configured depending on which rewrite direction is chosen:

Rewrite Senders’ Address to Target
On source tenant:

« Quest On Demand Coexistence group contains accounts (recipients) joined to Address Rewriting

+ Inbound Quest Coexistence Connector helps control mail flow for Address Rewrite Service from Microsoft
365 to the organization

« Outbound Quest Coexistence Connector helps control mail flow for Address Rewrite Service from the
organization to Microsoft 365

* Quest Coexistence Rulesimplement Address Rewriting messaging policy for accounts joined to
Address Rewriting

On target tenant:
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« Quest Coexistence Connector helps control flow of email messages for Address Rewrite Service from the
organization to Microsoft 365

Rewrite Senders’ Address to Source
On source tenant:

+ Quest Coexistence Connector helps control flow of email messages for Address Rewrite Service from the
organization to Microsoft 365

On target tenant:

+ Quest On Demand Coexistence group contains accounts (recipients) joined to Address Rewriting

+ Inbound Quest Coexistence Connector helps control mail flow for Address Rewrite Service from Microsoft
365 to the organization

« Outbound Quest Coexistence Connector helps control mail flow for Address Rewrite Service from the
organization to Microsoft 365

« Quest Coexistence Rulesimplement Address Rewriting messaging policy for accounts joined to
Address Rewriting

NOTE:

The service only works with accounts that have pairs in the target tenant. You should match or migrate an
account before adding it to address rewriting.

In case an email is sent to a group of people, including a migrated user, that email is automatically forwarded
to the migrated user, and then if the migrated user clicks Reply all, he / she gets a copy of his / her reply
message. This is default behavior.

Address Rewriting Scenarios

Address Rewriting supports the following scenarios:

« Replace senders’ address with the target primary email address.

« Replace senders’ address with the source primary email address.

NOTE:

« The address is only rewritten in the mail that goes to the recipients outside your organization. Internal
users receive the mail with the original address. Microsoft

« M365 Advanced Threat Protection default settings may cause issues with the Address Rewriting
Service. Please ensure that "Automatic forwarding" is set to "On" in the "Outbound spam filter policy"
for your source or target tenant depending on the rewriting scenario you choose.

Rewriting senders’ address to the target address

Use case: users from the source tenant need to communicate with external recipients from the name of the
target organization. It usually happens when the mail migration is not yet finished, but you want to use the
consistent branding.

To rewrite senders’ address to ones from the target select To target for the Rewrite senders’ address to on the
Domain Coexistence widget. You cannot change this setting after Address Rewrite Service is provisioned.
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Check Senders' Address property on the Mailboxes tab to find the effective email address after rewriting. If the
account don't have the Exchange mailbox provisioned in the target tenant (mail user), the target primary SMTP
address is used for address rewriting.

IMPORTANT: We recommend that all incoming mail is automatically redirected to the source mailbox. Set
Mail Flow for the mailbox to To source.

Rewriting senders’ address to the source address

Use case: migrated users need to communicate with external recipients from the name of the source organization.
It usually happens when you need to keep the original brand while merging all accounts in the target tenant.

To rewrite senders’ address to ones from the source select To source for the Rewrite senders’ address to on the
Domain Coexistence widget. You cannot change this setting after Address Rewrite Service is provisioned.

Check Senders' Address property on the Mailboxes tab to find the effective email address after rewriting.

= | IMPORTANT: We recommend that all incoming mail is automatically redirected to the target mailbox. Set

Mail Flow for the mailbox to To target.

Provisioning the Address Rewrite Service

IMPORTANT: After Address Rewrite Service provisioning starts, you cannot change the setting of the
sender's address to be rewritten.

1. Open the project dashboard.
2. Click Provision for Address Rewrite Service from the Domain Coexistence widget.

3. Wait until the service is provisioned and Exchange Server Integration is successfully configured.

The provisioning might take some time. In the meanwhile, you can select the mailboxes for the address rewriting.

Selecting Mailboxes for Address Rewriting

1. Loginto Quest On Demand and choose an organization if you have multiple organizations.
2. From the navigation pane, click Migrate > Projects to open the My Projects list.

3. Create a new project or open an existing project.
4

Click the Accounts tile, or click Open from the Accounts tile to open the Accounts and User
Data dashboard.

o

Click the Mailboxes tab or click Select in the Domain Coexistence tile.
6. Click Off in Address Rewrite facet to show the mailboxes that are ready for address rewriting.

+ | IMPORTANT: Address Rewrite Service only works with accounts that have pairs in the target tenant. You

can click Not Supported in Address Rewrite facet to see the mailboxes that are not ready for address
rewriting.

7. Select the mailboxes and click Address Rewrite.

8. In Address Rewrite Management task, select Turn on address rewriting for selected mailboxes.
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9. Click Next to view the task summary. Check selected options, name the task, and click Finish to
start the task.

10. Thetask is created. You can track its progress in the Tasks or monitor alerts and notifications in the Events.

You can add the mailboxes to address rewriting at any time. Note, that if the Address Rewriting Service is already
enabled, it might take a while before the rewriting will be enabled for the newly added mailbox. Check that Address
Rewrite status is On for the mailbox.

Configuring SPF Record

During the provisioning phase, we configure the target Exchange Server to correctly handle messages, processed
by Address Rewrite Service. If you want to be absolutely sure that the messages are not blocked by custom filters
and antiviruses, add the service's IP address to SPF record in target DNS.

« On Domain Coexistence widget, click Running to locate the event containing IP address of the Address
Rewrite Service server.

« Add the IP address to the SPF record in the target DNS. See provider's documentation for instructions.

Activating Address Rewriting

1. Make sure you have added the mailboxes to address rewriting. Click On in Address Rewrite to show the
joined mailboxes.

2. Go to the account migration dashboard and click Enable Coexistence in Domain Coexistence.

Deactivating Address Rewriting for Individual Mailboxes
1. Go to the migration project Dashboard

Click Accounts.

Open Mailboxes

Click On in Address Rewrite facet to show the mailboxes for which address rewriting is enabled.

Select the mailboxes for which you want to turn off address rewriting and click Address Rewrite.

I T

In Address Rewrite Management task, select the Stop address rewriting for the selected
mailboxes option.

7. Click Next to view the task summary. Check selected options, name the task, and click Finish to
start the task.

8. Thetask s created. You can track its progress in the Tasks or monitor alerts and notifications in the Events.

Deactivating Address Rewriting
1. Go to the migration project Dashboard.
2. Click Accounts.

1. Click Disable in the Domain Coexistence widget.

= | NOTE:You can turn Address Rewrite Service off at any time to stop sending outgoing messages with
substituted email address. The list of joined mailboxes is not affected.
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Deactivate the Address Rewrite Service if you want to delete the migration project.

Calendar Sharing

Create a relationship between the source and the target tenants to allow users to retrieve calendar availability
information,

1.

2
3.
4

o

Log in to Quest On Demand and choose an organization if you have multiple organizations.
From the navigation pane, click Migrate > Projects to open the My Projects list.
Create a new project or open an existing project.

Click the Accounts tile, or click Open from the Accounts tile to open the Accounts and User
Data dashboard.

Click Enable Calendar Sharing and verify the source and target domain names. Click Next to proceed.
Schedule when the task will be started. Click Next to view the task summary.

Name the task and check the selected options. Click Finish to save or start the task depending on schedule
option selected.
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Mailbox Migration

Basic mailbox migration workflow consists of the following steps:

# Step

1 Collect Statistics

2 Migrate Mailboxes

3 Optional: Use Desktop Update Agent (DUA) to automatically reconfigure user Microsoft

Outlook Profiles to connect to the Exchange Online server in the target tenant.

What We Migrate

Migration limitations indicated below may not be an exhaustive list of limitations as some may appear in unique
customer migration scenarios, or arise due to platform or legacy support restrictions. In some cases, a solution to a
limitation may already be on the product roadmap.

Quest On Demand migrates the following Mailbox components:

Mailbox Type Support Comments

User mailbox v

Shared mailbox v

Distribution Group v

Microsoft 365 Groups v

Resource mailbox v e.g. conference rooms, equipment

Component Support Comments

Inbox v

Folders v

Email v Migration of messages inside the mailbox root
folder (TIS / Top of Information Store) is not
supported.

Calendars v

Tasks v
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Component Support Comments

Journals v

Notes v

Rules v

Folder Permissions v

Public folders v

Calendar acceptance status emails v

Resource calendar permissions (e.g., for v

conference rooms)

Personal distribution lists v

Personal contacts v

Bounce notifications such as non-delivery v

reports or receipts (NDR)

Delivery Status Notifications (DSN) v

Custom rules like color categorization of v

emails, specific logic, sub-calendars and flags

Calendar notifications such as invites, v

responses, cancellations, etc.

PST Connection to Outlook Profile v

Calendar permissions sharing to more than 2 v

users

Pictures that have been added within a v

Business Card

Deleted items including recoverable deleted v

items.

Mailbox permission settings, sharing settings, v

delegates, and other mailbox-related settings

PST personal archives X Quest Offers a solution for PST to M365
migration

Safe Sender or Blocked Lists v

RSS Feeds X

Client settings (e.g., default fonts), folder X

views, outlook customizations

User defined or custom fields X

Notifications scheduled more than one week in X Default notifications that are set to 15 or 30

the future minutes will be migrated.

Outlook Quick Steps X
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Mailboxes List View

The List View displays the summary of the Mailboxes from the source and target tenants. Initially, the List View
displays the list of accounts with mailboxes and other columns are blank. As you run the discovery, collect statistics
and migration tasks, the list view will display more information about the accounts and the state of the mailbox
migrations.

To open the List View, open the Accounts and User Data migration workspace. Then select the Mailboxes tab and
then select List View if not already selected.

The Mailboxes List View is comprised of the following components:

Notification panel - presents relevant information and shortcuts to migration activities.

Filter panel - consists of predefined filters to help you search for mailboxes. See Filtering for more information
about working with filters. The predefined filters are:

Mailbox State - returns a list of mailboxes based on the based on the selected mailbox stage. See the
Mailbox State column description below for filter values.

Archive Mailbox State - returns a list of mailboxes based on the various stages in the migration process for
mailboxes with archiving enabled.

Mailbox Type - returns a list of mailboxes based on the type of mailbox. See the Type column described
below for filter values.

Mailbox View - returns a list of mailboxes with or without archives. The filter values are:
« Mailboxes with archive - mailboxes that have an archive enabled
« Mailboxes without archive - mailboxes that don't have archive enabled.

Address Rewrite - returns a list of mailboxes based on the availability of the Address Rewrite feature. See
the Address Rewrite column description below for filter values.

Mailbox Size - returns a list of mailboxes based on the size of the mailbox. See the Size column description
below for filter values.

Mail Flow - returns a list of mailboxes based on the mail forwarding direction of the mailbox. See the Mail
Flow column description below for filter values.

List View - displays information about Mailboxes in the source and target tenants. Use the Edit Columns to show
or hide columns in the list. The columns are as described below:

Type - icon that indicates the type of mailbox. The following mailbox types are supported:

1. User -mailbox associated with an individual user or account. It stores and manages email
messages, contacts, calendar events, and other personal information for a specific user.

2. Resource - mailbox designed for non-human entities or shared resources rather than individual
users. It is used to manage and organize emails, events, or other information related to a specific
resource such as a meeting room, equipment, or shared space.

a. Room - mailbox is specifically used to manage and coordinate reservations and scheduling
for physical meeting rooms or spaces. Users can book or schedule the room through the
room mailbox, helping to avoid conflicts and ensure efficient use of meeting spaces.

b. Equipment - similar to a room mailbox but is used to manage resources other than meeting
rooms, such as projectors, audio-visual equipment, or any shared equipment. It helps in
scheduling and coordinating the use of equipment among different users.
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c. Scheduled - mailbox associated with a specific schedule or timeline. It might be used to
manage and organize emails or events based on predefined schedules or timeframes.

d. Shared - a mailbox that multiple users can access and use collaboratively. It is often used for
teams or groups to manage communications, such as a shared email address for customer
support or a shared calendar for a project team.

« Name - name of the account in the source tenant.
« Mailbox State - indicates various mailbox stages in the migration process of a primary mailbox.
» Discovered - mailbox-enabled account has been found in the source tenant.
« Provisioning - mailbox is being set up in the target tenant.
» Provisioning Failed - mailbox could not be set up in the target tenant.
* Matched - mailbox in source matched to mailbox in target tenant.
+ Mapped - mailbox in source mapped to mailbox in target tenant.

» Queued - mailbox migration task is waiting for migration service resources to be available. For more
information, see How Queuing Works.

« Migrating - source and target tenants analyzed and mailbox migration started.
« Migrated - mailbox migrated successfully to the target tenant.

+ Migrated with Issues - some content is migrated but errors or warnings were encountered during
migration. Use a reporting task to look for missing files or other errors.

» Migration Failed - critical error occurred during migration and nothing has been migrated. See task
event details for more information.

« Switched - mailbox is switched between source and target.
« Migration Stopped - mailbox migration task has been stopped by the user.

o Task Status - status of the most recent task that was run for this mailbox. Valid values are New, Stopped, In
Progress, Failed and Completed.

« Source Mailbox - account mailbox in the source tenant.

« Target Mailbox - account mailbox in the target tenant.

o Source UPN - User Principal Name (UPN) of the source account.

o Target UPN - User Principal Name (UPN) of the target account.

« Mail Flow - indicates the mail forwarding direction. Valid values are To source, To target or Not Set.

+ Address Rewrite - indicates whether another domain is being used for this mailbox. Valid values are:
1. On-domainis setup and is active.
2. Off - domain is setup and is inactive.
3. Not supported - domain is not setup.

o All Items - number of all the items in a mailbox. Includes email messages, contacts, calendar events, and
other personal information

o Size - size of the mailbox in MB

« Items to Migrate - the number of items considered for migration in the primary mailbox after the
estimation phase

« Processed - the number of items in the primary mailbox which were attempted to migrate.
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« Errors - count of errors during migration.

« Archive Mailbox Status - indicates various mailbox stages in the migration process of an archive
enabled mailbox.

o Archive Items to Migrate - the number of items considered for migration in the archive enabled mailbox
after the estimation phase

« Archive Processed - the number of items in the archive enabled mailbox which were attempted to migrate.

« Collections - indicates the most recent collection where the corresponding account is added and the
number of additional collections that also contain this object.

Mailbox Details

When you select an mailbox-enabled account from the List View, the Mailbox Detail pane opens. The information in
the pane is described below:

o Source UPN - User Principal Name (UPN) of the source account.

o Target UPN - User Principal Name (UPN) of the target account.

« Status - status of the most recent task that was run for this mailbox. Valid values are New, Stopped, In
Progress, Failed and Completed.

« Last Synced - date and time the mailbox was last synchronized.
« Events - count of the events that occurred during mailbox processing through one or more tasks.
« Collections - list of collections that contain the selected mailbox-enabled account.

« Tasks - list of tasks invoked for the selected mailbox-enabled account.

Managing Mailboxes with Collections

See the topic Managing Accounts with Collections. The actions and steps described in the topic are the same for
managing OneDrive accounts with collections.

Collecting Statistics

A Collect Mailbox Statistics Task conducts an assessment of mailboxes of all accounts in the source tenant and
matching accounts in the target tenant.

Each Collect Mailbox Statistics Task generates events. Events are milestones that a task achieves as it runs.
For example, when a Collect Mailbox Statistics Task starts, an event is logged and it appears in the events list.
When the number of accounts that are selected for assessment is large, the Collect Mailbox Statistics Task
divides the total number of accounts into manageable sets. Each set is called a batch. When a batch of accounts is
assessed, another event occurs.

NOTE: Before you proceed, verify that the source tenant accounts have been discovered. For more
information see Discovering Accounts

In this topic:
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Create and run a Collect Mailbox Statistics Task
Review the Collect Mailbox Statistics Task
Review the events for the Collect Mailbox Statistics Task

Review the statistics collected

Create a Collect Mailbox Statistics Task

o o A~ w0 DN

10.

Log in to Quest On Demand and choose an organization if you have multiple organizations.

From the navigation pane, click Migrate > Projects to open the My Projects list.

Create a new project or open an existing project.

Click the Mail tile, or click Open from the Mail tile to open the Accounts and User Data dashboard.
Select the Mailboxes tab and then select List View if not already selected.

Select the accounts in the list from where you want to collect statistics. You can use search, filtering or
collections to quickly navigate through the list of mailboxes. You can select the check box in the table header
to select all the accounts.

Click Collect Statisticsfrom the Actions ribbon. The New Collect Mailbox Statistics Task wizard starts.
Each step is described below:

Description

a. Refresh mailbox statistics that have been already been collected- select this checkbox if
needed to refresh statistics collected from previous tasks.

b. Collect statistics from target - select this option to collect statistics from the target tenant and
generate the Comparison Report.

c. Click Next.
Notification

a. Send notification email once the task is completed - select this option to send a notification
email when a discovery task completes.

« Only in a case of failure - Select this option to send the email if the discovery task fails to
complete successfully.

b. Recipients - enter the email address of the recipients of this email. You can specify multiple
recipient email addresses separated by semicolon.

c. Click Next.
Schedule

a. Choose from one of three options to schedule the task. The scheduler will be activated only after you
complete the task wizard.

* Run now - task runs immediately.
* Run later - task must be started manually.

« Schedule - task will be started at a future date and time entered in the corresponding
calendar field.

b. Click Next.
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11. Summary
a. Verify the task specifications as described below:

i. Name - name of the task. You can specify a custom name. The default name is Collect
Mailbox Statistics Task.

ii. Source tenant - name of the tenant where the statistics will be collected.

iii. Scheduled start - date and time when the task will start. Now indicates that the task will start
immediately.

b. Click Back to revise or review a previous step or click Finish to complete the task wizard and start
the task as scheduled.

Review the Collect Mailbox Statistics Task

1. Open the Tasks tab.
2. Select the Collect Mailbox Statistics Task that you want to review.
3. Inthe task details pane that opens, the information presented is as described below:
a. Type - Type of the task. The type is Mailbox Assessment.
b. Created - Date and time when the task was created.
c. Modified - Date and time when the task was last updated.
d. State - State of the task.
e. Last Operation - The action that was most recently performed in this task.

f. Schedule - Date and time when the task started. Now indicates that the task started immediately
after the task was created.

g. Events (number) - The number of events that the task encountered.

ts and User Data

@) Collect Mailbox Statistics Task
LV

Review the statistics collected

1. Open the Tasks tab.

2. Select the Collect Mailbox Statistics Task that you want to review.
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3.
4.

From the task details pane, click Download Premigration Report.

Download and save the ZIP file to a suitable folder, and extract the report.

Review the Collect Mailbox Statistics Task Events

1.
2.
3.

Open the Tasks tab.
Select a task named Collect Mailbox Statistics Task that you want to review.

In the task details pane that opens, click Events (number). The Events tab opens with a filtered list of events
for the selected task.

Select an event that you want to review. In the task details pane that opens, the information presented is as
described below:

a. Object - name of the account if applicable.
b. Task - name of the task.
c. Time - date and time when the event occurred.

d. Category - type of task. the value is Mailbox Assessment.

Assessment

When you complete the collection of statistics for the mailboxes you can view the reports about the mailboxes. Open
the Assessment view to see the reports described below.

Mailbox statistics
+ Total mailboxes
« Total size
* Average size
« Maximal size

« Average ltem Count

o Toclean up

« The users not logged on to mailbox for 30 days
» The users not logged on to mailbox for 90 days
» The users never logged on to mailbox

« Disabled users with mailbox

* Inventory

« Mailboxes with archive

+ To adjust

» Mailboxes with duplicate user name

When you are done with the assessment you are ready to start the migration.
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Migrating Mailboxes

Before you proceed, verify that the mail-enabled accounts in the source tenant have been discovered and matched.
For more information see Discovering Accounts or Matching and Mapping Accounts.

In this topic:
« Considerations
o Limitations
o Migrating Rules
» Migrating Delegate Permissions
» Migrating Folder Permissions
« Starting a Mail Migration Task
« Examples

« Reviewing the Mail Migration Task

Considerations

» The following types of mailboxes are supported: Regular, Room, Equipment (Resource), Shared.

« During remigration, On Demand Migration remigrates mail, calendar, task, and sticky note items that have
changed in the source mailbox to the target mailbox. Remigration of other types of items that have been
modified or deleted in the source mailbox is not supported.

The following types of changes are synchronized during remigration:
Messages:

* Message is updated in the target if changed in the source (including changes to drafts).
« Message is moved to a different folder in the target if message is moved in the source.

» Message is deleted in the target if message is deleted in the source.

Folders and Subfolders:
« Folder and subfolder names are updated in the target if renamed in the source.
« Folderis moved to a different location in the target if the folder is moved in the source.

« Folderis deleted in the target if folder is deleted in the source.

Calendar items:
« Calendar item is updated in the target if the item is changed in the source.
« Calendar item is deleted in the target if the item is deleted in the source.

= | NOTE: If Contacts, Tasks and Sticky Notes items are deleted in the source, they will not be deleted in
the target.

« The migration service performs a full comparison of the source and target tenants during remigration if one
of the following Mail Migration Task configurations is used, ensuring that messages are not moved or
deleted, and folders are not moved, renamed, or deleted in the target:
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Mail Folders:
« Migrate all folders except.
« Migrate specific folders.
« Migrate to custom folder.

o Migrate to folder.

Date Range:
« Only migrate mail within specified date range.
« Source or target is not Exchange Online (O365).
% | NOTE: Tasks that use the configurations listed above do not save mail synchronization states. As a

result, these tasks can impact subsequent tasks, potentially causing messages or folders to remain
unchanged (not deleted, moved, or renamed) which leads to duplicates in the target tenant.

« The Microsoft 365 Groups migration service performs a full comparison during remigration as well, between
the source and target, ensuring that messages are not moved or deleted, and folders are not moved,
renamed, or deleted in the target.

» During mail migration, users may want to receive emails from both source and target mailboxes, or keep
custom forwarding. You can set this up in two ways:

« Select the Manage Mail Forwarding options in the Mail Flow step of the New Mail Migration
Task wizard.

o Set up mail forwarding with the New Mailbox Switch Task wizard after you complete the
mail migration.

« For each task, the maximum number of mailboxes is limited to 1000. Please contact Quest Technical
Support if larger lists are required in a single task.

Limitations

On Demand Migration is designed to provide a robust migration experience for a variety of source and target
platforms. However, some limitations exist that are the result of inherent discrepancies between email service
platforms and cannot be fixed.

General
» Migration of messages inside the mailbox root folder (TIS / Top of Information Store) is not supported.

* You must discover and match Sensitivity Labels if you plan to migrate email items with label. Otherwise the
migration will fail with the error message:m "Failed to prepare migration plan, no mapping exists for labels."

Rules

» Autodiscover must be enabled on your target for successful rules migration.

» During the migration, the name of a group participating in a source rule will be converted to an SMTP email
address. The address is retrieved from the mailbox list of the migration plan, and will be used in the
corresponding target rule.

« Migration of rules from or to personal archives is not supported.

Delegates
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« Migration of customized delegate permissions is currently not supported:

« Custom folder permissions are migrated as None (lack of any permissions) when the target delegate
does not exist.

« If the target delegate exists, source and target delegate permissions are merged and the predefined
Roles (Editor, Author, Reviewer and None) take precedence over any Custom permission set.

« If the target delegate exists and both source and target permissions are set to Custom, the target
permissions will be set to None.

Folder Permissions

« Folder permissions for Recoverable Items are not migrated.
» Folder permissions from personal archive and to personal are not migrated.

+ The migration service will attempt to migrate permissions for all folders in the mailbox tree and create
folders for each, regardless of the content type selected for migration. If a custom folder is specified, non-
mail folder permissions are not migrated to the target tenant.

Migration to a Custom Folder

« Mailbox rules are not migrated.
« Mail folders, their content and permissions are migrated to the custom folder.

« Content and permissions of non-mail folders cannot be migrated either to the custom folder or to their default
location because non-mail folders are not migrated to the target tenant when a custom folder is specified.

Migrating Rules

This includes OWA (Outlook Web App) Inbox rules, and the rules created in an Outlook client version 2019, 2016,
2013, 2010, or Outlook for Microsoft 365. Migration of rules created in Outlook for Exchange 2010 is not supported.

For all mailboxes that are migrated to existing target mailboxes, On Demand Migration removes the existing rules
from the target tenant like OWA Inbox rules and the rules created in Outlook from the target tenant including
previously-migrated rules. Then all the rules from the source are migrated to the target.

If the rules in a user's target Outlook do not match the rules on the server, the following
message appears when the user opens the target mailbox in Outlook after migration:

The rules on this computer do not match the rules on Microsoft Exchange. Only one set of rules can be kept.
You will usually want to keep the rules on the server. Which rules do you want to keep?

In this case, the user must select "Server" to avoid data loss.
Rules that contain unsupported conditions or actions will not be migrated, or will not work after migration. So, you
must set them up manually on the target.
The following tables list the supported Outlook conditions:

Outlook Condition Outlook Outlook Outlook Outlook Outlook for
2019 2016 2013 2010 Microsoft 365

from people or public group Yes Yes Yes Yes Yes

with specific words in subject Yes Yes Yes Yes Yes

through the specified account No No No No No
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Outlook Condition Outlook Outlook Outlook Outlook Outlook for
2019 2016 2013 2010 Microsoft 365
sentonly to me Yes Yes Yes Yes Yes
where my name is in the To box Yes Yes Yes Yes Yes
marked as importance Yes Yes Yes Yes Yes
marked as sensitivity Yes Yes Yes Yes Yes
flag for action Yes Yes Yes Yes Yes
where my name is in the Cc box Yes Yes Yes Yes Yes
where my name is in the To or Cc Yes Yes Yes Yes Yes
box
where my name is notinthe Tobox  Yes Yes Yes Yes Yes
sent to people or public group Yes Yes Yes Yes Yes
with specific words in the body Yes Yes Yes Yes Yes
with specific words in the subjector  Yes Yes Yes Yes Yes
body
with specific words in the message Yes Yes Yes Yes Yes
header
with specific words in the recipient's  Yes Yes Yes Yes Yes
address
with specific words in the sender's Yes Yes Yes Yes Yes
address
assigned to specific category Yes Yes Yes Yes Yes
assigned to any category Yes Yes Yes Yes Yes
which is an automatic reply Yes Yes Yes Yes Yes
which has an attachment Yes Yes Yes Yes Yes
with a size in a specific range Yes Yes Yes Yes Yes
received in a specific date span Yes Yes Yes Yes Yes
uses the specific form Yes Yes Yes Yes Yes
sender is in specific Address Book No No No No No
with selected properties of Yes Yes Yes Yes Yes
documents or forms
which is a meeting invitation or Yes Yes Yes Yes Yes
update
from RSS feeds with specified textin  Yes Yes Yes Yes Yes
the title
from any RSS feed Yes Yes Yes Yes Yes
of the specific form type Yes Yes Yes Yes Yes
on this computer only Yes Yes Yes Yes Yes
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The following tables list the supported Outlook actions:

Outlook Action Outlook Outlook Outlook Outlook Outlook for
2019 2016 2013 2010 Microsoft 365
move it to the specified folder Yes Yes Yes Yes Yes
move a copy to the specified folder Yes Yes Yes Yes Yes
assign it to the specific category Yes Yes Yes Yes Yes
delete it Yes Yes Yes Yes Yes
permanently delete it Yes Yes Yes Yes Yes
forward it to people or public group Yes Yes Yes Yes Yes
forward it to people or distribution listas Yes Yes Yes Yes Yes
an attachment
redirect it to people or distribution list Yes Yes Yes Yes Yes
have server reply using a specific No No No No No
message
reply using a specific template Yes Yes Yes Yes Yes
flag message for action in a numberof  Yes Yes Yes Yes Yes
days
clear the Message Flag Yes Yes Yes Yes Yes
clear message's categories Yes Yes Yes Yes Yes
mark it as importance Yes Yes Yes Yes Yes
print it Yes Yes Yes Yes Yes
play a sound Yes Yes Yes Yes Yes
start application N/A No No No N/A
mark it as read Yes Yes Yes Yes Yes
run a script N/A No No No N/A
perform a custom action N/A N/A N/A No N/A
display a specific message inthe New  Yes Yes Yes Yes Yes
Item Alert window
display a Desktop Alert Yes Yes Yes Yes Yes
apply retention policy No No No No No
stop processing more rules Yes Yes Yes Yes Yes

The following tables list the supported OWA Inbox conditions:
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OWA Condition for Microsoft 365

Microsoft 365

People

My name is

Subject

Keywords

Marked with

Message includes

Message size

Received

All messages

From

To

I'mon the To line

I'm on the Ccline

I'mon the To or Ccline
I'm not on the To line

I'm the only recipient
Subjectincludes

Subject or body includes
Message body includes
Sender address includes
Recipient address includes
Message header includes
Importance

Sensitivity

Classification

Flag

Type

Has attachment

At least

At most

Before

After

Apply to all messages

The following tables list the supported OWA Inbox actions:

OWA Action for Microsoft 365

Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes

Yes

Microsoft 365

Organize

Move to
Copy to
Delete

Pin to top

Yes
Yes
Yes

Yes
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OWA Action for Microsoft 365 Microsoft 365

Mark message Mark as read Yes
Mark as Junk Yes
Mark with importance Yes
Categorize Yes
Route Forward to Yes
Forward as attachment Yes
Redirect to Yes
Stop processing more rules Yes

Migrating Delegate Permissions

There are two types of delegate access permissions in Exchange on-premises and Exchange Online. and both of
them are supported by ODM:

Full Access, Send As, Send on Behalf - These permissions are generally used for mailbox-level access and are
configured in the Exchange Admin Center or via PowerShell. For more information, see the Microsoft article:
Manage permissions for recipients in Exchange Online.

Reviewer, Author, Editor etc. - These permissions are typically used to control access to folders within a mailbox,
such as the Inbox or Calendar, and they are set at the folder level. For more information, see the Microsoft article:
About Delegates.

On Demand Migration migrates delegate permissions in the following ways.
« Ifamatched delegate exists in the target, mailbox delegation permissions can be transferred.

« If a matched delegate does not exist in the target, mailbox delegation cannot be migrated and an error event
will occur.

« [fthe target mailbox delegation is not set, the mailbox delegation will be transferred as is.

« If the mailbox delegation has been set in the target tenant before the migration starts, rules and exceptions
as specified below will be applied.

Source Target (in case matched delegate does not exist in target)
Delegate access permission on Delegate access permission on Delegate access permission on
source target before migration target after migration

None N/A None

Reviewer N/A Reviewer

Author N/A Author

Editor N/A Editor

Customized set (except None, N/A None

Reviewer, Author, Editor)
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Source Target (in case matched delegate exist in target)

Delegate access Delegate access Delegate access permission on target after
permission on source permission on target migration
before migration

None or customized set None or customized set None

(except None, (except None,
Reviewer, Author, Reviewer, Author,
Editor) Editor)
Customized set (except Reviewer, Author, Reviewer, Author, Editor values from target.
None, Reviewer, Editor
Author, Editor)
Reviewer, Author, Customized set (except Reviewer, Author, Editor values from source.
Editor None, Reviewer,
Author, Editor)
Reviewer, Author, Reviewer, Author, Most permissive value between the source and
Editor Editor

target access permissions.
Possible values - Reviewer, Author, Editor

Migrating Folder Permissions

If the target folder permission does not exist, permissions are migrated as is.

« Ifthe target folder permission exists before a migration starts, the most permissive value between the source

and target access permissions will be set.

Starting a Mail Migration Task

1.

2
3.
4.
5

Log in to Quest On Demand and choose an organization if you have set up multiple organizations.
From the navigation pane, click Migrate > Projects to open the My Projects list.

Create a new project or open an existing project.

Click the Mailtile, or click Open from the Mail tile to open the Accounts and User Data dashboard.

Click the Mailboxes tab. The Mailboxes List opens. If you don't see a list of mailbox-enabled accounts, you
must run the New Account Discovery Task again.

Select the mailbox accounts in the list that you want to migrate. You can use search, filtering or collections to
quickly navigate through the list of mailboxes. You can also select the check box in the table header to select
all the mailbox accounts.

From the local toolbar, select Migrate Mail. The New Mail Migration Task wizard starts. Each step is
described below:

Start
a. Task Name - You can specify a custom task name. The default name is Mail Migration Task.

b. Use the settings from an existing migration template for this task - select this option if you
have already saved a previous migration templates. if this is the first time you are migrating
mailboxes, keep this option unchecked.

» Select template - select a template that you previously created, from the dropdown list.
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c. Go to Summary step - select this option to preserve the settings and go directly to the last step of
the wizard. If you do not select this option, but you have selected a template, you can step through
the wizard and edit the settings in the template.

d. Click Next.
9. Licensing Plan

a. Set license at the target - select this check box to assign a selected license to migrated mailbox
accounts in the target tenant. Clear the check box to skip license assignments for migrated
mailbox accounts.

b. Select the licensing plan - this dropdown list appears if the Set license at target check box is
checked. Select the licensing plan from the dropdown list that you want to assign to migrated
mailboxes.

c. Specify how the selected licensing plan will be assigned to the target accounts:

« Assign the plan to accounts without Exchange Online option. Licensed users will
retain the existing plans - Retain the existing licenses and assign the selected plan only to
unlicensed accounts (default). Licensed users will retain the existing plans.

« Assign the plan to all accounts. Licensed users will be switched to the selected plan
- Replace all license assignments with the licenses from the selected plan. Licensed users
will be switched to the selected plan.

i NOTE:

« Resource mailboxes that have not been licensed on the source tenant will retain the
unlicensed status.

« Licensed resource mailboxes will be handled according to the selected option.

« Incase no usage location is set on the target the source value will be used for the
assigned license. Otherwise the target usage location value remain unchanged and
can be modified manually, if necessary.

« Ifnolicense plan is selected users that are unlicensed at the target will fail to migrate.

« Selected licensing option is only applicable to Exchange Online. It does not affect the
licensing plans picked for OneDrive Migration

d. Click Next.

10. Migration Options
a. Specify a migration flow:

« From Primary Mailbox to Primary mailbox - migrate content of the primary mailbox
(default scenario.)

« From Archive mailbox to Archive mailbox - migrate content of the archive mailbox.
+ From Archive mailbox to Primary mailbox - restore archived content to primary mailbox.

o From Primary mailbox to Archive mailbox - migrate some of the content of the primary
mailbox to archive. Useful with the specific Migration Options selected.

b. Specify which mailbox items you want to transfer to the target by selecting the appropriate check
box:
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« Migrate Mail - select this option to migrate email items.

« Migrate Calendar - select this option to migrate calendar items. The organizer of the
calendar item will be mapped to the corresponding target tenant user account. Invitees in
calendar items are retained as the source tenant user.

= | NOTE: The source tenant links to Microsoft Teams meetings in calendar items are
retained and must be migrated separately. For more information see Migrating
Meeting Links.

« Migrate Contacts - select this item to migrate contacts.
« Migrate Tasks/Notes - select this option to migrate tasks and notes.

+ Migrate Recoverable Items - select this option to migrate recoverable items. If the check
box is unchecked these items will not be transferred.

« Migrate Safe Sender and Blocked List - select this option to migrate mailboxes that are
marked as safe senders and those that are blocked.

« Reset Migration - Select this option only when you need to do a full re-migration and not a
delta sync of your source content to a target. For example,you want to delete content from
the target mailbox and want to re-migrate the source again.

11. Migration Settings

i TIP:It can take a while to migrate mail to archive mailboxes. Source mailboxes that have archives
can be easily selected using Inventoryreport on Assessment view of Mailboxes. It would be useful
to rerun the Discovery task to update the information.

a. Specify which mailbox settings you want to transfer to the target by selecting the
appropriate check box:

+ Migrate Mailbox Rules - select this option to migrate mailbox rules. See Migrating Rules for
more details.

« Migrate Mailbox Delegation - select this option to migrate delegation permissions. See
Migrating Delegate Permissions for more details.

« Enable Automapping for shared mailboxes - Auto-mapping is an Exchange &
Exchange Online feature. Once enabled, any auto-mapped mailbox will be opened
by the delegate's Outlook client in a persistent state with Full Access permissions
and cannot be closed by the user. If users want to remove the auto-mapped mailbox
from their Outlook client, administrative intervention is required to remove the Full
Access permission or clear the auto-mapping flag.

+ Migrate Folder Permissions- select this option to migrate folder permissions. See
Migrating Folder Permissions for more details.

« Migrate Auto-Reply - select this option to migrate auto-reply messages and settings.

+ Migrate Litigation Hold Settings - select this option to migrate Litigation Hold settings as
described below. This option enables Litigation Hold on the target mailbox if the Litigation
Hold is enabled on the source mailbox and it is not enabled on the target mailbox. To reduce
the growth of Recoverable Items in the target tenant during incremental migrations, select
this option during your final migration task.

Migration of Litigation Hold settings will fail if the target mailbox
doesn’t have the right license type.

On Demand Migration User Guide
Mailbox Migration



Litigation Hold Settings

» LitigationHoldDate - setting is copied as-is from the source mailbox to the
target mailbox.

« LitigationHoldDuration - setting is copied as-is from the source mailbox to the
target mailbox.

« LitigationHoldEnabled - setting is copied if the value is set to True on the source and
False on the target.

 LitigationHoldOwner - the migration service will check if the configured user in the
source tenant is mapped to a user in the target and set appropriately before migrating
the setting.

o RetentionUrl - setting is copied as-is from the source mailbox to the target mailbox.

b. Click Next.

12. Sensitivity Labels
Choose how you want to migrate sensitivity labels applied to mailbox contents. Sensitivity labels require
specific tenant permissions. They must be discovered and matched before you can use the following
options. For more details, see the topic Sensitivity Labels.

Encrypted mailbox items may be inaccessible on the target tenant if sensitivity

labels that are applied to items in the source tenant are not processed. If an item is
encrypted in the source, then with this option enabled, it is decrypted, labels are processed
and the item is reencrypted in the target.

a. Process document sensitivity labels - select this checkbox to enable sensitivity label processing
if you have already configured and matched sensitivity labels.

Remove sensitivity labels from documents migrated to the target - select this option to
clear the labels from migrated items. Labels on items in the source tenant are not changed.

Match and apply corresponding labels to documents migrated to the target - select
this option to match and apply sensitivity labels during migration. If the label in the source
item has a matching label in the target (there is a corresponding target label in the On
Demand repository), the source label is replaced by the target label. If the label in the source
item has no matching label in the target (there is no corresponding target label in the On
Demand repository), the item is not migrated.

b. Click Next.

13. Mail Flow

= | NOTE: You can skip this step and set up mail forwarding with the New Mailbox Switch Task wizard
after you complete the mail migration.

a. Enable/Disable Mail Forwarding - select this check box to control mail forwarding. This check box
is selected by default. When this check box is selected, you can choose from the following options:

Enable Mail Forwarding - enable Mail Forwarding (on by default for the initial New Mail
Migration Task) from Target to Source. On Demand Migration assumes that end-users will
not be using their new target mailboxes immediately after the first "Migrate Mail" task (cut-
over), so forwarding is set on the new target mailbox to forward any new mail that is received
in the target back to the source. This way any new mail is assured to be delivered to the
active end-user mailbox.

On Demand Migration User Guide
Mailbox Migration



« Mail forwarding direction - set the mail forwarding direction by choosing From
target to source or From source to target. From the On Demand Migration table of
mailboxes, the forwarding email is in the Source Mailbox / Target Mailbox depending
on the mail forwarding direction selected. See the Mail Flow column value (To
Source or To Target) which can be switched with the switch mailboxes functionality
(see Mail Forwarding).

« Custom domain for forwarding - specify the custom domain name for forwarding
email addresses. If the domain is omitted or does not exist, the primary SMTP
address will be used.

« Disable Mail Forwarding - choose this option to remove any populated mail forwarding
address. Use this option to remove forwarding addresses in source mailboxes before the
migration and target mailboxes after the migration. You cannot deactivate mail forwarding
using the switch mailboxes functionality described in the topic .

b. Click Next.
14. Mail Folders

a. Specify which mail folders to migrate and where they should be migrated by selection one of the
following options

» Migrate all folders - select this option to migrate all folders from the source to the tenant.
Mail will be migrated to a folders with the same name in the target tenant.

+ Migrate all folders except - select this option to exclude the selected mailbox folders (and
subfolders if any) and optionally provide an alternate folder name to migrate all other folder
contents. When you select this option the following options are also available:

» Folders to ignore: Choose from Deleted Items, Junk Email, Drafts, Conversation
History, Sent Items, and Inbox. You can also specify one or more custom folder paths
separated by a semicolon.

TIPS:

« When you specify folders in the textbox, type the fully qualified path, for
example, Accounting/Notice.

« Make sure the forward slash (/) is used in the path you specify. Example:
Accounting/Notice. The backslash (\) is not supported.

« The leading slash is supported, but not required. Both "Accounting/Notice"
and "/Accounting/Notice" paths are supported.

« Quotes are not nneeded even if the folder name contain spaces.

+ Migrate specific folders - select this option to migrate only the selected mailbox folders
(and subfolders if any) and optionally provide an alternate folder name to migrate the
specified folder contents. When you select this option the following options are also
available:

o Folders to include: Choose from Inbox, Sent ltems, Drafts, and Deleted ltems. You
can also specify one or more custom folder names separated by a semicolon.

TIPS:

+ When you specify folders in the textbox, type the fully qualified path, for
example, Accounting/Notice.
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« Make sure the forward slash (/) is used in the path you specify. Example:
Accounting/Notice. The backslash (\) is not supported.

« The leading slash is supported, but not required. Both "Accounting/Notice"
and "/Accounting/Notice" paths are supported.

« Quotes are not nneeded even if the folder name contain spaces.

+ Migrate content to a custom folder - select this option to migrate content from source
mailbox to a custom folder. To run incremental migration, a mail migration task should be
created with the same folder name. Any change in the folder name will be treated as a
migration to a new custom folder. See Limitations for custom folders for more details.

+ Custom folder name - specify the name of the custom folder where content will be
migrated. For example, all mail from the source mailbox can be migrated to the
Migrated Mailbox custom folder in the target tenant.

+ Migrate to folder - select this option to specify a custom target folder for well known source
folders such as Inbox, Deleted Items, Archive, and Sent Items. If you do not provide a
target folder name then the mail migration service will migrate the contents of the source
folder to a folder with the same name on the target.

b. Click Next.

15. Date Range
Limit the date range for content transfer. You can set any of the following options:

a. Migrate mail before to set end date for the date range
b. Migrate mail after to set start date for the date range
c. Click Next.

16. Notification
a. Select the options as described below:

+ Send notification email after the mail migration is completed - select this option to
send a notification email when the mailbox migration task completes. The notification is sent
whether or not the mailbox migration succeeds unless the Only in a case of failure option
is selected.

« Only in a case of failure - select this option to send the notification email only when one or
more mailboxes cannot be migrated. When this option is selected, a notification email will not
be sent if all the mailboxes are migrated successfully.

« Recipients - enter a semicolon-delimited list of mailboxes where the natification will be sent.
The mailbox of the current user will be entered by default and can be changed.

NOTE: Notifications are sent from no-reply@quest-on-demand.com. Recipients
must add this email address to the Safe Senders List.

To add the email address to your Safe Senders list in Microsoft Outlook, do the
following:

a. Onthe Home tab, click Junk, and then click Junk E-mail Options.

b. Onthe Safe Senders tab, click Add and add the no-reply@quest-on-
demand.com e-mail address.
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The notification that is sent will contain the following information in the email body:
+ Project id - the unique identified of the project.
o Task id - the unique identifier of the task.
« Type - the type of the task: Mail Migration.
» Created - the data and time when the task was created.
» Modified - the most recent date and time when the task was modified.
« Status - the state of the task.
» Last operation - The last recorded event in the task.
« Schedule - indicates when the task was run.

+ Mailboxes - The number of mailboxes selected for this migration categorized by migration
status (New, Stopped, In Progress, Failed, and Completed) and count.

b. Click Next.
17. Schedule

a. Choose from one of three options to schedule the task. The scheduler will be activated after you
complete the task wizard.

* Run now - task runs immediately.
* Run later - task must be started manually.

« Schedule - task will be started at a future date and time entered in the corresponding
calendar field.

b. Click Next.

18. Reporting
Select the check box Generate detailed report of migration errors to generate a migration error report
when you run the Mail MigrationTask.
You can download the report from the Reports tab of the Accounts and User Data migration workspace by
clicking the Download link in the Error Log column. If there are no migration errors, a download link is not
available. Error reports are retained for 30 days. After 30 days the download link is replaced with the label
Expired and you can no longer download the report. For more information about error reports, see Reports.

19. Summary

a. Save task settings as a template - select this option to save the settings in this wizard as a
reusable migration template.

« Template Name - specify a name for the template. If you have changed the settings of a
preselected template, specify the same template name to apply the changes to the template
when you complete the wizard. All saved templates are displayed in the Templates tab.

b. Review the task summary. You can specify a custom task name. The default name is Mail
Migration Task.

c. Click Back to change configurations if necessary or click Finish to save or start the task depending
on the schedule option selected.

+ | NOTE: Before the actual mail migration begins, a mailbox is activated by fetching a list of calendars using
Graph API and delegated type of permissions. This is necessary as per Microsoft's recommendation to set
the calendar configuration correctly before running the meeting link task.
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Examples

Example 1
Task options selected:

« Migration Options: Migrate Mail and Migrate Calendar

« Migration Settings: Migrate Folder Permissions
Result:

« Afolder for each supported content type is created in the target tenant account mailbox tree, regardless of
the content type selected.

« Mail folders, their content and permissions are migrated.

« Permissions of all folders are migrated regardless of the content type selected.

Example 2
Task options selected:

« Migration Options: Migrate Mail and Migrate Calendar
« Migration Settings: Migrate Folder Permissions

« Mail Folders: Migrate content to a custom folder> MyFolder
Result:

« A custom folder called MyFolder is created in the target tenant account mailbox.
o Afolder for each supported content type is created in MyFolder, regardless of the content type selected.
« Mail folders, their content and permissions are migrated to MyFolder.

» Calendar folders, their content and permissions are not migrated, either to MyFolder or their default
locations, because they are non-mail folders.

Reviewing the Mail Migration Task

You can track a task's progress from the Tasks tab, view the summary on the Dashboard or monitor alerts and
notifications in Events.

You can track the migration of objects from the Mailbox State column in the Mailboxes list view. The column values
during and after a task is run are as follows:

Column value Description

Migrated Migration is complete and successful.
Migrated with Issues Migration has completed with errors.
Migrating Migration of this object has started.
Migration failed Migration did not succeed.
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Column value Description

Migration stopped Migration canceled by the user.

Provisioning Mailbox is being set up in the target tenant.

Provisioning Failed Mailbox could not be set up in the target tenant.

Queued Mailbox migration task is waiting for migration service resources to be
available.

Migrating Meeting Links

When a calendar item with a link to a Microsoft Teams meeting is migrated, the link to the original Teams meeting in
the source tenant is retained. Use the Meeting Link Migration Task to update Microsoft Teams meeting links in the
target tenant.

How it works: The meeting link migration task creates a new Teams meeting with the original meeting details in the
target tenant. It sets the target user as the organizer. This new meeting invite must be accepted by all participants.
The original meeting migrated to the target is canceled. The cancellation email is automatically sent out to the
organizer and attendees.

Considerations

The attendee list is not updated to match the target domain.

A cancellation email is sent out to the organizer and attendees. Since the source attendees are not replaced
with the corresponding target ones, the cancellation email is sent out to the source tenant.

A new meeting is created if the migrating user is the organizer of that particular Teams meeting.
A meeting is not recreated if the source meeting was created in Microsoft Teams through a Teams channel.

On Demand Migration recreates present and future meetings, both one-time and recurring meetings.
Meetings that happened in the past are migrated with Calendar migration.

Recurring meetings with modified instances are reset to original settings after migration.

The subsequent runs of the Meeting Link Migration Task will skip the meetings which were
previously processed.

Properties like a flag and categories are not supported with this migration.

IMPORTANT:
Mailbox migration with the Migrate Calendar option selected, must be completed before starting this task.

To migrate meeting links:

P 0N

Log in to Quest On Demand and choose an organization if you have set up multiple organizations.
From the navigation pane, click Migrate > Projects to open the My Projects list.
Create a new project or open an existing project.

Click the Mail tile, or click Open from the Mail tile to open the Accounts and User Data dashboard.
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5. Click the Mailboxes tab. From the Mailboxes List, select the pre-migrated mailboxes in the list for which you
want to migrate the meeting links. You can use search, filtering or collections to quickly navigate through the
list of mailboxes.

6. From the Mailboxes List toolbar, click More > Meeting Link Migration. The New Meeting Link Migration
Task wizard starts. Each step is described below:

7. Start
a. Task Name - You can specify a custom task name. Default name is Meeting Link Migration Task.

b. Use the settings from an existing migration template for this task - select this option if you
have already saved a previous migration templates. if this is the first time you are migrating
mailboxes, keep this option unchecked.

» Select template - select a template that you previously created, from the dropdown list.

c. Go to Summary step - select this option to preserve the settings and go directly to the last step of
the wizard. If you do not select this option, but you have selected a template, you can step through
the wizard and edit the settings in the template.

d. Click Next.

8. Custom Email Message
Customize the cancellation message in the text box.

9. Notification

a. Send notification email once the task is completed - select this option to send a notification
email when a discovery task completes.

« Only in a case of failure - Select this option to send the email if the discovery task fails to
complete successfully.

b. Recipients - enter the email address of the recipients of this email. You can specify multiple
recipient email addresses separated by semicolon.

c. Click Next.
10. Schedule

a. Choose from one of three options to schedule the task. The scheduler will be activated after you
complete the task wizard.

* Run now - task runs immediately.
* Run later - task must be started manually.

+ Schedule - task will be started at a future date and time entered in the corresponding
calendar field.

b. Click Next.
11. Summary

a. Save task settings as a migration template - select this option to save the settings in this wizard
as a reusable migration template.

« Migration Template Name - specify a name for the template. If you have changed the
settings of a preselected template, specify the same template name to apply the changes to
the template when you complete the wizard. All saved templates are displayed in the
Templates tab.
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Review the task summary. You can specify a custom task name. Default name is Meeting Link
Migration Task.

Click Back to change configurations if necessary or click Finish to save or start the task depending
on the schedule option selected.

How to track the migration

You can track a task's progress from the Tasks tab and filter for tasks where Type = Meeting Link Migration. You

can view the summary on the Dashboard or monitor alerts and notifications in Events.

Mail Forwarding

To support the customer preferences related to mail forwarding, the following behavior is now supported for mail
migration task in case forwarding is not set using On Demand Migration (Mail Flow column is empty) and for
mailbox switch (standard and reverse scenarios) tasks:

Before After
Task Source. Target. Source. Target.
Type ForwardingSMTPAdd ForwardingSMTPAdd ForwardingSMTPAddre ForwardingSMTPAddre
ress ress ss ss
Mail Points to target * Not set/ Set to any Not set (cleared) Source.PrimarySMTPAd
migration SMTP address drgsg orone .of the
existing email addresses
(From from selected custom
target to domain for forwarding, if
source set.
option) ) . .
Points to any SMTP Not set/ Set to any Remains unchanged Source.PrimarySMTPAd
address except for SMTP address dress or one of the
target * existing email addresses
from selected custom
domain for forwarding, if
set.
Not set Not set/ Set to any Not set Source.PrimarySMTPAd
SMTP address dress or one of the
existing email addresses
from selected custom
domain for forwarding, if
set.
Mail Not set/ Set to any Points to source** Target.PrimarySMTPAd Not set (cleared)
Migration SMTP address dr§s§ orone pfthe
existing email addresses
(From from selected custom
source domain for forwarding, if
to target set
option) . . .
Not set/ Set to any Points to any SMTP Target.PrimarySMTPAd Remains unchanged
SMTP address address except for dress or one of the

source **

existing email addresses
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Before After
Task Source. Target. Source. Target.
Type ForwardingSMTPAdd  ForwardingSMTPAdd  ForwardingSMTPAddre ForwardingSMTPAddre
ress ress ss ss
from selected custom
domain for forwarding, if
set
Not set/ Set to any Not set Target.PrimarySMTPAd Not set
SMTP address dress or one of the
existing email addresses
from selected custom
domain for forwarding, if
set
Mail Not set/ Set to any Points to source™* Remains unchanged Not set (cleared)
Migratio SMTP address except
n: for target *
Remove . )
Points to target * Not set/ Set to any Not set (cleared) Remains unchanged
SMTP address except
for source **
Not set/ Set to any Not set/ Setto any Remains unchanged Remains unchanged
SMTP address except SMTP address except
for target * for source **
Switch Not set/ Set to any Points to source** Target.PrimarySMTPAd Not set (cleared)
SMTP address dress or one of the
(From existing email addresses
source from selected custom
to target domain for forwarding, if
option) set
Not set/ Set to any Points to any SMTP Target.PrimarySMTPAd Remains unchanged
SMTP address address except for dress or one of the
source ** existing email addresses
from selected custom
domain for forwarding, if
set
Not set/ Set to any Not set Target.PrimarySMTPAd Not set
SMTP address dress or one of the
existing email addresses
from selected custom
domain for forwarding, if
set
Unswitch Points to target * Not set/ Set to any Not set (cleared) Source.PrimarySMTPAd
SMTP address dress or one of the
(From existing email addresses
target to from selected custom
source domain for forwarding, if
option) set
Points to any SMTP Not set/ Set to any Remains unchanged Source.PrimarySMTPAd
address except for SMTP address dress or one of the

target*

existing email addresses
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Before After

Task Source. Target. Source. Target.
Type ForwardingSMTPAdd  ForwardingSMTPAdd  ForwardingSMTPAddre ForwardingSMTPAddre
ress ress ss ss

from selected custom
domain for forwarding, if

set
Not set Not set/ Setto any Not set Source.PrimarySMTPAd
SMTP address dress or one of the

existing email addresses
from selected custom
domain for forwarding, if
set

* Target.PrimarySMTPAddress or any of Target.EmailAddresses
** Source.PrimarySMTPAddress or any of Source.EmailAddresses

Switching Mailboxes

The mailbox switching task allows customers to set up mail forwarding as the final step in the migration and mark
the mailbox state as Switched. This task may not be required if forwarding was set during the mail migration task.

To start a Mailbox Switch Task

1. Loginto Quest On Demand and choose an organization if you have set up multiple organizations.
2. From the navigation pane, click Migrate > Projects to open the My Projects list.

3. Create a new Office 365 Services project or open an existing project.

4. Click the Mail tile, or click Open from the Mail tile to open the Accounts and User Data dashboard.

5. Click the Mailboxes tab. The Mailboxes List opens. Select the mailbox accounts in the list that you want to

switch. You can use search, filtering or collections to quickly navigate through the list of mailboxes. You can
also select the check box in the table header to select all the mailbox accounts.

6. From the actions, click Switch Mailboxes. The New Mailbox Switch Task wizard starts. Each step is
described below:

7. Start
a. Task Name - You can specify a custom task name. The default name is Mailbox Switch Task.

b. Use the settings from an existing migration template for this task - select this option if you
have already saved a previous migration templates. if this is the first time you are migrating
mailboxes, keep this option unchecked.

« Select template - select a template that you previously created, from the dropdown list.

c. Go to Summary step - select this option to preserve the settings and go directly to the last step of
the wizard. If you do not select this option, but you have selected a template, you can step through
the wizard and edit the settings in the template.

d. Click Next.
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8. Mail Flow
a. Select options as described below:

« Mail forwarding direction - Set the mail forwarding direction by choosing From target to
source or From source to target. From the On Demand Migration table of mailboxes, the
forwarding email is in the Source Mailbox / Target Mailbox depending on the mail forwarding
direction selected. See the Mail Flow column value (To Source or To Target) which can also
be switched as part of a migration task (see Migrating Mailboxes).

e Custom domain for forwarding - Specify the custom domain name for forwarding
email addresses. If the domain is omitted or does not exist, the primary SMTP address
will be used.

« Mark Mailbox State column as Switched — select this check box to change the Mailbox
State from its current value to “Switched”.

b. Click Next.
9. Notification
a. Selectoptions as described below:

« Send notification to original mailboxes — select this check box to configure a notification
to send to the user’s original mailboxes

« Send notification to new mailboxes — select this check box to configure a notification to
send to the user’s new mailboxes

The notification that is sent can be customized for the following attributes:

+ Sender’s email address — the value that should be displayed as the Sender’s
email address

« Send from — the value that should be displayed as the Sender’s Display Name
« Subject — the text that should be displayed as the message Subject
+ Message —the text that should be displayed in the message body
b. Click Next.
10. Schedule

a. Choose from one of three options to schedule the task. The scheduler will be activated after you
complete the task wizard.

a. Run now - task runs immediately.
b. Run later - task must be started manually.
c. Schedule - task will be started at a future date and time. Enter the start time for the task.
b. Click Next.
11. Summary

a. Save task settings as a migration template - select this option to save the settings in this wizard
as a reusable migration template.

« Migration Template Name - specify a name for the template. If you have changed the
settings of a preselected template, specify the same template name to apply the changes to
the template when you complete the wizard. All saved templates are displayed in the
Templates tab.
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b. Review the task summary. You can specify a custom task name. The default name is Mailbox
Switch Task.

12. Click Back to change configurations if necessary or click Finish to save or start the task depending on the
schedule option selected.

Switching Applications in a Domain
Move Scenario

When performing a tenant-to-tenant migration that includes a domain move, On Demand Migration needs to refresh
the source and target usernames and email addresses after the domain move to ensure that the Desktop Update
Agent works as expected. To use the Desktop Update Agent after moving a domain from one tenant to another,
perform the following procedure:

1. Complete the Domain Move.
Confirm that the updated usernames and email addresses are shown in the source and target tenants.
Re-run the New Account Discovery Task wizard to refresh source usernames and email addresses.

2
3.
4. Re-run the New Account Matching Task wizard to refresh target usernames and email addresses.
5. Run the New Switch Applications Task wizard. Select the options to Skip mailbox state validation and
Skip OneDrive state validation if the account migration states were reset to Matched. For more

information, see Configuring the Switch Applications Task in the Desktop Update Agent User Guide.

i NOTE: If you run the New Switch Applications Task before the domain move is complete, you will not need
to re-run the task since the Desktop Update Agent will check the source and target user information at the
time the end-user runs the tool.
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OneDrive Migration

When the user accounts are matched or migrated, you can transfer the content of their OneDrive for Business
stores to the target tenant.

What We Migrate

Migration limitations indicated below may not be an exhaustive list of limitations as some may appear in unique
customer migration scenarios, or arise due to platform or legacy support restrictions. In some cases, a solution to a
limitation may already be on the product roadmap.

Quest On Demand migrates the following OneDrive components:

Objects and content types

Object Support Notes

Document Document size can be up to 100 GB.
Authorship properties: v
» Created Date
e Created by
e Last Modified Date
« Last Modified By

Document properties v
Document permissions v
Versions and Version History v
Folder

Properties v
Folder permissions v

Permissions

Direct Sharing Permissions v Permissions for:
« Internal Users
e Groups

o Guest (External) Users
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Object Support Notes

Custom level permissions v
Link Sharing Permissions v Permissions for:
e Internal Users
o Groups
o Guest (External) Users

M365 security and compliance features

Legal Hold X
Retention Labels X
Microsoft Information Protection policies and X
labels

M365 Compliance Customer Lockbox X

Power Platform features

Power Apps X

Power Pages X

Power Automate (Flow) X

Power Virtual Agents X

Others

Microsoft public preview features X In general, Microsoft public preview features are
not supported in production migrations. These
features may also take additional time to fully
develop and test for release to production.

Personal SharePoint Lists X

SharePoint subsites, lists and libraries added X

to a user's OneDrive

Shortcut X

Whiteboard v The folder that contains the Whiteboard files is

migrated. If you plan to migrated Teams, you
must pre-migrate the Whiteboard files created by
the Whiteboard creator.

Limitations

Only the latest version of frequently updated files such as outlook PST files, database files and log files will
be migrated.

Considerations

Before starting the OneDrive migration consider the following:
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When active or expired Sharing Links are migrated, existing permissions are converted to direct permissions
in the target tenant.

Migrating Sharing Link permissions for external users requires the external user be an Azure Active
Directory guest.

Migrating Authors and Editors will only map to the Primary SMTP Address. Multiple SMTP addresses are
not currently supported.

Migrating a OneDrive user Recycle Bin is not supported.
Document with URLs longer than 400 characters cannot be migrated to a target tenant.

Very large OneDrives with hundreds of thousands of files or files that are 500 GB or larger, should be divided
into two or more OneDrives to improve migration throughput.

Prerequisites

« You must match or migrate user accounts in the migration project to ensure that membership, content

ownership, and permissions are processed correctly.

The target tenant should has the fully configured OneDrive feature with a valid license plan. Licenses can be
automatically assigned to the target users during the migration.

Tenant administrator consents are granted for source and target tenants .The following consents should be
granted for OneDrive migration feature:

+ Migration - Basic
« Migration - SharePoint

If tenant administrator consents are not granted or have expired, account discovery will be deactivated and
you will be unable to continue.

Tenant administrator credentials must also be provided for both tenants in the Configure
Connections dialog.

Prerequisites

You must match all accounts in the project to ensure that membership and content ownership are
processed correctly.

The following admin consents should be granted for SharePoint migration:
« Migration - Basic
« Migration - OneDrive - Minimal (for source)

o Migration - OneDrive - Full (for source and target)

Dashboard

The On Demand Migration Dashboard tab in the Accounts and User Data migration workspace provides summary
information about migration tasks and events. The OneDrive users tile indicates the number of OneDrive users and
the status of their migration.
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528 OneDrive users 1 task No errors

Discovery Task © Task has been started (Started by user)

| by
M New 528 (100%)
M stopped 0 (0%)
In Progress 0 (0%)
M Failed 0 (0%)
| ] Completed 0 (0%)
SHOW ALL SHOW ALL SHOW ALL

OneDrive List View

The List View displays the summary of the OneDrive information from the source and target tenants. Initially, the List
View displays the list of accounts and other columns are blank. As you run the discovery, collect statistics and
migration tasks, the list view will display more information about the accounts and the state of the OneDrive
migrations.

To open the List View, open the Accounts and User Data migration workspace. Then select the OneDrive tab and
then select List View if not already selected.

The List View has several predefined filters to help you search for accounts based on OneDrive account
information:

« Last Run Status - returns a list of OneDrive accounts based on the status of the latest task. See the Last
Run Status column description below for filter values.

« Migration State- returns a list of OneDrive accounts based on the migration state of the OneDrive. See the
Migration State column description below for filter values.

« Account Matching - returns the list of OneDrive accounts that are either Matched or Unmatched.

« Collect Statistics Status - returns a list of OneDrive accounts based on the state of the Collect Statistics
task for the OneDrive account. See the Collect Statistics column description below for filter values.

ONEDRIVE ESKTOP AGENTS  REPORTING

* MIGRATEONEDRIVE () COLLECTSTATISTICS  [&f ONEDRIVE REPORTING ~ MORE {3 EDIT COLUMNS

T te T Ppriority

Target items. Last Run Status

e 0 0 0 0 0 0 0 T

@ 0 0 0 0 0 0 0 0 0 0 @ 3

© 0 0 © 6 0 0 ©0 © © © 0 © ¢
e 0 0 0 0 0 0 0 0 0 0 0O
¢ 0 © 0 © 0 0 0 © © ©0 0 ©

The columns in the List View are as described below. Use the Edit Columns List View Actions Menu to show or
hide columns in the list:
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1. Name - name of the account in the source tenant.
2. Migration State - indicates various stages in the migration process.
o <blank> - no task has been run yet. Use Unknown in the filter.
« Discovery Failed - failed to retrieve source site or statistics data, or other errors occurred.
« Discovered - retrieved statistics from source.
« Not Migratable - source has no license or OneDrive not provisioned.
+ Provisioning - started provisioning OnDrive in the target tenant.
« Provisioning Failed - OneDrive provisioning failed due to license or credential errors.

« Provision Pending - no provisioning errors, but OneDrive not provisioned after 1 hour. Customers
must rerun the migration task within 24 hours or manually provision the target

« Provisioned - OneDrive provisioned and verified in target tenant.

* Queued - task is waiting for migration service resources to be available. For more information, see
How Queuing Works.

« Migrating - source and target tenants analyzed and migration started.

« Migration Failed - critical error occurred nothing has been migrated. See task event details for more
information.

+ Migrated with Issues - some content is migrated but errors or warnings were encountered during
migration. Use a reporting task to look for missing files or other errors.

« Partially Migrated - migration is successful, but source item count is larger than target item count
after migration. See task event details for more information.

+ Migrated - OneDrive migrated successfully to the target tenant.

3. Collect Statistics - the state of the Collect Statistics task for the OneDrive account. An empty value
indicates that the account has not yet been assessed. Accounts that were an assessment was attempted
will display a status as described below. You can filter the table by selecting one of the following values in
the Collect Statistics Status filter. Click Clear All to reset the filter if necessary.

« Completed - OneDrive is provisioned and the statistics were collected successfully.

+ Not Licensed/Provisioned - OneDrive is neither licensed nor provisioned and the statistics could
not be collected.

« Unavailable - the named account is not available and the statistics could not be collected.

+ Not Started - collection of statistics has yet to be attempted for the named account.
4. Provisioning - when OneDrive is provisioned for the user on the target, the value is set to Completed.
5. Items Migrated (%) - percentage of files that have been migrated to the target

6. Source Items - number of items in the OneDrive for the source account. If there is no value the account has
not yet been assessed.

7. Source Size- total size of all the files in OneDrive for the source account. If there is no value the account has
not yet been assessed.

8. Source Last Modified - indicates the date and time of the last modification of the source OneDrive. Every
time the statistics or migration task is run this value will be updated according to the source date.
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10.
1.

12.
13.
14.
15.

Target items - number of items in the OneDrive for the target account. If there is no value, you did not
select the option in the New OneDrive Collect Statistics Task wizard to collect item count statistics from the
target account, the account is not available, OneDrive has not been provisioned or the account has not yet
been assessed.

Last Successful Run - date and time of the last successful migration. This column is hidden by default.

Last Run Status - indicates the status of the latest task. Valid values are New, In Progress, Completed,
Failed, or Stopped..

Source UPN - User Principal Name (UPN) of the source account.
Source Root Url - relative path of the source OneDrive root URL.
Target UPN - User Principal Name (UPN) of the target account.

Collections - indicates the most recent collection where the corresponding account is added and the
number of additional collections that also contain this object.

OneDrive Details

When you select an account from the List View, the OneDrive Detail pane opens. The information in the pane is
described below:

Source Email - email address of the selected account in the source tenant.

Target Email - email address of the selected account in the target tenant.

Provisioning - when OneDrive is provisioned for the user on the target, the value is set to Completed.
Migration Progress (%) - percentage of files that have been migrated to the target.

Source Items - number of items in the OneDrive for the source account. If there is no value the account has
not yet been assessed.

Target items - number of items in the OneDrive for the target account. If there is no value, you did not
select the option in the New OneDrive Collect Statistics Task wizard to collect item count statistics from the
target account, the account is not available, OneDrive has not been provisioned or the account has not yet
been assessed.

Last Run Status - indicates the status of the latest task. Valid values are New, In Progress, Completed,
Failed, or Stopped..

Last Successful Run - date and time of the last successful migration. This column is hidden by default.
Events - count of the events that occurred during OneDrive processing through one or more tasks.
Collections - list of collections that contain the corresponding account.

Tasks - list of tasks invoked for the selected OneDrive.

Managing OneDrive Accounts with
Collections

See the topic Managing Accounts with Collections. The actions and steps described in the topic are the same for
managing Mailboxes accounts with collections.
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Collecting Statistics

The Collect OneDrive Statistics Task conducts an assessment of OneDrive related to all accounts in the source
tenant and matching accounts in the target tenant: The assessment report provides the following information
among others:

« The number of items in the OneDrive for each account and the total number of items across all selected
accounts where the assessment was possible.

¢ The total size of all the items in the OneDrive for each account and the total size of all items across all
selected accounts where the assessment was possible.

Each Collect OneDrive Statistics Task generates events. Events are milestones that a task achieves as it runs.
For example, when a Collect OneDrive Statistics Task starts, an event is logged and it appears in the events list.
When the number of accounts that are selected for assessment is large, the Collect OneDrive Statistics Task
divides the total number of accounts into manageable sets. Each set is called a batch. When a batch of accounts is
assessed, another event occurs.

NOTE: Before you proceed, verify that the source tenant accounts have been discovered. For more
information see Discovering Accounts

In this topic:

o Starting a Collect OneDrive Statistics Task
« Reviewing the Collect OneDrive Statistics Task
» Reviewing the statistics collected

» Reviewing the events for the Collect OneDrive Statistics Task

Starting a Collect OneDrive Statistics Task

1. Login to Quest On Demand and choose an organization if you have multiple organizations.
2. From the navigation pane, click Migrate > Projects to open the My Projects list.

3. Create a new project or open an existing project.
4

Click the OneDrive tile, or click Open from the OneDrive tile to open the Accounts and User
Data dashboard.

5. Select the OneDrive tab and then select List View if not already selected. Then select any account in the
list to activate the menu options.

6. Click Collect Statisticsfrom the Actions ribbon. The New Collect OneDrive Statistics Task wizard starts.
Each step is described below:

7. Description

i NOTE:Statistics are collected from the source tenant by default.

a. Include collection of item count from target OneDrive accounts - select this option to include
item count statistics from the target account and generate the Comparison Report.
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New OneDrive Collect Statistics Task

Important: Task duration depends on the number of accounts selected. Approximate duration is 2 minutes
for each 1000 accounts.

b. Click Next
8. Schedule

a. Choose from one of three options to schedule the task. The scheduler will be activated only after you
complete the task wizard.

* Run now - task runs immediately.
* Run later - task must be started manually.

« Schedule - task will be started at a future date and time entered in the corresponding
calendar field.

b. Click Next.
9. Summary
a. Verify the task specifications as described below:

i. Name - name of the task. You can specify a custom name. The default name is Collect
OneDrive Statistics Task.

ii. Source tenant - name of the tenant where the statistics will be collected.
iii. Target tenant - name of the target tenant in this project.

iv. Collect target statistics - indicates whether you have opted to include item count statistics
from the target account.

v. Scheduled start - date and time when the task will start. Now indicates that the task will start
immediately.

b. Click Back to revise or review a previous step or click Finish to complete the task wizard and start
the task as scheduled.
Reviewing the Collect OneDrive Statistics Task

1. Open the Tasks tab.

2. Select the Collect OneDrive Statistics Task that you want to review.
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3. Inthe task details pane that opens, the information presented is as described below:
a. Type - Type of the task. The type is OneDrive Assessment.
b. Created - Date and time when the task was created.
c. Modified - Date and time when the task was last updated.
d. State - State of the task.
e. Last Operation - The action that was most recently performed in this task.

f. Schedule - Date and time when the task started. Now indicates that the task started immediately
after the task was created.

g. Accounts (number) - numberindicates the count of accounts in the source tenant that are
inspected. The values indicate the assessment category of the accounts. The categories are:

a. Completed - Number of accounts where OneDrive is provisioned and the total size and item
count was successfully assessed.

b. Stopped - Number of accounts where OneDrive could not be assessed because it is neither
licensed nor provisioned.

h. Events (number) - The number of events that the task encountered.

TASKS

%) OneDrive Collect Statistics Task
V)

Reviewing the statistics collected

1. Open the Tasks tab.
2. Select the Collect OneDrive Statistics Task that you want to review.

3. From the task details pane, click Download Premigration Report. If comparison reports were generated,
click Download comparison report.

4. Download and save the ZIP file to a suitable folder, and extract the report.

Reviewing the events for the task

1. Open the Tasks tab.

2. Select a task named Collect OneDrive Statistics Task that you want to review.
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3. Inthe task details pane that opens, click Events (number). The Events tab opens with a filtered list of events
for the selected task.

4. Select an event that you want to review. In the task details pane that opens, the information presented is as
described below:

a. Object - name of the account if applicable.
b. Task - name of the task.

Time - date and time when the event occurred.

134

d. Category - type of task. the value is OneDrive Assessment.

e. Summary - a descriptive statement about the event. Notice that the most recent event provides a
summary of the assessment across all accounts that could be assessed. The assessment details
contain the Total items count and Total file size from the source, and the Total target items
count from the target tenant if data is available.

Migration > Kitty Mart = Pet Corp > Accounts and User Data = Select Collection -

DASHBOARD ACCOUNTS MAILBOXES ONEDRIVE EVENTS TASKS

7 days 5
Task name : OneDrive Collect Statisti... x JIARTLFIN 30 days o

Custom range 12aM 6AM 12PM 6PM 12AM
O Time v Description X
0 [i ] Today at 10:12 AM Completed statistics assessment of 32 accounts. Check result it o Completed statistics assessment of 32
accounts. Check result in details.
O [i ] Today at 10:12 AM Finished assessment for batch of 3 accounts. Check result in de
O [i ] Today at 10:12 AM Finished assessment for batch of 6 accounts. Check result in dé Object
O @  Todaystin:12aM Finished assessment for batch of 8 accounts. Check resultinde 195K OneDrive Collect Statistics Task
ime Wednesday, April 14, 2021 10:12 AM
O [ ] Today at 10:12 AM Finished assessment for batch of 8 accounts. Check result in dé
OneDrive Assessment
O [i ) Today at 10:12 AM Finished assessment for batch of 7 accounts. Check result in de Completed statistics assessment of 32 accounts:
P ) Completed: 24
ay at 10:11 AM rting Statistics asses: f32 a 2 X .
O Today at 10:11 AN Starting statistics assessment of 32 accounts. Not Provisioned/Licensed: &
O ] Today at 10:11 AM Task has been started (Started by user)

Assessment result for Completed accounts:
Total source items count : 418
» Total source files size : 563.8MB
Total target items count : 0

¥ items per page 1-Bof 8items

]

Migrating OneDrive

You can migrate OneDrive for discovered and matched accounts with large selection of migration options. These
options give you control over the scope of files migrated, permissions, licensing and version management

In this topic:
« Recommendations

o Starting a OneDrive Migration Task
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« Tracking the progress of the migration task

* Viewing the report

Recommendations

The OnDemand migration service for OneDrive attempts to provision OneDrive for accounts being migrated if
the OneDrive has not been provisioned. You can manually provision the OneDrive before a migration as
described below:

1.

2.

Provision OneDrive for accounts in the target tenant that don't have a OneDrive provisioned.

« Forasmall number of target users, you can manually provision the OneDrive from the Office 365
admin console of the target tenant.

« For alarge number of target users, run a PowerShell script to provision the OneDrive. For more
details, see https://docs.microsoft.com/en-us/onedrive/pre-provision-accounts

OneDrive must be provisioned at least 24 hours before starting a migration.

Starting a OneDrive Migration Task

1.

2
3.
4

7.

8.

Log in to Quest On Demand and choose an organization if you have multiple organizations.
From the navigation pane, click Migrate > Projects to open the My Projects list.
Create a new project or open an existing project.

Click the OneDrive tile, or click Open from the OneDrive tile to open the Accounts and User
Data dashboard.

Open the OneDirive tab and verify that the List View has displays the list of user Accounts. See Discovering
Accountsif the list is empty.

Select one or more accounts for which you migrate the OneDrive contents. This enables the Migrate
OneDrive menu option.

i NOTE: To migrate OneDrive for user accounts in a collection

a. Select the collection from the dropdown menu in the top right corner labeled Select
Collection.

b. Select the accounts to migrate from the collection. To check all accounts, select the check
box in the list header.

c. Proceed to the next step.

Click Migrate OneDrive to open the New OneDrive Migration Task wizard and follow the steps
described below.

Start

a. Use the settings from an existing migration template for this task - select this option if you
have already saved a previous migration templates. if this is the first time you are migrating
mailboxes, keep this option unchecked.

« Select template - select a template that you previously created, from the dropdown list.

b. Go to Summary step - select this option to preserve the settings and go directly to the last step of
the wizard. If you do not select this option, but you have selected a template, you can step through
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the wizard and edit the settings in the template.
c. Click Next.
Migration Options

New OneDrive Migration Task

Start Specify the file migration action:

Migration Options

Version Options

e a copy if the target file is newer

target as a copy will be renamed. Eg. Sample.txt will be renamed to

Sample_migra

Specify an alternative migration location:

Relative folder path

a. Choose a migration action

« Overwrite target files - Select this option to overwrite the file in the target tenant if it was
previously migrated.

« Skip if the target file is the same version or newer - This is the default selection. When
this option is selected, the migration service will not migrate a file if the file already exists on
the target tenant and has the same or newer version than the file in the source tenant.
Select this option to speed up the migration process especially if you are starting multiple
migration tasks.

« Overwrite if the target file is older or make a copy if the target file is newer - Select
this option to overwrite the file in the target tenant if it was previously migrated and the file in
the target is an older version, or create a copy of the source file if it was previously migrated
and the file in the target is a newer version. When a copy is created in the target it will be
renamed. For example, Sample. txt will be renamed to Sample migration copy.txt.
If the file versions in the source and target are the same, it is skipped.

NOTE: Do not rename a previously migrated file or folder before the migration
completes. If you rename a previously migrated file or folder before the migration
completes, it may be unexpectedly overwritten even though you select the second or
third option. New files or folders are not impacted. The migration service compares
both file versions and modified date to determine older or newer files.

b. [Optional] Files are migrated to the root folder. You can specify an alternate target migration folder

« Relative folder path - specify the relative path to a folder where the OneDrive contents will
be migrated.

c. Click Next.
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10. Version Options

New OneDrive Migration Task

Start
Migration Options
Wersion Options

Attribute Options

Choose how many versions to migrate

Lartest
. More

versions. Requires significantly more time to migrate

Choose the maximum number of file versions to migrate
Number of versions 2 v

Choose which versions to migrate

Note: The Microsoft 365 AutoSave feature saves multiple versions in each editing session.

test version and preceding versions

rsion and daily latest from preceding days

Choose a file size limit

If the |atest version exceeds the file size limit, it will be migrated but previous versions will be ignared

a. Specify the scope of file migration

Each OneDrive file has its own version history and each change to a file is saved with a new version.
Select from the following migration options to determine how file versions should be migrated:

= | NOTE: Only the latest version of frequently updated files such as outlook PST files, database
files and log files will be migrated

o Latest version only - This is the default selection. The most recent version of the file will be
migrated. All other versions will be ignored.

+ More versions - Additional versions of a file will be migrated based on the options described
below. Large version sets take a significantly long time to migrate.

Number of versions - the maximum number of version to migrate. The available
choices are: 2, 5, 10, 30, 60, 90 and 365. When you specify the number of versions,
additional options can be selected.

Latest version and preceding versions - The version count includes the latest
version and the preceding versions in chronological order restricted to the Size Limit
of the latest version. For example, if you choose to migrate 5 versions, then the most
recent version and 4 preceding versions will be migrated as long as the most recent
version does not exceed the selected size limit specified.

Latest version and daily latest from preceding days - The version count includes
the latest version and the latest version from each preceding day restricted to the
Size Limit of the latest version. For example, if there are many versions of a file and
you choose to migrate 5 versions, then the most recent version and the latest version
from each of the 4 preceding days will be migrated as long as the most recent version
does not exceed the selected size limit specified.

Size limit - This setting is available if the Latest version and preceding versions
or the Latest version and daily latest from preceding days option is selected. By
default, the size limit is 80 MB. You can configure the size limitation by selecting from
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one of the possible values in the dropdown list. If the size of the latest file version
exceeds the selected size limit, the latest version will be migrated and previous
versions will be ignored. If the size of the latest file version does not exceed the
selected size limit, then the file and its versions will be migrated based on your
selection between Latest version and preceding versions or Latest version and
daily latest from preceding days.

« All Versions - The latest version of the file will be migrated, and all previous versions of the
file will be migrated if the latest version does not exceed a specified size limit. This option
requires significantly more time to migrate all the versions.

« Size limit - This setting is available if the All Versions option is selected. By default,
the size limit is 80 MB. You can configure the size limitation by selecting from one of
the possible values in the dropdown list. If the size of the latest file version exceeds
the selected size limit, the latest version will be migrated and previous versions will
be ignored. If the size of the latest file version does not exceed the selected size limit,
then the file and its versions will be migrated.

b. Click Next.

11. Attribute Options
This step determines how file and folder attributes are migrated and managed by the migration service.
x

New OneDrive Migration Task

Start Select which account will be displayed in Created by and Modified by properties of migrated content

Migration Options
Version Options & Fargst aceaun:
Attribute Options

Select how the sharing permissions will be transferred to the target users:
Sensitivity labels

Select whether to migrate permissions with the Auto re-run task to reduce the task load:

Migrate permissions with the Auto re-run task

Select whether to convert source Sharing Links permissions to direct permissions for matched target accounts and
groups:

Convert Sharing Links permissions to direct permissions

a. Accountdisplay: Select which account will be displayed in the Created by and Modified by
properties of migrated content:

« System Account - This is the default selection. The Created by and Modified by properties
of the migrated file or folder is displayed as System Account.

« Matching target account - The Created by and Modified by properties of the migrated file
or folder is displayed as the target account that was matched with the source account. If the
target account cannot be found, the migration service records a warning event and the
properties of the migrated file or folder is displayed as System Account.

b. Permission migration: Select how the sharing permissions will be transferred to the target users:
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« Do not migrate permissions - This is the default selection. Permissions associated with the
file being migrated will be ignored.

« Update permissions for migrated content - The permissions of files that are migrated will
be updated. Some files may be skipped if you selected the Skip if the target file is the
same version or newer in the previous step. Sharing Links are not migrated unless
Convert Sharing Links permissions to direct permissions is selected.

« Update permissions for all content - All file or folder permissions in the target tenant will
be updated whether or not they were migrated if the corresponding file or folder is present in
the source tenant. Sharing Links are not migrated unless Convert Sharing Links
permissions to direct permissions is selected.

c. Auto rerun: Select whether to migrate permissions with the Auto rerun task to reduce the task load

« Migrate permissions with the Auto rerun task - the permissions will be migrated with the
Auto rerun task after the migration completes.

d. Permission conversion

« Convert Sharing Links permissions to direct permissions - migration is slower with this
option select. Select this option to convert Sharing Links permissions of files or folders in the
source tenant to direct permissions in the target tenant. Only shared links that were activated
by the users or group members (the user or group member clicked on the link to access the
file or folder) in the source tenant will be migrated and converted to direct permissions. Users
or group members who did not activate a shared link in the source tenant will not get the
direct permissions in the target tenant and must re-request permissions from the owner when
they access the file or folder in the target tenant.
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NOTE:

a.

e. Click Next

Users can access their shared content through the Shared With Me view in OneDrive.
Some restrictions apply.

Some sharing permissions are not converted if the user has shared the file or folder
with more than 30 users. Only 30 users will receive direct permissions from the
Sharing Links, while others will not be processed due to a Microsoft limitation.

If a Sharing Link permission is removed on the source file or folder after it is migrated,
the links to this file or folder are still visible in the Shared with me and Shared by me
views in OneDrive, but the file or folder cannot be accessed.

Group permissions are not displayed in the Shared with me view because Microsoft
currently does not support this functionality.

For shared folders, only the top level folder is displayed in the folder tree.

For files and folders that do not exist in target tenant before migration the source
permission will always be used.

For files and folders that exist in the target tenant before a migration, the following
example describes how file sharing permissions will be managed. The rules are the
same for internal and external users as permission holders, or groups (Microsoft 365
group or security group) as permission holders.

For files

If Overwrite target files for selected migration is selected, the source file sharing
permission will be used.

If Skip if the target file is the same version or newer is selected, the target file
sharing permission will be used.

For folders

If either Overwrite target files for selected migration or Skip if the target file is
the same version or newer option is selected, the target sharing permission will be
used as a base. Any addition of permissions in the source will be added onto the
target.
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12. Sensitivity Labels

New OneDrive Migration Task

¥ Process document sensitivity labels

Step5 0112 - | Cance

Choose how you want to migrate sensitivity labels applied to OneDrive files. Sensitivity labels require
specific tenant permissions. They must be discovered and matched before you can use the following
options. For more details, see the topic Sensitivity Labels.

a. Process document sensitivity labels - select this checkbox to enable sensitivity label processing
if you have already configured and matched sensitivity labels.

Encrypted documents may be inaccessible on the target tenant if
sensitivity labels that are applied to documents in the source tenant are not
processed. If a document is encrypted in the source, then it is decrypted, labels are
processed and the document is reencrypted in the target.

+« Remove sensitivity labels from documents migrated to the target - select this option
to clear the labels from migrated documents. Labels on documents in the source tenant are
not changed.

« Match and apply corresponding labels to documents migrated to the target - select
this option to match and apply sensitivity labels during migration. If the label in the source
document has a matching label in the target (there is a corresponding target label in the On
Demand repository), the source label is replaced by the target label. If the label in the source
document has no matching label in the target (there is no corresponding target label in the
On Demand repository), the document is not migrated.

b. Click Next.
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13. Licensing Plan

New OneDrive Migration Task

Start Pick the appropriate OneDrive for Business licensing plan. The following plans are available on the target tenant:
Migration Options
Version Options
Attribute Options
Sensitivity labels

I Licensing Plan

Filter Items

a. Set license at the target - select this check box to assign a selected license to migrated mailbox
accounts in the target tenant. Clear the check box to skip license assignments for migrated
mailbox accounts.

b. Select the licensing plan - this dropdown list appears if the Set license at target check box is
checked. Select the licensing plan from the dropdown list that you want to assign to migrated
mailboxes.

c. Specify how the selected licensing plan will be assigned to the target accounts:

« Assign the plan to accounts without Exchange Online option. Licensed users will
retain the existing plans - Retain the existing licenses and assign the selected plan only to
unlicensed accounts (default). Licensed users will retain the existing plans.

« Assign the plan to all accounts. Licensed users will be switched to the selected plan
- Replace all license assignments with the licenses from the selected plan. Licensed users
will be switched to the selected plan.

i NOTE:
« OnebDirive for Business that have not been licensed on the source tenant will retain the
unlicensed status in the target tenant.
« Selected licensing option is only applicable to OneDrive migration. It does not affect
the licensing plans picked for Mail Migration.
d. Click Next.
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14. Filter ltems

New OneDrive Migration Task

Start

Migration Options
Version Options
Attribute Options
Sensitivity labels
Licensing Plan
Filter ltems

Natification

All lterns
All ltems that were added or modified since the last successful migration
. Items to exclude

Iterns to include

Items are excluded If any of the following selected conditions are fulfilled:

Exclude specific folders (semicolon
separated full paths)

Exclude specific file types (semicolon
separated list)

Exclude files created hd

Exclude files modified hd

Exclude files bigger than (MB)

a. Setupfilters as described below:

All items - select this option to ignore filters. This is the default option and all OneDrive
Content for the selected account will be migrated.

All items that were added or modified since the last successful migration - select this
option to migrate items that were added or modified in the source since the last successful
migration. The migration service will check the Last Successful Run attribute and migrate
every item added or modified in the source. If the OneDrive has not been successfully
migrated before, all items will be migrated.

Items to exclude - select this filter option to exclude files and folders from the migration.
Then specify the filter criteria. ltems are excluded if any of the following criteria are fulfilled:

« Exclude specific folders- provide a semicolon-separated list of relative paths to
folders that you want to skip. You can use slash or backslash. If it is convenient for
you, use spaces after semicolons, e.g., filteredfolder; somefolder/subfolder

« Exclude specific file types - provide a semicolon-separated list of file extensions.
The values are not case sensitive. You can use spaces and dots, e.g., .exe; dll;
bat; doc; pdf

o Exclude files created

« select Before from the dropdown. Then click in the date field that appears to
open the date picker and select a date. Files created before this date will not
be migrated.

» select After from the dropdown and then click in the date field that appears
to open the date picker and select a date. Files created after this date will
not be migrated.
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« Exclude files modified

« select Before from the dropdown. Then click in the date field that appears to
open the date picker and select a date. Files modified before this date will not
be migrated.

« select After from the dropdown. Then click in the date field that appears to
open the date picker and select a date. Files modified after this date will not
be migrated.

« Exclude files bigger than (MB) - enter a numeric value. The maximum value is
1000 MB. Only integer values are supported.

« Items to include - select this filter option to include files and folders from the migration. Then
specify at least one filter criteria. ltems are included if any of the following criteria are fulfilled:

« Include specific folders- provide a semicolon-separated list of relative paths to
folders that you want to include. You can use slash or backslash. If it is convenient for
you, use spaces after semicolons, e.g., filteredfolder; somefolder/subfolder

» Include specific file types - provide a semicolon-separated list of file extensions.
The values are not case sensitive. You can use spaces and dots, e.g., .exe; dll; BAT

¢ Include files created

« select Before from the dropdown. Then click in the date field that appears
to open the date picker and select a date. Files created before this date will
be migrated.

o select After from the dropdown. Then click in the date field that appears
to open the date picker and select a date. Files created after this date will
be migrated.

¢ Include files modified

« select Before from the dropdown. Then click in the date field that appears
to open the date picker and select a date. Files modified before this date
will be migrated.

« select After from the dropdown. Then click in the date field that appears
to open the date picker and select a date. Files modified after this date will
be migrated.

« Include files bigger than (MB) - enter a numeric value. The maximum value is 1000
MB. Only integer values are supported.

b. Click Next.
15. Notification

a. Send notification email once the task is completed - select this option to send a notification
email when a discovery task completes.

« Only in a case of failure - Select this option to send the email if the discovery task fails to
complete successfully.

b. Recipients - enter the email address of the recipients of this email. You can specify multiple
recipient email addresses separated by semicolon.

c. Click Next.
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16. Schedule

a. Choose from one of three options to schedule the task. The scheduler will be activated only after you
complete the task wizard.

* Run now - task runs immediately.
* Run later - task must be started manually.

« Schedule - task will be started at a future date and time entered in the corresponding
calendar field.

« Priority - select a priority from the dropdown for the objects scheduled for migration with this
task . Values are: Highest, High, Medium, Low and Lowest. The default priority is Medium.
If the system is busy, the objects are queued (Migration state = Queued). When the system
accepts new migration work, objects are taken from the queue based on the assigned priority
and age in the queue.

b. Click Next.
17. Auto rerun

a. Auto re-run task if target user(s) are missing any files or folders - Select this option to rerun
the migration task for files or folders that failed to migrate on the first run. The migration task will auto
rerun once only. Failure of the files to migrate the first time could be because of intermittent network
issues or throttling. We recommend that this setting remains selected.

This setting is enabled but read-only if the Migrate permissions in the Auto rerun task option
is selected in Attribute Options. Auto re-run is not available if an alternate target migration
folder has been specified in the Migration Options step or item filters have been configured in
Filter Items step.

The migration service will issue an event warning for all files that fail to migrate. You can also check
the batches for how many files failed to migrate.

b. Click Next.
18. Reporting
Generate detailed report of migration errors - select this option to generate a migration error report when
you run the OneDrive Migration Task.

You can download the report from the Reports tab of the Accounts and User Data migration workspace by
clicking the Download link in the Error Log column. If there are no migration errors, a download link is not
available. Error reports are retained for 30 days. After 30 days the download link is replaced with the label
Expired and you can no longer download the report. For more information about error reports, see Reports.

19. Summary

a. Save task settings as a migration template - select this option to save the settings in this wizard
as a reusable migration template.

« Migration Template Name - specify a name for the template. If you have changed the
settings of a preselected template, specify the same template name to apply the changes to
the template when you complete the wizard.

b. Verify the task specifications as described below:

+ Name - name of the task. You can specify a custom name. The default name is OneDrive
Migration Task.

« Source tenant - name of the tenant where the statistics will be collected.
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« Target tenant - name of the target tenant in this project.

« Scheduled start - date and time when the task will start. Now indicates that the task will start
immediately.

o Priority - the priority of this task.
« File migration - migration action when a file is migrated.
« Versions to migrate - options to migrate the version history.

+ Account to display - account name that will be displayed in the Created by and Modified
by properties of migrated content:

« Alternative migration location - default is the root folder or an alternate target
migration folder

« Sharing permissions - how sharing permissions will be transferred to the target users.

o Auto-rerun - option to rerun the migration task for files or folders that failed to migrate on
the first run.

« Sensitivity labels - indicates how sensitivity labels should be processed. Valid settings are:
Do not process labels, Match and apply corresponding labels to documents migrated to the
target, and Remove sensitivity labels from documents migrated to the target.

+ Reporting - option to collect and retain data for report generation.

c. Click Back to change configurations if necessary or click Finish to save and start the task
as scheduled.

Tracking the progress of the migration task

While the OneDrive Migration Task is running, click Assessment to track the progress of the migration task.

Migration > KittyMart = PetCorp > Accounts and User Data

DASHBOARD ACCOUNTS MAILBOXES ONEDRIVE EVENTS TASKS

Assessment Any - Any -

The following summary reports are available and described below.

e OneDrive Users
« Migration Progress is updated in real time.

o Migration Statistics

OneDrive Users

The Users figure at the top of the OneDrive users pane reports on the total number of OneDrive users to migrate.
Account migration and matching reports on the number of OneDrive users matched and not matched.
OneDrive provision in target reports on the number of provisioned users.
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OneDrive Users

482 Users

Account Migration and Matching

96 Matched 386 Not Matched

OneDrive Provision in Target

105 Provisioned 377 Unknown

Migration Progress

The migration progress pane reports on the status of the migration of OneDrive users. It is updated in real time.

Statistic Description

Last Run This data relates to the Last Run Status column on the List View tab. Show data from the last run
Status status: new, in progress, completed, failed, stopped.

Progress Started Users = The users listed on the List View tab with Migration Progress % greater than
of Started  zero.

Users The bar chart shows the Migration Progress % for users. It shows how many users have
Migration Progress % at fewer than 50%, 50% to 95%, 95% to 99%, and 100%. For example, if
the diagram shows 63 users at 100% then 63 users have Migration Progress % value of 100%.

How is Migration Progress % calculated? It is calculated as a ratio of the number of target items to
the number of source items. If 10 items have migrated to the target and there are 100 items to be
migrated on the source then the ratio for that user Migration Progress % is 10%.

Average % This is the average Migration Progress % value for users on the List View.
for started
users
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Migration Progress
Last Run Status: 387 New | 0 In Progress | 52 Completed | 0 Failed | 43
Stopped

Progress of Started Users (Source/Target Items Ratio)

<sov |
50%-95% |

95% -99.99% [N

100% |

S 0 B o SRR

G5

Users

Average % for Started Users: 75.57 %

Migration Statistics

The migration statistics pane reports on statistics recorded for the last 14 days.
« Total migration file size for entire project (last 14 days)
» Total migration file count for entire project (last 14 days)

Dependent on the scope of the file migration the content of OneDrive storage is transferred in batches that
can be submitted for processing to OneDrive at the same time to be processed concurrently, it can take a
while for OneDrive to complete processing of submitted batches. Refer also to the Events tab while the
migration task is running.

Migration Statistics
Current Migrating Users 5
Scope: Entire Project (Last 14 days)

Total Migration File Size

Packaged 592.5 KB

Migrated 592.5 KB

Total Migration File Count
Packaged 58

Migrated 58
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Viewing the report

1. Open the Tasks tab.

2. Selectthe OneDrive Reporting Task (or your custom name) that you want to review.
3. Inthe task details pane that opens click Events (number).
4

Select the event with the description: Link to download the report is in the Details pane. Report link is active
for 1 hour.

5. Click the report link in the details pane.
&) EDIT COLUMNS devents Q

Time = Description Task Name X

Today at 5:45 PM Completed reporting task. Onel

o Link to download the report
is in the Details pane. Report

Today at 5:45 PM Link to download the report isin the Details pane. Report link is active for 1 hour. OneDrive Reporting Task

link is active for 1 hour.

Today at S:41 PM Generating report. Please wait . ask

e e 9 @

Task has baen started (Starte

6. You can rerun the OneDrive Reporting Task after 1 hour to generate another report, and follow the same
steps described here to view the report.

Assessment

After you start a OneDrive migration, open the Assessment view to see the reports described below.
Migration » KittyMart = PetCorp » Accounts and User Data

DASHBOARD ACCOUNTS MAILBOXES ONEDRIVE EVENTS TASKS

Assessment Any - Any -

i NOTE: Click the Assessment button again to refresh the reports during a migration.
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OneDrive Users

OneDrive Users

482 Users

Account Migration and Matching

96 Matched 386 Not Matched

OneDrive Provision in Target

105 Provisioned 377 Unknown

e Number of users
o Number of user accounts that are matched or unmatched
« Number of OneDrive accounts provisioned or not provisioned in the target tenant

Migration Progress

Migration Progress
Last Run Status: 387 New | 0 In Progress | 52 Completed | 0 Failed | 43
Stopped

Progress of Started Users (Source/Target Items Ratio)

<50%

50% - 95%
95% - 99.99%
100%

S ® 0 K

S5

DA A

Users

Average % for Started Users: 75.57 %

« Last Run Status - number of user accounts in state of the migration process
» Progress of Started Users (Source/Target Items Ratio)

» Average % for Started Users
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« Migration Statistics

Migration Statistics
Current Migrating Users

Scope: Entire Project (Last 14 days)

5
Total Migration File Size
Packaged 592.5 KB
Migrated 592.5 KB
Total Migration File Count
Packaged 58
Migrated 58

o Current Migrating Users - number of users that are currently migrating.

« Scope - indicates the performance of the migration within the last 14 days

o Total Migration File Size - total files size packaged or migrated within the last 14 days
» Packaged - total file size submitted for migration

Migrated - total file size actually migrated

« Total Migration File Count - total files packaged or migrated within the last 14 days

Packaged - total number of files submitted for migration

Migrated - total number of files actually migrated

« File Size (per hour) - performance chart that indicates the file size packaged and migrated per hour. Data is
displayed for the last 14 days.
File Size (per hour)

File Count (per hour) - performance chart that indicates the number of files packaged and migrated per
hour. Data is displayed for the last 14 days.
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File Count (per hour)
2

File Gount

[

[
Jun 08, 21:00 Jun 08, 60:00 Jun 08, 03:00 Jun 09, 06:00

Jun 09, 0800 Jun 08, 12:00 Jun 08, 15:00 Jun 09, 18:00
Time(uTC)

N Packaged [ Migrated

+ Average concurrent migrating users (per hour) - indicates the average number of users being

concurrently migrated per hour. The optimization is managed seamlessly by the migration service to avoid
bandwidth or throttling issues.

Average concurrent migrating users (per hour)
10

Avg users count
e

u |

Jun 08, 21:00 Jun 10, 20:00 Jun 12, 19:00 Jun 14, 18:00

Jun 16, 17:00 Jun 18, 16:00 Jun 20, 15:00 Jun 22, 14:00
Time(uTC)

I g users count
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Microsoft Teams Migration

On Demand Migration for Teams securely migrates Microsoft Teams and associated Microsoft 365 Groups
across Microsoft 365 tenants. You can also use this dashboard for migration of content for Microsoft 365 Groups
without Teams functionality. (Content Migration for Microsoft 365 Groups). Microsoft Teams migration requires
additional licensing.

Basic Microsoft Teams migration workflow consists of the following steps:

#

Step

Create a migration project (created automatically with New Migration Ul)

Grant necessary permissions in case these permissions are not already granted. See
Prerequisites.

IMPORTANT: Itis not recommended to use existing user accounts as source and target
temporary Migration Service accounts, because it is recommended to remove them for safety
reasons after the migration will be completed. These accounts can be removed from teams as
described in Finalizing the Migration.

Discover teams/groups on the source tenant
On this step you can see names, suggested for target teams. In case you need some changes
use manual mapping as described below. There are no provision on the target on this step.

TIP: Organize teams in collections to streamline the provision and migration process

Export teams mapping to CSV file

Map teams manually using exported CSV file

You can use manual mapping to migrate source team to the target team with another name. If the
channel do not exist, it will be provisioned. Also you can use manual mapping to merge several
source teams to one target team.

Create Microsoft 365 Groups and Provision teams on the target tenant. Target teams will be
owned by the target temporary Migration Service account that is used to perform the provisioning.

» The temporary Migration Service account in the source tenant will be added to all source
teams as a member, and source private channels as an owner.

» The temporary Migration Service account in the target tenant will be added to all target
teams and Microsoft 365 Groups as a member and an owner, and target private channels
as an owner

These accounts can be removed from teams as described in Finalizing the Migration.

Migrate teams
Migrate / merge all conversations (including inline content) from the source to target channels.

o Target temporary Migration Service account will own all private channels migrated to the
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# Step

target.
8 remigrate teams to incorporate supported changes made after the migration task (step 7) was
started.
9 Monitor the progress and track issues

What We Migrate

Migration limitations indicated below may not be an exhaustive list of limitations as some may appear in unique
customer migration scenarios, or arise due to platform or legacy support restrictions. In some cases, a solution to a
limitation may already be on the product roadmap.

In this topic:

+ Objects and content types
« Migration from an Education tenant to an Education tenant

o Migration from a Commercial tenant to a GCC High tenant

Objects and content types

Object Support  Notes

Adaptive Cards X

Announcements partial Customized background picture for announcements cannot be
migrated

Applications partial Only Word, Excel, PowerPoint, OneNote and List tab applications

linked to files in the same channel are supported. If you rename a
tab in the source team and then re-migrate, the renamed tab will
be migrated. The target will then have two tabs, one with the old
name and one with the new name.

Whiteboard tabs are migrated if the Whiteboard files, in the
OneDrive of the Whiteboard creator, is pre-imgrated to the target
tenant. At least one team owner must have permission to the
whiteboard file in source tenant. Whiteboard tabs will be migrated
as Weblink tabs in target.

Applications including Shifts X
for schedule management

Archived team v Archived teams will first be migrated to the target tenant as active
teams. Then they will be archived in the target tenant. Archived
team can only be migrated once and remigrating archived teams
is not supported.

Attached images, media files, partial Preview icons cannot be migrated.
documents
Authorship partial Authorship in messages is migrated as a string with author name

On Demand Migration User Guide

Microsoft Teams Migration 181



Object Support  Notes
and creation date. File authorship is supported.

Bots Bot messages in channel conversation can be migrated.

Calls and devices X Contacts, contact groups, call history, voicemail, and custom
setup cannot be migrated. Devices and device setup cannot be
migrated.

Chats v Images, media files and documents referenced in one-on-one or

group chats are stored in your OneDrive for Business folder. They
must be migrated using the On Demand Migration for OneDrive
service, before you migrate the chats. File links in team chats will
not work after chat migration if the files are moved to another
folder in the source tenant.

Files that are linked to the private chats and meetings are
migrated but do no display in the Files tab of private chats and
meetings. In the source tenant a member removed from a chat
can still see the history of the chat in the source. In the target
tenant, members cannot see the history of chats they have been
removed from.

Users deleted on the tenant cannot be migrated, so do not appear
as members of a chat on the target. Deleted users remain visible
as members of a chat on the source. One-to-one chats, where
one of the users is deleted, are migrated for the user that is still a
member of the tenant.

If external users are added to target chats during migration, the
external users cannot access the Archived chat file since no
permissions are granted to the external users.

If a domain move is done after a chat migration, the Conversation
History links in migrated chats will not work because the URL of
those tabs remain mapped to the original target domain.

Private one-to-one chats are migrated as group chats. All the
messages in the migrated chats are posted by the temporary
Migration Service.

Private one-to-one chats with a Skype user cannot be migrated.
The Microsoft Graph API List chat messages do not support
querying messages of that type.

Private one-to-one chats initiated by an external user (user from
another tenant) cannot be migrated. Private one-to-one chats not
initiated by an external user are migrated, and in the title the
external user’s real name is replaced with the text "External user".
Bot messages will not be migrated.

Loop components in chats cannot be migrated.

Emoji is not supported when archiving chats.

Errors in chat migration will not be linked to a particular user since
chat always happens among multiple users. As a result, those
errors will not be visible in Exported Error Logs since the logs are
exported per user.

Chat application tabs cannot be migrated.
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Object Support  Notes

Code snippets X

Conversations v The target tenant's temporary Migration Service account is
displayed as the owner of all migrated messages on the target:
The original owner and creation time of a message are displayed
in the first line of the message starting with "Originally posted
by...".

Individual messages larger than 4 MB will not migrate. Messages
containing several inline messages can exceed 4MB. The chat
will migrate without the large messages. An error will display in
the On Demand Migration for Teams Events tab of the form:
Request failed with RequestEntityToolLarge status code (Request
Entity Too Large).

Custom tags for teams v GCC tenants do not support tags.

Custom website tab v

E-mail attachments X

Emoiji, GIF, Sticker, Praise, v Emoji in messages are supported but reaction emojis are not

memes supported.

File preview partial Preview icons of files attached to a post cannot be migrated. The
file is migrated as a link.

Formatted text

Guest accounts and v

conversations

Images posted inline from v

buffer

Inbox folder and Calendar from v

the group mailbox associated

with a team

Link preview of public images v Preview icons cannot be migrated. Only the link is migrated.

Link preview of public sites partial Preview icons cannot be migrated. Only the link is migrated.

Lists partial Lists must be created in the same SharePoint site used by the
team or Private Channel. You must select the Standard and
Customized (All SharePoint Content) option in the Migration
Options step of the New Teams Migration Task to allow the
migration of Lists and their content.

Meeting conversations v Conversations are migrated as private chats, but cannot be
inserted into the original Teams meeting. Conversations in a
channel stay in the channel rather than a private chat, and are
migrated to the target channel with a Teams migration task.

Meeting Notes in private X

meetings

Meeting recordings partial Recordings of scheduled meetings in a team channel, stored in

SharePoint or OneDrive, are migrated.
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Object

Support

Notes

@mentions:

» Users (includes
@Everyone)

e Channels

e Teams

OneNote

OneDrive Shared Library

OneDrive Sharing Links

Planner

partial

partial

partial

partial

« Meeting recordings stored in Microsoft Stream (Classic)
cannot be migrated; the link to the recording on the source
team channel is retained.

« On Demand does not support meeting recordings in a
group chat. Recordings in group chats and one-to-one
chats cannot be migrated with the On Demand Migration
for Teams service. Since the recording file is stored in the
chat organizer's OneDrive account, you can use the On
Demand Migration for OneDrive service to migrate
recordings.

e On Demand does not support meeting recordings for
"Meet now" meetings.

All @mentions from the source will be created as plain text with
blue color in the target tenant to avoid notification to end users
during migration.

OneNote files will be migrated during file migration but the
OneNote tabs will not be created in the target channels due a
limitation of the Microsoft APl. When migrating to a new team,
default notebook tabs in target channels will be linked to the
migrated OneNote files since the tabs are created automatically
during teams creation in the target tenant.

If teams are renamed during migration, the default notebook in
the source tenant will be migrated as source team name instead
of the renamed target team name. As a result, the Note content
will not show up in the target team channel and the notebook link
in the SharePoint quick launch does not open the Note content.

OneDrive Shared Library must be created and associated with a
team in the same SharePoint site. You must select the Standard
and Customized (All SharePoint Content) option in the Migration
Options step of the New Teams Migration Task to allow the
migration of OneDrive Shared Library and its content.

Only shared links that were activated by the users or group
members (the user or group member clicked on the link to access
the file or folder) in the source tenant will be migrated and
converted to direct permissions. Users or group members who did
not activate a shared link in the source tenant will not get the
direct permissions in the target tenant and must re-request
permissions from the owner when they access the file or folder in
the target tenant. Use the Convert Sharing Links permissions
to direct permissions option in the Attribute Options step of the
New OneDrive Migration Task to migrate sharing links.

Premium Planner and Planner Tab are not migrated. Buckets,
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Object Support  Notes
Planner Tasks and Comments are migrated. When migrating
Planner Tasks, assignees in target tasks will receive a notification
after migration.
The author of auto-generated comments like 'New task ... created'
in migrated tasks will always show as the login user. This is a
limitation of Microsoft Graph APl when creating tasks in the target
tenant with application permission.
Premium Planner plans are not supported due to a limitation of
Microsoft Graph API.

Private channels v See Channel settings subsection below.

Reaction Emoji X

Rich card attachments X

Self-Chat X

Shared channels v See Channel settings subsection below.

SharePoint document libraries v Sensitivity labels applied to SharePoint files can be migrated.

(Files)

Standard channels v See Channel settings subsection below.

Team owners and team v Only for Microsoft 365 Groups that are migrated / matched.

members Teams and groups with dynamic membership can be migrated
but cannot be merged.
The memberships is not updated in Teams immediately after
membership migration. It takes a while before Microsoft
synchronizes memberships between groups and Teams.
Workaround: Wait for membership synchronization.

Team picture v

Team settings partial Target team settings cannot be updated if you re-run the
provisioning task.
Allow members to upload custom apps and Team code
settings cannot be migrated.

Timestamps v

Wiki sections and pages X

Files uploaded from mobile application

Media files
Voice recordings

Documents

Channels and Channel Settings

General settings

v
X
v

Channel isFavoriteByDefault property migration is not supported.
Workaround: Enable Automatically show this channel in
everyone’s channel listoption for the channel manually in your
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Object

Support

Notes

Standard channels

Private channels

Shared channel

Group Settings

Allow external senders to email
this group

Send copies of group
conversations and events to
group members

Hide from my organization's
global address list

Others

Microsoft public preview

M365 security and compliance
features for Teams

e Legal Hold
+ Retention Labels

e Microsoft Information
Protection policies and
labels

» M365 Compliance
Customer Lockbox

Power Platform features for
Teams

« Power Apps
o Power Pages

« Power Automate
(Flow)

« Power Virtual Agents

Teams client.

The Teams client will not display the updates immediately. It may
take up to 24 hours before the changes are reflected due to
Microsoft limitations. Private channel members not visible in the
Teams application unless you explicitly search for a member.

Shared Channels can only be provisioned in the original team
where the channel was created. Shared Channel membership is
not migrated.

General

General

General

In general, Microsoft public preview features cannot be migrated.
These features may also take additional time to be fully
developed and tested before being released to production.

Migration from an Education tenant to an Education tenant

Teams migration from one education tenant (Microsoft 365 for Education) to another is partially supported. The
following team types and supported content can be migrated:
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« Standard Team
« Class Team

e PLCTeam

« Staff Team

Limitations

« When provisioning Public Education teams, the visibility of the teams will change due to limitations of the

Microsoft Teams for Education Templates:

« Class Team: changes from Public to HiddenMembership.
« PLC and Staff: changes from Public to Private.

« Assignment app, personal OneNote notebook linked to a Teams channel and the OneNote tab linked to

another team are currently not supported. Links to files in migrated messages cannot be migrated in case
these links point to files located outside the default SharePoint URL. These links are missing in the target.

All other Education content is not supported for migration.

Migration from a Commercial or GCC tenant to a GCC High tenant

The table below lists the content types in Microsoft Teams that are available for migration from a Commercial or

GCC tenant to a GCC High tenant with the On Demand Migration for Teams service.

Content type

Availability in

GCC High
tenant

Migration support

Announcements

Applications

Applications including shifts for schedule management
Associated SharePoint document libraries (files)
Attached images, media files, documents
Authorship

Bots

Calendars

Chats

Code snippets

Conversations

Custom tags for teams

Custom website tab

Email attachments

Emoiji, Teams GIFs, memes

Formatted text

A
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Content type Availability in Migration support

GCC High
tenant
Group mailbox associated with team v X
Guest accounts and conversations v v
Images posted inline from buffer v v
Link preview of public images v Partial. Icon is not
migrated.
Link preview of public sites v Partial. Icon is not
migrated.

Meeting conversations v v
Mentions v v

» Users

e Channels

e Teams
OneNote v X
Planner (Planner Tab, Buckets, Tasks and Comments) v v
Private channels v v
Public channels v v
Team owners and team members (Creation of Microsoft 365 v v
Groups)
Team picture v v
Timestamps v v
Wiki sections and pages 4 x

i NOTE: Starting January 2024, neither Wiki tabs nor the

Wiki app will be accessible through Teams. Users will no
longer have the ability to export their wikis. However,
users will still be able to download their wiki files from
SharePoint. For more information, see
https://support.microsoft.com/en-us/office/export-a-wiki-
to-a-onenote-notebook-in-microsoft-teams-8cd8ab0c-
2314-42b0-a1d0-5c6c4c5e1547

Prerequisites

Verify the following requirements are met before migrating Microsoft Teams. If these actions are not performed,
discovery, provision and migration tasks will fail or some data might be lost!

The following consents must be granted to the tenants before Teams migration can be started
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Migration - Basic
Migration - Mailbox Migration

Migration - SharePoint - Minimal for the source tenant, and Migration - SharePoint - Full for the source

and target tenants. Migration - SharePoint is a legacy permission set and should be replaced with either
the Minimal or Full permission sets.

Migration - Teams - Minimal for the source tenant, and Migration - Teams - Full for the source and target

tenants. Migration - Teams is a legacy permission set and should be replaced with either the Minimal or
Full permission sets.

TIP: If the consents are not granted or expired, Discover Teams action is disabled and the following
notification is displayed: Grant admin consent to the following Migration sub modules on the Tenants
page for both source and target tenants: Basic, SharePoint, and Teams. Open Tenants page and
grant the necessary Required Consents and Permissions so that the product can access the source and
target tenants. You will be redirected to the Microsoft web site for granting admin consent. Once admin
consent is granted, you can start discovering Teams.

IMPORTANT: The Tenant Administrator must open the OneNote application just once in the target tenant. It
does not have to be opened or run by every user. If OneNote is not initialized before granting consent for
Teams migration, the following error occurs: Unexpected response while attempting to
register the tenant: AADSTSxxxxxx: The app needs access to a service
("https://*.onenote.com/")

Accounts must be matched or migrated before migrating teams.

Images, media files and documents referenced in one-on-one or group chats are stored in your OneDrive for

Business folder. They must be migrated using the On Demand Migration for OneDrive service, before you
migrate the chats.

Required permissions

See the On Demand Migration - Permissions Reference Guide for details.

Temporary Migration Service accounts

Itis recommended to create or use source and target temporary Migration Service accounts.

The temporary Migration Service accounts should be granted the Global Administrator or Teams
Administrator role on the tenants for which these account are used. The temporary Migration Service
accounts in the source and target tenant should have Teams license from the Microsoft 365 admin center.

Do not change your temporary Migration Service accounts before completing the migration project.

You must remove the source and target temporary Migration Service accounts for safety reasons

after the migration is completed. These accounts can be removed from teams as described in
Finalizing the Migration.

The target temporary Migration Service account is used in (but not limited to) the following scenarios:

It creates and owns the provisioned target teams.

Itis added to all target teams and Microsoft 365 Groups as a member and an owner, and to all target private
channels as an owner.

Itis used to perform the Teams migration and is displayed as the owner of all migrated conversation and
chat messages and planner tasks on the target.
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« Itis added to all the chats (both group chats and private chats) as a participant during chats migration, and
then removed from the migrated chats as soon as the chat migration is complete. All migrated chats of the
target temporary Migration Service account are hidden when the chat migration is complete.

Teams Migration Workspace

In this topic:

e Dashboard

e Teams

e Team Content

e Chats

o Configuring the project
.

NOTE: The Teams migration workspace is common for the Teams, M365 Groups and Chats migration
services. See Migrating Groups for details about M365 Groups.

Dashboard

NOTE: If the Teams license check fails, verify that the source and target tenants are valid. Then run the
PowerShell commands in Quest KB article 337302 to confirm that the tenant administrator account used to
grant consent has TeamspaceAPI activated.

Migration » New Project > Teams Submitidea B | T Select Collection

DASHBOARD TEAM TEAM CONTENT M365 GROUPS ~ CHATS  REPORTS

P —

~ DISCOVER & CONFIGURE PROJECT

Getting Started Teams
Q) reecequisice O oiscovery
® Grant Consent
© Check License and Rale
© Migrat

M365 Groups

QUICK HELP DISCOVER TEAMS DISCOVER M365 GROUPS

Chats 3 tasks No errors

DISCOVER CHATS SHOW ALL SHOW ALL
The components of the dashboard are as described below:

Notification panel - presents relevant information and shortcuts to migration activities. The notification panel is
displayed across all tabs.

Dashboard Menu - contains the following links to common activities in the migration process.

« Discover - starts the New Teams & Groups Discovery Task wizard to collect information about accounts in
the source tenant. For more information see Discovering Teams and Groups.
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« Configure Project - starts the Edit Project wizard for Teams. You can specify default settings as described
in the Configuring the project section.

Dashboard Tiles

« Getting Started - displays a summary of the various actions for preparing and migrating teams. Click Quick
Help to open the Quick Help dialog. Then click the Teams tab to see help topics related to Teams, or click
the Groups or Chats tab to see help topics related to Groups or Chats respectively.

x
Getting Started
R [ 3¢ croues | cnats |

(1) Preparation (2) Migration

Configure project Provision Teams

Before you begin

Migrate Teams

« Teams - displays a summary of the teams in various migration states. Click Show All to open the Teams
List view to inspect the teams.

« M365 Groups - displays a summary of the M365 Groups in various migration states. Click Show All to open
the Groups List view to inspect the groups.

o Chats - displays a summary of chats in various migration states.

« Tasks - displays the five most recent tasks that were completed in the Teams migration workspace. The title
displays the total number of tasks. Click Show All to open the Tasks List view.

« Events - displays the five most recent events that were completed in the Teams migration workspace. The
title displays the total number of events. Click Show All to open the Events List view.
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Teams

= Quest OnDemand Al Systems Operational (@) bobbydey@questcom s @

& Migration > Migration Test Org » Teams = Select Collectio

B8 My Dashboard TEAMS

DISCOVER TEAMS MORE ACTIONS &) EDIT COLUMNS n Q m

SharePoint Channels Members Source Fi. TargetFil.  Messages Migrated Plans Migrated. Tasks Migrated...

The Teams List View is comprised of the following components:
Notification panel - presents relevant information and shortcuts to migration activities.

Filter panel - consists of predefined filters for the Teams List view and tabs to switch between the Teams List view
and the Assessment view. See Filtering for more information about working with filters. The predefined filters are:

o Teams - returns a list of teams based on the migration state of the team.

« Teams By Size - returns a list of teams based on the size of a team. Valid ranges are More than 1GB,
100MB - 1GB, 10MB - 100MB, Less than 10MB. The dropdown also shows the number of teams in the list
for each range.

« SharePoint - returns a list of teams based on the nature of the SharePoint site linked to the team. Valid
values are Customized and Standard.

List View Actions Menu - contains links to teams migration activities and the search box. Each action is explained
in greater detail in subsequent topics. See Searching for more information about working with the search box.

List View - displays information about teams in the source and target tenants. Use the Edit Columns to show or
hide columns in the list. The columns are as described below:

« Team Name - name of the team in the source tenant.
+ Migration State - status of the task in the migration process. Values are as listed below:
« Discovered - team discovered in the source tenant.
« Exists in target - team in the source tenant exists in the target tenant.
« Provisioning - started provisioning team in the target tenant.
« Provisioned - team provisioned successfully in the target tenant.

+ Provisioned with issues - Team provisioned in the target tenant but there were issues during
provisioning.

o Provision failed - started provisioning team in the target tenant.
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* Queued - team is waiting for migration service resources to be available. For more information, see
How Queuing Works.

« Migrating - team migration in progress.
« Partially migrated - team migration completed but some components were not migrated.

« Partially migrated with issues - team migration completed some components were not migrated
and due to issues during migration.

+ Migrated - team migrated successfully to the target tenant.
+ Migrated with issues - team migration completed but there were issues during migration.
+ Migration failed - team could not be migrated.
« SharePoint - nature of the SharePoint site linked to the team. Values are as described below:
e <no-value> - SharePoint content has not be discovered yet.
e Standard -thereis at most 1 SharePoint site and 4 Lists in the SharePoint site collection

e Customized - there are more than 1 site and 4 Lists in the SharePoint site collection

i NOTE: The SharePoint status is available only after the New Teams Provisioning Task is run.

« Channels - total number of channels in the source tenant team.

» Source Members - total number of members in the source tenant team.

o Target Members - total number of members in the target tenant team.

« Source Files (GB) - total size in GB of files across all public channels in the source tenant.
« Target Files (GB) - total size in GB of files across all public channels in the target tenant.
» Source Messages - total number of messages in the source tenant team.

+ Migrated Messages - number of messages migrated to the target tenant team.

« Target Messages - total number of messages in the target tenant team.

e Source Plans - total number of plans in the source tenant team.

« Migrated Plans - number of plans migrated to the target tenant team.

o Target Plans - total number of plans in the target tenant team.

« Source Tasks - total number of tasks in the source tenant team.

+ Migrated Tasks - number of tasks migrated to the target tenant team.

« Target Tasks - total number of tasks in the target tenant team.

« Source SharePoint site Url - SharePoint site URL of the source team. Available when the team is
provisioned in the target tenant.

+ Target SharePoint site Url - SharePoint site URL of the target team. Available when the team is
provisioned in the target tenant.

« Mapped to Different SharePoint site Url - indicates whether or not the team's SharePoint site is mapped
to a different url in the target tenant.

» Progress (%) - migration progress indicated as a percentage.
o Last Activity - date and time of the last action performed on the team record.

« Created - date and time the team record was created.
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« Last Statistics Collected Date - date and time when the most recent statistics were collected.
« Target Team Name - name of the team in the target tenant.
o Source MailNickname - email alias of the associated Microsoft 365 Group in the source tenant.

« Target MailNickname - email alias of the associated Microsoft 365 Group in the target tenant. Available
when the team is provisioned in the target tenant.

« IsArchived - indicates whether the team is archived. Archived teams can be migrated like any other team.

» Collections - indicates the most recent collection where the corresponding Team is added and the number
of additional collections that also contain this object.

+ Source Team URL - URL of the source team.
« Target Team URL - URL of the target team. Available when the team is provisioned in the target tenant.
« Source Group ID - unique identifier of the team or group in the source tenant.

« Target Group ID - unique identifier of the team or group in the target tenant. Available when the team is
provisioned in the target tenant.

o Source SMTP Address - SMTP address of the Office 365 group of the source team.

o Target SMTP Address - SMTP address of the Office 365 group of the source team. Available when the
team is provisioned in the target tenant.

« Source Team Owner UPNs - User Principal Names of the source team owners. Up to 5 names are listed.

« Target Teams Owner UPNs - User Principal Names of the target team owners. Up to 5 names are listed.
Available when the team is provisioned in the target tenant.

Teams Assessment View
See the Premigration Assessment for Teams for the complete list of available reports.
Team Details

When you select a team from the List View, the Team Detail pane opens. The information in the pane is
described below:

« Description - name of the team in the source tenant.
» Visibility - indicates whether the source tenant team is Public or Private.
« Is Archived - indicates whether the source tenant team is archived.

« SharePoint Customized - status of the selected account. Valid values are New, In Progress, Failed
and Completed.

« Source Location - geo location of the source team. The geo location could be blank if your source tenant
team is not geo-located.

« Source Url - SharePoint site URL of the source team. Available when the team is provisioned in the
target tenant.

» Target Location - geo location of the target team. This value appears when the team is provisioned and will
reflect the preferred location specified in the New Teams Provisioning Task wizard. The geo location could
be blank if your target tenant team is not geo-located.

« Target Url - SharePoint site URL of the target team. Available when the team is provisioned in the
target tenant.

« Owner count - number of owners of the source team. A team can have up to 100 owners.

¢ Member count - number of members in the source tenant team.
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« Migrated messages count - number of messages migrated to the target tenant team.
« Archive messages count - number of archived messages in the source tenant team.

o Last Operation - the most recent operation performed on the team. Valid values are Discovered,
Provisioned, and Migrated.

« Events - count of the events that occurred during one or more tasks.

o Tasks - list of tasks invoked for the selected team.

Team Content

The Team Content tab presents a list of teams and its components along with the count of child items of the object
type. When you open the Team Content tab, the list view initially displays all the teams and their migration state
along with the total count of the team components of each team: Channel, Planner, Mailbox, Team membership,
SharePoint Content* and SharePoint Site*. For each team component you can additionally view its components and
their child item counts as well.

TEAM CONTENT
Any - Any Al Parent: FEV-EU_BD_Innovation x

& EDIT COLUMNS 1 ns Q m

Type Name & T Migration State items To Migrate Processed Progress(¥)

Vigrated —
tems To Migrate

9 000

L
o/e 09

* Example: Consider a team with multiple private channels A and B.

If you select the SharePoint Standard option in the New Teams Migration Task wizard, then the following items are
displayed in the Team Content view with type "SharePoint List" after migration.

Type Name

SharePoint List Documents - team site name

SharePoint List Documents - private channel A site name
SharePoint List Documents - private channel B site name

If you select the SharePoint Standard and Customized option in the New Teams Migration Task wizard, then the
following items are displayed in Team Content view with type "SharePoint Site" after migration.

Type Name

SharePoint Site Site - team site name
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Type Name

SharePoint Site Site - private channel A site name

SharePoint Site Site - private channel B site name

To display the contents of a specific team:

1. Select the team to open the details pane on the right hand side.

2. Click Show Content. The components of the selected team are displayed in the list view along with the
migration state and child item counts for each component. In the details pane, the Show Parent link is
activated and the Show Content link is deactivated.

* | NOTE: Components of a team can be displayed when teams are migrated through a new project created
after the Jan 10, 2023 release.

d All Systems Operational (B) bobby.dey@quest.com \ [i ]

ion > Migration Test Org > Teams T Select Collectior

B8 My Dashboard

TEAM CONTENT

& Tenants

= migration Any - Any BN Parent: Design

Design Membership

®
Mambarship Design Membarship

4

To display the parent of a specific team component:

1. Select the team component to open the details pane on the right had side.

2. Click Show Parent. The parent team is displayed in the list view along with the migration state and the total
count of the team components. In the details pane, the Show Content link is activated and the Show
Parent link is deactivated.

The components of teams are migrated when you start a migration task with the New Teams Migration Task wizard
and select the team component types to migrate.

i NOTE: The Events property value in the detail pane for a selected child component will be zero.

Filter panel - consists of predefined filters for the Teams List view and tabs to switch between the Teams List view
and the Assessment view. See Filtering for more information about working with filters. The predefined filters are:

» Status - migration state of the team.

« Type - object type: Team, Channel, Planner, Mailbox, team membership or SharePoint Content.
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List View - displays information about teams in the source and target tenants. Use the Edit Columns List View
Actions Menu to show or hide columns in the list. The columns are as described below:

o Type - object type: Team, Channel, Planner, Mailbox, membership or SharePoint Content.

+ Name - name of the object

+ Migration State - status of the task in the migration process. Values are as listed below:

Discovered

Exists in target - object in the source tenant exists in the target tenant
Mapped

Provisioning

Provisioned

Provision failed

Migrating

Partially migrated

Partially migrated with issues
Migrated

Migrated with issues

Migration failed

« Items to migrate - the count of child items of the object. For each team, the count indicates the total
number of child components of the team. For each team components the item counts displayed are as
described below:

Planner: number of Planner tasks

Channel: number of messages

Mailbox: the team mailbox. The count is always 1
Membership: number of team members

SharePoint Content: number of sites

« Processed - the number of items considered for migration.

» Progress (%) - migration progress in percentage. If a team component is not selected for migration in the
New Teams Migration Task wizard, this value does not exist for the component.
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Chats

The Chats List View displays Chats between one or more matched users between a source and target tenant.

Migration > New Migration Project > Teams T Select Collectio

CHATS

Q DISCOVER &) EDIT COLUMNS Q m
ser Name & ration State Mailbox Status Migrated Chats reh Source

Workflow ODM Licensed OneDrive Status

No

No

© © 0 © 0 0 © 0 ¢ © ©
1 1 3 i & & & @

The Chats List View is comprised of the following components:
Notification panel - presents relevant information and shortcuts to migration activities.

Filter panel - consists of predefined filters for the Chats List view . See Filtering for more information about working
with filters. The predefined filters are:

« Chats - returns a list of chats based on the migration state of the team.
« ODM Licensed - returns a list of user account with ODM license status. Values are Yes and No.

« Account Type - returns a list of user accounts based on their mailbox type. Values are Mailbox-Enabled
Userand Non-Mail-Enabled User.

List View Actions Menu - contains links to chat migration activities and the search box. Each action is explained in
greater detail in subsequent topics. See Searching for more information about working with the search box.

List View - displays information about teams in the source and target tenants. Use the Edit Columns to show or
hide columns in the list. The columns are described as below:

« User Name - name of the user account.

« Migration State - migration status of chats from discovery to successful migration. Values are
Discovered, Migrating, Partially migrated, Partially migrated with Issues, Migrated, Migrated with Issues,
Migration Failed.

« Account Type - indicates the mailbox type of the user account. Values are Mailbox-Enabled User and Non-
Mail-Enabled User.

+ ODM Licensed - indicates whether or not an On Demand Migration user account license has been
consumed when the account migration task is started. Values are Yes, No, Not required.

o Account Matching -(deprecated)

« OneDrive Status - migration status of the OneDrive files for this user.
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Mailbox Status - migration status of a user's mailbox. It is a best practice to migrate a mailbox before chats
are migrated for any user. Values are Discovered, Matched, Migrating, Migrated, Migrated with Issues,
Migration Failed, Switched, and Migration Stopped.

Migrated Chats - number of chats that have been migrated.

Archived Chats - indicates whether or not the archive option is selected during a chat migration. If the value
is Yes, chats belonging to this user cannot be archived again.

Message Count (< 180 days) - number of chat messages generated by the user in the last 180 days. There
is a latency of 24-48 hours from the time a message is created.

Last Activity (< 180 days) - most recent activity in the last 180 days. This data is provided by Microsoft
based on user activity in Microsoft Teams.

Total Chats - total number of chats in the source tenant.
Source UPN - User Principal Name (UPN) of the source account.
Target UPN - User Principal Name (UPN) of the target account.

Collections - indicates the most recent collection where the corresponding Chat is added and the number of
additional collections that also contain this object.

Configuring the project

Before you begin, you must configure the teams migration project as described below:

1.

2
3.
4

7.

Log in to Quest On Demand and choose an organization if you have multiple organizations.
From the navigation pane, click Migrate > Projects to open the My Projects list.
Create a new project or open an existing project.

Click Teams from the project tiles, or click Open from the Teams tile to open the Teams migration
workspace.

Click Configure Project. The Edit Project wizard for Teams starts. You can specify default settings as
described below:

Project Settings

a. Set Migration Defaults - specify a Default target user to use as the team owner when the existing
owner has no match on the target tenant. Then click Finish to save the setting.

b. Teams Migration Option - select Skip private channels during provisioning and migration to
prevent the provisioning of and migration of private channels. However, if private channels are
already provisioned, this setting will be ignored and private channel content will be migrated.

c. Chat Archive Setting - specify a Folder name for archived files for archiving HTML chat files
d. Click Next.
Migration Service Accounts

a. Displays the current source and target tenant names along with the username that has granted
consents to the tenant. If consents are missing for one or both tenants, then a warning message is
shown to check the consents.

b. Click Back to revise or review a previous step or click Finish to save the configuration.
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Discovering Teams and Groups

Every team is associated with a Microsoft 365 Group, but there are groups that are not associated with teams. In
this topic, the term team means a Microsoft Team and includes its associated group, and the term group means a
Microsoft 365 Group that is not associated with a team.

NOTE: This topic explains the process to discover both teams and groups. If you want to discover only
teams, see Discovering Teams. If you want to discover only groups that are not related to teams, see
Discovering Groups.

In this topic:

Discovering all teams and groups
Discovering teams and groups from a file
Reviewing the Discover task

Reviewing the Discover task events

Discovering all teams and groups

This is the simplest approach which uses the Discover tasks to inspect the source tenant and discover
all the teams.

To start the Discover task:

1.

2
3.
4

o

Log in to Quest On Demand and choose an organization if you have multiple organizations.
From the navigation pane, click Migrate > Projects to open the My Projects list.
Create a new project or open an existing project.

Click Teams from the project tiles, or click Open from the Teams tile to open the Teams migration
workspace.

Click Discover > Discover All from the Teams dashboard.

The New Teams & Groups Discovery Task wizard starts. Each step is described below:
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7. Discovery Options

New Teams & Groups Discovery Task

Discovery Options Select an option to discover Microsoft Teams and Groups provisioned in the source tenant

Notification

i NOTE: The Azure AD administrator account will be added to the discovered Teams and Groups.

a. All Teams - select this option to discover all Microsoft Teams.
b. All Groups - select this option to discover all Microsoft 365 Groups without Teams.
c. All Teams and Groups - select this option to discover Microsoft 365 Groups and Teams.
d. Click Next.
8. Notification

a. Send notification email once the task is completed - select this option to send a notification
email when a discovery task completes.

« Only in a case of failure - select this option to send the email if the discovery task fails to
complete successfully.

b. Recipients - enter the email address of the recipients of this email. You can specify multiple
recipient email addresses separated by semicolon.

c. Click Next.
9. Schedule

a. Choose from one of three options to schedule the task. The scheduler will be activated only after you
complete the task wizard.

* Run now - task runs immediately.
* Run later - task must be started manually.

« Schedule - task will be started at a future date and time entered in the corresponding
calendar field.

b. Click Next.

On Demand Migration User Guide
Microsoft Teams Migration



10. Summary
a. Verify the task specifications as described below:
i. Name - name of the task. You can specify a custom name. The default name is Discover.
ii. Source tenant - name of the tenant where the statistics will be collected.
iii. Target tenant - name of the target tenant in this project.

iv. Scheduled start - date and time when the task will start. Now indicates that the task will start
immediately.

b. Click Back to revise or review a previous step or click Finish to complete the task wizard and start
the task as scheduled.

Discovering teams and groups from a file

This step is required if you plan to discover teams and groups using a CSV file. When you have a large set of teams
and groups but you want to migrate a subset of the objects, the CSV file lets you specify the teams and groups that

you want to discover and ignore the rest. You can then use this file in the New Teams & Groups Discovery Task as

described in this topic to discover the teams from the source tenant.

Preparing the CSV file

1. Login to the Microsoft 365 admin center (https://admin.microsoft.com) with the credentials of your source
tenant administrator.

2. From the navigation pane, click Active groups.
3. Select Microsoft 365 tab in the Active Groups page

4. Click Export and then click Export all groups. A Groups.csv file will be downloaded to your computer.

i Microsoft 365 admin center P sesrch

Starz Corp

Active groups

Microsoft 365 Distribution list  Mail-enabled security  Security O Searchall groups

3items Y Groups with Teams

Contoso

| ¥ Health

5. Editthe CSV file and retain the Group ID and Group name columns. Then retain the teams and groups you
want to discover and delete the rest.
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6.

Groups.csv ~ jo

File Hom Inser Draw Page Form Data Revie View Help >
B13 & Fe i
A B -
1 |Group ID Group name
2 |58812962-49ba-4343-9df0-1d786edbc031 All Company
3 |Bcedb05c-c2c0-4091-a071-d764d 7f40b04 Contoso
4 |3e4aB8be-9302-4b9b-8bd5-a46dd4a8adbbb  Starz Events
5 |cDaf280a-91f7-4825-8477-ade6d776b80e Starz Finance
6
7
8
g -
Groups @ 1 3
Ready = m - 1 + 100%

Save the CSV file. You may rename the file if needed.

Starting the Discover Task

1.

N o o k& w0 N

Log in to Quest On Demand and choose an organization if you have multiple organizations.

From the navigation pane, click Migrate > Projects to open the My Projects list.

Create a new project or open an existing project.

Click Teams from the project tiles, or click Open from the Teams tile to open the Teams dashboard.
Click Discover > Discover from file from the Teams dashboard.

The New Teams & Groups Discovery Task wizard starts. Each step is described below:

Discovery Options

New Teams & Groups Discovery Task

I Discovery Options Select a comma-separated values (CSV) file that contains the list of Microsoft 265 Groups and Teams to be

X discovered. Refer to the documentation for details about the file format.
Notification

Step 10f3 Next
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a. Click Browse and select the CSV that contains the Group IDs and Group names of the teams that
you want to discover.

b. Click Next.
8. Notification

a. Send notification email once the task is completed - select this option to send a notification
email when a discovery task completes.

« Only in a case of failure - select this option to send the email if the discovery task fails to
complete successfully.

b. Recipients - enter the email address of the recipients of this email. You can specify multiple
recipient email addresses separated by semicolon.

c. Click Next.
9. Schedule

a. Choose from one of three options to schedule the task. The scheduler will be activated only after you
complete the task wizard.

* Run now - task runs immediately.
+ Run later - task must be started manually.

« Schedule - task will be started at a future date and time entered in the corresponding
calendar field.

b. Click Next.
10. Summary
a. Verify the task specifications as described below:
i. Name - name of the task. You can specify a custom name. The default name is Discover.
ii. Source tenant - name of the tenant where the statistics will be collected.
iii. Target tenant - name of the target tenant in this project.

iv. Scheduled start - date and time when the task will start. Now indicates that the task will start
immediately.

b. Click Back to revise or review a previous step or click Finish to complete the task wizard and start
the task as scheduled.

Reviewing the Discover Task

1. Open the Tasks tab.

2. Select the task that you want to review. The default name is Discover.

3. Inthe task details pane that opens, the information presented is as described below:
a. Type - type of the task. The type is discoverteams.
b. Created - date and time when the task was created.
c. Modified - date and time when the task was last updated.
d. State - state of the task.

e. Last Operation - the action that was most recently performed in this task.
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f. Schedule - date and time when the task started. Now indicates that the task started immediately
after the task was created.

g. Events (number) - number indicates the count of events that the task encountered. The values
indicate the type of the events and the event count for each type.

Migration > New Migration Project > Teams = select Collectio

TASKS

@) oi
\\_//‘n Discover Teams

©  Discover Complated Discovery Today st 8:34 AM Discovered 10 teamis)

4. Ifyou select the options to collect statistics in the New Teams & Groups Discovery Task wizard, you will see
additional tasks: Collect Plan and Task statistics for Teams and Groups and Collect Message statistics for
Teams. Click each task to view the corresponding details in the details pane.

Reviewing the Discover Task Events
1. Open the Tasks tab.

2. Select the task that you want to review.

3. Inthe task details pane that opens, click Events (number). The Events tab opens with a filtered list of events
for the selected task.

4. Select an event that you want to review. In the event details pane that opens, the information presented is as
described below:

a. Object - name of the team or group discovered.

b. Task - name of the task.

c. Time - date and time when the event occurred.

d. Category - type of task. the value is Application.

e. Source - name of the On Demand Migration service
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Migration » Starz Corp =

DASHBOARD TEAMS

Any -
CLEARALL

o Time ¥

o e Today at 5:24 PM
o e Today at 5:24 PM
o o Today at 5:24 PM
o o Today at 5:24 PM
o o Today at 5:24 PM
o e Today at 5:24 PM
[m] Li ] Today at 5:24 PM
o e Today at 5:23 PM

Galaxy Corp > Teams

EVENTS TASKS

M365 GROUPS

CHATS

Today "
7days
30 days

[
Customrange  qaam

Description

Discover completed. Discovered 4 teamys) and group(s) in total
Discovered team 'Contoso’

Discovered group ‘All Company’

Discovered team ‘Starz Events

Discovered team "Starz Finance’

Migration engine version 1.2.0.1545

Discovering teams) and group(s)...

Task has been started (Started by user)

6AM

Object Name

Contaso
All Company
Starz Events

Starz Finance

9AM

Task Name

Discover

Discover

Discover

Discover

Discover

Discover

Discover

= Select Collection -

12PM IPM &PM 9PM 12AM

x

- o Discovered team 'Contoso’

Object Contaso

Task Discover

Time Friday, July 23, 2021 5:24 PM
Category Application

Source Teams Migration
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Discovering Teams

In this topic:

Discovering all Teams
Discovering Teams from a file
Reviewing the Discover Teams task

Reviewing the Discover Teams task events

Discovering all Teams

This is the simplest approach which uses the Discover Teams tasks to inspect the source tenant and discover
all the teams.

To start the Discover Teams task:

1.

2
3.
4.
5

Log in to Quest On Demand and choose an organization if you have multiple organizations.

From the navigation pane, click Migrate > Projects to open the My Projects list.

Create a new project or open an existing project.

Click Teams from the project tiles, or click Open from the Teams tile to open the Teams dashboard.

Click Discover Teams from the Teams tile in the Teams dashboard

_or_

Select the Teams tab and select the List View if not already selected. Then click Discover Teams >
Discover All from the Actions menu.

The New Teams Discovery Task wizard starts. Each step is described below:

Discovery Options

New Teams Discovery Task

I Description Discover Microsoft Teams provisioned in the source tenant

Notification
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a. Click Next.
8. Notification

a. Send notification email once the task is completed - select this option to send a notification
email when a discovery task completes.

« Only in a case of failure - select this option to send the email if the discovery task fails to
complete successfully.

b. Recipients - enter the email address of the recipients of this email. You can specify multiple
recipient email addresses separated by semicolon.

c. Click Next.
9. Schedule

a. Choose from one of three options to schedule the task. The scheduler will be activated only after you
complete the task wizard.

* Run now - task runs immediately.
* Run later - task must be started manually.

o Schedule - task will be started at a future date and time entered in the corresponding
calendar field.

b. Click Next.
10. Summary
a. Verify the task specifications as described below:

i. Name - name of the task. You can specify a custom name. The default name is
Discover Teams.

ii. Source tenant - name of the tenant where the statistics will be collected.
iii. Target tenant - name of the target tenant in this project.

iv. Scheduled start - date and time when the task will start. Now indicates that the task will start
immediately.

b. Click Back to revise or review a previous step or click Finish to complete the task wizard and start
the task as scheduled.

Discovering Teams from a file

When you have a large set of teams but you want to migrate a subset of those teams, you can start the discovery
process by using a CSV file. The CSV file lets you specify the teams that you want to discover and ignore the rest.
This is a two-step process:

Preparing the CSV file

1. Login to the Microsoft 365 admin center (https://admin.microsoft.com) with the credentials of your source
tenant administrator.

2. From the navigation pane, click Active groups.
3. Select Microsoft 365 tab in the Active Groups page

4. Setthe listfilter to Groups with Teams.
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5. Click Export and then click Export groups in this list. A Groups.csv file will be downloaded to your
computer.

i Microsoft 365 admin center P search

Starz Corp

Home

Active groups

(5]
R users ~
A Groups ~
| Active groups

Deleted groups

Shared mailboxes
Microsoft 365  Distribution list  Mail-enabled security

Fa FRoles

B Resources ~

| 2 eiting
@ Support v Group nan |
@ Settings v Contoso

& setwn Starz Events

Reports v

| ¥ Health

Starz Finance T Sunfinance@MIESI25423 comicrascfico

' Search all groups

Jitems ¥ Groups with Teams

6. Editthe CSV file and retain the Group ID and Group name columns. Then retain the teams you want to
discover and delete the rest. If you retain a row that references a group without a team, the group will be

ignored during discovery.
NOTE:

* You can download a CSV template when you start the New Teams Discovery Task wizard
and click Download Example File from the Discovery Options step.

« CSYV file names with non-ASCII characters are not supported.

Groups.csv ~ ,Q
File  Hom Inser Draw Page Form Data Revie View Help
B15 ~ 5
A B

1 |Group ID Group name
2 |Bced715c-c2c0-4091-a071-d764d 7fA0b04 Contoso
3 |3edabbbe-9302-4b9b-8bd5-a46dd48a%bbb  Starz Events
4 |c0af2B0a-91f7-3725-8477-adeb4776b80e Starz Finance
5
4]
7
8
]

Groups ) ‘ »
Ready H 0 - 1 +  100%

7. Save the CSV file. You may rename the file if needed.

Starting the Discover Teams Task

1. Log in to Quest On Demand and choose an organization if you have multiple organizations.

From the navigation pane, click Migrate > Projects to open the My Projects list.

2
3. Create a new project or open an existing project.
4

Click Teams from the project tiles, or click Open from the Teams tile to open the Teams dashboard.
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5. Click the Teams tab and select the List View if not already selected. Then click Discover Teams >
Discover From File from the Actions menu.

6. The New Teams Discovery Task wizard starts. Each step is described below:

7. Discovery Options

New Teams Discovery Task

I Discovery Options Select a comma-separated values (CSV) file that contains the list of Microsoft Teams to be discovered.

Notification Sample CSV File Dow i Exarnple File

Group ID,Group name
6fd73fd9-0113-400f-b164-f77a95586078, Contoso

Browse...

a. Click Browse and select the CSV that contains the Group IDs and Group names of the teams that
you want to discover.

b. Click Next.
8. Notification

a. Send notification email once the task is completed - select this option to send a notification
email when a discovery task completes.

+ Only in a case of failure - select this option to send the email if the discovery task fails to
complete successfully.

b. Recipients - enter the email address of the recipients of this email. You can specify multiple
recipient email addresses separated by semicolon.

c. Click Next.
9. Schedule

a. Choose from one of three options to schedule the task. The scheduler will be activated only after you
complete the task wizard.

* Run now - task runs immediately.
« Run later - task must be started manually.

« Schedule - task will be started at a future date and time entered in the corresponding
calendar field.

b. Click Next.
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10. Summary

a. Verify the task specifications as described below:

Name - name of the task. You can specify a custom name. The default name is
Discover Teams.

Source tenant - name of the tenant where the statistics will be collected.
Target tenant - name of the target tenant in this project.

Scheduled start - date and time when the task will start. Now indicates that the task will start
immediately.

b. Click Back to revise or review a previous step or click Finish to complete the task wizard and start
the task as scheduled.

Reviewing the Discover Teams Task

1. Open the Tasks tab.

2. Select the task that you want to review. The default name is Discover Teams.

3. Inthe task details pane that opens, the information presented is as described below:

Type - Type of the task. The type is di scoverteams.

a
b. Created - Date and time when the task was created.

Modified - Date and time when the task was last updated.

c
d. State - State of the task.

e. Last Operation - The action that was most recently performed in this task.

f. Schedule - Date and time when the task started. Now indicates that the task started immediately
after the task was created.

g. Events (number) - Number indicates the count of events that the task encountered. The values
indicate the type of the events and the event count for each type.

Reviewing the Discover Teams Task Events

1. Open the Tasks tab.

2. Select the task that you want to review.

3. Inthe task details pane that opens, click Events (number). The Events tab opens with a filtered list of events
for the selected task.

4. Select an event that you want to review. In the event details pane that opens, the information presented is as
described below:

Object - name of the team or group discovered.

a
b. Task - name of the task.

c. Time - date and time when the event occurred.

d. Category - type of task. the value is Application.

e. Source - name of the On Demand Migration service
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Migration » Starz Corp = Galaxy Corp » Teams

DASHBOARD TEAMS M365 GROUPS CHATS EVENTS TASKS

Severity : Info x J Current x

Any -

Task name : Discover Teams x JEGEZCIEE

Migration engine version 1.2.0.1545

Discovering teams}.

2 o 9 2 9 9 92

Task has been started (Started by user) - Discover Teams

= select Collection -

- a
Time v Description Object Name Task Name X
Today at 4:21 PM Discover completed. Oiscovered 3 team(s) in tota Discover Teams o Discovered team 'Starz Events'
0 Today at 4:21 PM Discovered team ‘Starz Events Starz Events Discover Teams
Today at 421 PM Discovered team ‘Contoss' Contoso Discover Teams L
Today at 4:21 PM Discovered team ‘Starz Finance Starz Finance Discover Teams

Application

Teams Migration

Managing Teams with Collections

Migrating large numbers of teams requires careful planing. The teams could belong to different offices and
geographical locations or sensitive departments. Migrating teams of Finance or Legal departments require special

care. Organize the teams into collections to make large team lists more manageable.
In this topic:

+ Adding Teams to Collections

« Working with the Collections Dashboard
Adding Teams to Collections

You can add teams to collections in several ways:

» Select the teams and add to a new collection
» Select the teams and add to an existing collection

¢ Use a CSV file to add teams to one or more collections

To add selected teams to a new collection:

1. From the project dashboard, click Open in the Teams tile to open the Teams dashboard.

2. Click the Teams tab and select List View if not already selected.

3. Select the teams you want to add to the collection.
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4. From the actions toolbar, click Collections > New Collection. The New Collection dialog opens.

x

New Collection

20 Objects have been selected to be added to the new collection.

Collection name APAC Sales

5. Enter a collection name in the Collection name field and click Save to add the selected teams to the
collection.

To add selected teams to an existing collection:

1. From the project dashboard, click Open in the Teams tile to open the Teams dashboard.
Click the Teams tab and select List View if not already selected.

Select the teams you want to add to an existing collection.

A 0D

From the actions toolbar, click Collections > Add To Collection. The Add to existing collection
dialog opens.

Add to existing collection

2 Objects have been selected to be added to the new collection.

Collection name v

5. Select a collection from the Collection name dropdown and click Save to add the selected teams to the
collection.

To add teams from a CSV file to a new or existing collection:
Using a CSV file provides the following additional benefits:
« Multiple collections can be created with the same CSV file.
« Existing collections can be specified in the CSV file to add additional teams.
« Public Folders can be listed in multiple collections.

This is a two-step process as described below to add teams to one or more collections:
Step 1: Prepare the CSV file

1. From the actions toolbar, click Collections > Import Collections. The New Import Collections from
File Task wizard starts.

2. From the Mapping File step, click Download Example File. A ZIP file is downloaded.
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3. Extract the CSV file and use it to prepare your import file in one of three formats described below:

i NOTE: CSV file names with non-ASCII characters are not supported. Teams in the CSV that
have not been discovered cannot be added to a collection.

Use the format shown below to prepare the CSV file. The minimal set of columns required are shown.

i TIP: You can export the selected teams to a CSV file and then add the Collection column
and retain the Source MailNickname column. All other columns in the exported CSV file will
be ignored so you can remove those columns if you want.

A B

1 |Collection Source MailMickname

2 |APAC StarzFinance

3 |APAC StarzEvents

4 |Marketing Events

5 [Sales Vendors

6 |Sales Sales

7 |HO Corporate

¢ Collection - Column header for the collection name. If a collection in the CSV does not exist,
a new collection will be created with the name specified in the CSV.

o Source MailNickname - Email alias of the M365 group of the team. You can get the Source
MailNickname property of the teams when you export teams to a CSV file. Source
MailNickname values are case-sensitive.

Step 2: Import the CSV file

1. Open the Teams tab.

2. From the actions toolbar, click Collections > Import Collections. The New Import Collections from
File Task wizard starts.

3. Mapping File
a. Click Browse and select the CSV file. The selected CSV file name appears.
4. Schedule

a. Choose from one of three options to schedule the task. The scheduler will be activated after
you complete the task wizard.

* Run now - task runs immediately.
« Run later - task must be started manually.

« Schedule - task will be started at a future date and time entered in the corresponding
calendar field.

b. Click Next.
5. Summary
a. Verify the task specifications as described below:

i. Name - name of the task. The default name is Import Collections From File. You
can specify a custom name.
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ii. Scheduled start - date and time when the task will start. Now indicates that the task
will start immediately.

b. Click Back to revise or review a previous step or click Finish to complete the task wizard and
start the task as scheduled.

c. Click Finish.

To verify the addition of the team to a collection:

1.

Check the Collections column in the Teams List View that indicates the most recent collection where the
team has been added and the number of additional collections that also contain the team.

Select a team from the Teams List View to open the Team Detail pane. Check the Collections property that
lists all the collections where the team has been added.

Working with the Collections Dashboard

The Collection Dashboard shows the collection-specific summary, allows you to see teams added to it, create tasks
for them, and monitor the progress of tasks.

To view the collection dashboard for an existing collection:

1.
2.

From the project dashboard, click Open in the Teams tile to open the Teams workspace.

From the top-right corner of the workspace, click Select Collection and then select the collection to view.
The collection Dashboard is displayed.

Open the Teams tab. You will see the list of teams that belong to the collection.

To remove items from a collection:

a.

b.

From the actions toolbar, click Collections > Remove from Collection.

In the confirmation dialog click Remove to remove the selected Teams from the collection.

To rename the collection:

a.

Click Collections > Rename Collection in the Actions toolbar of the collections dashboard.

To delete the collection:

a.

Click Collections > Delete Collection in the Actions toolbar of the collections dashboard.

To see the tasks for collection-specific teams:

a.

Open the Tasks tab.

To see the events related to the collection:

a.

Open the Events tab.

To return to the Teams migration workspace:

a.

Click the collection dropdown at the top-right corner of the page, and select Show All.
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Exporting Teams

To export teams to a comma-separated values (CSV) file:

1. Click Teams from your migration project

2. Click the Teams tab. From the Teams List View select the teams you want to export.
3. Fromthe Teams List View select More > Export.
4

Open the CSV file by extracting it from the ZIP file that is downloaded to your computer.
The exported data contain the following information:

o Team Name - source team name

« Workflow - (deprecated) the most recent operation performed on the team

+ Channel, Members, Messages, Plans, Tasks - counts of various content in the team.

» Size(MB) - size of all the content in the team.

« Last Activity - date and time of the last action performed on the team record.

« Created - date and time the team record was created

« Target Team Name - suggested target team name that will be provisioned in the target tenant

+ Source MailNickname - email alias of the associated Microsoft 365 Group. This value will be used for the
mail enabled object and will be used as PrimarySmtpAddress for this Microsoft 365 Group. The value must
be unique across your tenant.

« Last Operation Description - description of the last operation performed on this team.

Provisioning Teams

The provisioning task helps you with the following premigration preparations:

« Provision teams in the target tenant.

« Resolve naming conflicts.

Considerations

1. After all source teams are discovered you can begin provisioning teams on the target tenant with a Teams
Provisioning Task. Verify that all associated accounts are matched or migrated before you create the
provision task.

2. A Group Map task will be automatically created in the Accounts and User Data migration workspace of the
project. The purpose of this task is to match the team-related group accounts so that the On Demand
Migration for SharePoint service can use the mapping for membership migration.

3. Ifone or more new private channels or shared channels are added to a source team after provisioning, then
you must re-provision the team in the target tenant to ensure that the SharePoint content is discovered for
those new channels.
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4. When teams are provisioned, the account that is assigned the Migration Service role will be added to the
source teams, private channels and shared channels to prepare for migrating the channel settings to the
target tenant.

5. When teams are provisioned on the target tenant, a Discover SharePoint Contents Task is run
automatically. The task discovers the corresponding SharePoint site collection and its contents listed in the
SharePoint Contents tab.

6. When teams are provisioned on the target tenant, some scenarios like team renaming, multi-geo and others,
will automatically trigger one or more SharePoint mapping tasks.

7. Teams in the target tenant may take up to 24 hours to be fully provisioned by Microsoft.

Starting the provisioning task

1. Loginto Quest On Demand and choose an organization if you have multiple organizations.
2. From the navigation pane, click Migrate > Projects to open the My Projects list.

3. Create a new project or open an existing project.
4

Click Teams from the project tiles, or click Open from the Teams tile to open the Teams Migration
Workspace.

o

Select one or more teams from the Teams List View.
6. Click Provision. The New Teams Provisioning Task wizard starts. Each step is described below:

7. Provision Options

New Teams Provisioning Task

Provision Options If a team does not exist on target, it will be provisioned
. = a team with the s 2 5ts get:
Channel Filter If a team with the same name exists on target
. Provision a new team on the target with the original name plus suffix

Merge to the existing team on target

Provide a suffix for the display name of the new team

New team display name suffix Migrated

Tip: Use Map from file action to provision the new team with custom name, or to create a custom mapping.
Preferred location in target multi-geo tenant

teams location Default hd

Tip: Set the 'Default target geo location' property with the Configure Project action from the SharePoint dashboard.

Suppress Group Welcome Message

a. Choose from the following options if a team with the same name exists on target:

« Provision a new team on the target with the original name plus suffix - Select this
option to provision a new team on the target tenant by adding a suffix to the team name.

+ New team display name suffix - The default suffix is Migrated. You can specify
another suffix.

+ Merge to the existing team on target - Select this option to merge a team in the source
tenant with a team in the target tenant that has the same name. Then select an option ifa
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team channel with the same display name already exists in the target team:

« Provision a new channel on the target with the original name plus suffix -
Select this option to provision a new team channel on the target tenant by adding a
suffix to the channel name.

« New channel display name suffix - The default suffix is Migrated. You
can specify another suffix.

+ Merge source channel conversations with the Target channel - Select this
option if the target channel is empty.

Source Target Target
Team A
Channel 1 Channel 2 Channel 2
— Existing
Team A | Channel 2 + Team A | channel 3 — Channel 3 Target
Channels
Channel 3 Channel 4 Channel 4
Channel 1
: Migrated
Channel 2 - migrated Source
. Channels
Channel 3 - migrated

b. Preferred location in target multi-geo tenant - Leave the preferred data location as Default if the
target is a multi-geo tenant and you have already configured a default geo location for the target
tenant. All teams and groups will be migrated to the same region. To set up the default geo location,
see Configuring the Migration Project. If you change the default settings, please allow at least 5
minutes for the new settings to take effect. Alternatively, select the geo location configured for the

target tenant.

i TIP: To migrate teams to different regions, the best practice is to create a collection of teams
for each region (see Using Collections for Teams). Example collection names could be
"Migrate to EUR", "Migrate to JPN" or "Migrate to NAM". Then use the collection as a filter to

create the provision task.
For more information about multi-geo tenants, see Microsoft 365 Multi-Geo.

c. Suppress Group Welcome Message - Select this option to prevent spamming users with welcome
messages when Teams are provisioned on the target tenant.

= | NOTE: Suppressing these messages may result in performance degradation due to issues
with Microsoft’s synchronization behavior. We suggest you check the performance during the

pilot migration.
d. Click Next.

Channel Filter
With this filter, you can include or exclude specific channel types such as Private, or Shared. Standard

channels are always included.
a. Private - select this option to include private channels.
b. Shared - select this option to include shared channels.
c. Click Next.

Notification

a. Send notification email once the task is completed - select this option to send a notification
email when a provisioning task completes.
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« Only in a case of failure - Select this option to send the email if the provisioning task fails to
complete successfully.

b. Recipients - enter the email address of the recipients of this email. You can specify multiple
recipient email addresses separated by semicolon.

c. Click Next.
10. Step 4. Schedule

a. Choose from one of three options to schedule the task. The scheduler will be activated only after you
complete the task wizard.

* Run now - task runs immediately.
* Run later - task must be started manually.

+ Schedule - task will be started at a future date and time entered in the corresponding
calendar field.

b. Click Next.
11. Summary
a. Verify the task specifications as described below:

i. Name - name of the task. You can specify a custom name. The default name is
Provision Teams.

ii. Source tenant - name of the tenant in this project.

iii. Target tenant - name of the target tenant in this project.

iv. Scheduled start - date and time when the task will start. Now indicates that the task will start

immediately.

b. Click Back to revise or review a previous step or click Finish to complete the task wizard and start
the task as scheduled.

The provisioning task is created. You can track its progress from the Tasks tab, view the summary on the
Dashboard or monitor alerts and notifications from the Events tab.

Mapping Teams

You can rename and map teams, or rename, map and merge one or more source teams to a specific team in the
target tenant in two ways:

* Mapping and renaming teams from the Teams list

+ Mapping, renaming and merging teams from a file

Mapping and Renaming Teams from the Teams list

1. Login to Quest On Demand and choose an organization if you have set up multiple organizations.
2. From the navigation pane, click Migrate > Projects to open the My Projects list.

3. Create a new project or open an existing project.

4. Click Teams from the project tiles, or click Open from the Teams tile.

5. Gotothe Teams tab and select one or more teams from the Teams list that you want to rename and map.
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6. Click More > Rename and Map. The New Teams & Groups Rename and Map Task wizard starts. Each
step is described below:

7. Mapping options
a. Enterthe information as described below:
« Add prefix - specify a prefix for the team name. Whitespaces are not supported.
« Add suffix - specify a suffix for the team name. Whitespaces are not supported.
b. Click Next.
8. Notification

a. Send notification email once the task is completed - select this option to send a notification
email when a mapping task completes.

« Only in a case of failure - select this option to send the email if the mapping task fails to
complete successfully.

b. Recipients - enter the email address of the recipients of this email. You can specify multiple
recipient email addresses separated by semicolon.

c. Click Next.
9. Schedule

a. Choose from one of three options to schedule the task. The scheduler will be activated only after you
complete the task wizard.

* Run now - task runs immediately.
* Run later - task must be started manually.

+ Schedule - task will be started at a future date and time entered in the corresponding
calendar field.

b. Click Next.
10. Summary
a. Verify the task specifications as described below:

i. Name - name of the task. You can specify a custom name. The default name is Rename
and Map Task.

ii. Source tenant - name of the tenant in this project.
iii. Target tenant - name of the target tenant in this project.

iv. Scheduled start - date and time when the task will start. Now indicates that the task will start
immediately.

b. Click Back to revise or review a previous step or click Finish to complete the task wizard and start
the task as scheduled.

The task is created. You can track its progress from the Tasks tab, view the summary on the Dashboard or monitor
alerts and notifications from the Events tab.

Mapping, Renaming and Merging Teams from a File

To rename teams or merge one or more source teams to a specific team in the target tenant, a CSV file is used to
indicate the mapping between source and target teams, as described below.
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NOTE:

When teams are renamed and provisioned in the target tenant, Microsoft creates a default OneNote tab.
Since ODM migration service is not aware of this default tab, any OneNote content that is migrated will retain
the original name and will not appear in the default target OneNote tab of the renamed team.

There are two scenarios with OneNote migration when teams are merged:

a. When one or more teams are merged to a team with a different name in the target tenant, Microsoft
creates a default OneNote tab for the renamed target team. Since ODM migration service is not
aware of this default tab, any OneNote content that is migrated will retain the original name and will
not appear in the default target OneNote tab of the renamed team.

b. When one or more teams are merged to a team with a preexisting team in the target tenant, contents
in the OneNote tab in the target tenant is overwritten with the content from the source.

To create the mapping file:

1. Prepare a comma-separated values (CSV) file with the source and target team names.
i TIP:
« Export selected teams to a comma-separated values (CSV) and then edit this file. See
Exporting Teams for more details.

« You can download a CSV template when you start the New Mapping from File Task wizard
and click Download Example File from the Mapping File step.

« CSV file names with non-ASCII characters are not supported.

2. The header row defines the names of the source and target attributes used for mapping. Subsequent rows
list the mapping values of the attributes.
The columns are as follows:

« Source Mailnickname - unique name of the source team. The following column header variations
are supported: SourceMailNickname, Source MailNickname, Source MailNickName. The
column header is case sensitive.

o Target Mailnickname - unique name of the target team. The following column header variations are
supported: TargetMailNickname, Target MailNickname, Target MailNickName. The
column header is case sensitive. You can merge multiple source teams to a single target team when
you specify the same Target Mailnickname in a mapping file.

« Target Team Name - display name of the target team. The column header is case sensitive. If two
or more records have the same Target Mailnickname then the Target Team Name for each record
must be specified and must be the same.

A B 2

1 |Sowurce Mailnickname Target Mailnickname Target Team Name

2 |Corporate CompanyMNews Company News Example 1
3 |StarMarketing GalaxyMarketing Galaxy Marketing Example 2
4 |StarEvents GalaxyEvents Galaxy Marketing

5 |TeamSales GalaxySales Galaxy Sales Team

& |Globalsales GalaxySales Galaxy Sales Team Example 3
7 |SalesMembers GalaxySales Galaxy Sales Team
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Example 1: Row 2: Simple change of name

The name properties of the source team will change to the Target Mailnickname and Target Team Name
respectively.

Example 2: Rows 3 and 4: Different target teams with the same display name

The Target Mailnicknames are different but the Target Team Names are the same. The Target
Mailnickname takes precedence and the teams will be mapped to distinct Target Mailnicknames but the
display name of each target team will be the same. It is recommended that you use unique display names to
avoid confusion.

Example 3: Rows 5, 6 and 7: Merge multiple source teams with the same target team

The Target Mailnickname is the same. The teams will be merged with the same target team with the
specified display name.

3. Save the CSV file. You may rename the file if needed.

To upload the mapping file:

1. Log in to Quest On Demand and choose an organization if you have multiple organizations.

From the navigation pane, click Migrate > Projects to open the My Projects list.

Create a new project or open an existing project.

Click Teams from the project tiles, or click Open from the Teams tile to open the Teams dashboard.

Click the Teams tab.

o o A w DN

Click More > Map from File. The New Mapping from File Task wizard starts. Each step is described below:

x

New Mapping from File Task

Target Group Name |
o MapFromFileGroug

7. Mapping file

a. Click Browse and select the CSV mapping file. The selected file name appears next to the
Browse button.

b. Click Next.
8. Notification

a. Send notification email once the task is completed - select this option to send a notification
email when a mapping task completes.
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« Only in a case of failure - select this option to send the email if the mapping task fails to
complete successfully.

b. Recipients - enter the email address of the recipients of this email. You can specify multiple
recipient email addresses separated by semicolon.

c. Click Next.
9. Schedule

a. Choose from one of three options to schedule the task. The scheduler will be activated only after you
complete the task wizard.

* Run now - task runs immediately.
* Run later - task must be started manually.

+ Schedule - task will be started at a future date and time entered in the corresponding
calendar field.

b. Click Next.
10. Summary
a. Verify the task specifications as described below:
i. Name - name of the task. You can specify a custom name.
ii. Source tenant - name of the tenant in this project.
iii. Target tenant - name of the target tenant in this project.

iv. Scheduled start - date and time when the task will start. Now indicates that the task will start
immediately.

b. Click Back to revise or review a previous step or click Finish to complete the task wizard and start
the task as scheduled.

The task is created. You can track its progress from the Tasks tab, view the summary on the Dashboard or monitor
alerts and notifications from the Events tab.

Removing Teams

To manage large lists of teams in a project, you can remove one or more teams from the teams list view that you
don't need for migration. The teams that are removed will remain in the source tenant and you must re-discover the
teams in the project when you need them for migration.

When teams are removed, all associated items, mappings and migration information will also be removed from the
project. When these teams are rediscovered, they will be treated as new teams in the project and the process of
provisioning and migration of the teams and related items must be repeated.

1. Log in to Quest On Demand and choose an organization if you have multiple organizations.
2. From the navigation pane, click Migrate > Projects to open the My Projects list.

3. Create a new project or open an existing project.

4. Click the Teams tile, or click Open from the Teams tile to open the Teams dashboard.

5

Select the Teams tab and select List View if not already selected.
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6. Select the teams you want to remove.
i TIP: Use filters, search or collections to quickly navigate through the list of teams.
7. Click More > Delete. The New Remove Team Mappings Task wizard starts.
8. Description
a. Click Next.
9. Notification

a. Send notification email once the task is completed - select this option to send a notification
email when a discovery task completes.

« Only in a case of failure - select this option to send the email if the discovery task fails to
complete successfully.

b. Recipients - enter the email address of the recipients of this email. You can specify multiple
recipient email addresses separated by semicolon.

c. Click Next.
10. Schedule

a. Choose from one of three options to schedule the task. The scheduler will be activated only after you
complete the task wizard.

* Run now - task runs immediately.
* Run later - task must be started manually.

« Schedule - task will be started at a future date and time entered in the corresponding
calendar field.

b. Click Next.
11. Summary
a. Verify the task specifications as described below:

i. Name - name of the task. You can specify a custom name. The default name is
Remove Teams.

ii. Source tenant - name of the source tenant in this project
iii. Target tenant - name of the target tenant in this project.

iv. Scheduled start - date and time when the task will start. Now indicates that the task will start
immediately.

b. Click Back to revise or review a previous step or click Finish to complete the task wizard and start
the task as scheduled.

Collecting Statistics

The Collect Team Statistics Task for Teams conducts an assessment of all teams in the source tenant and
matching teams in the target tenant. It provides information like member count, content size (in GB), planner count
and planner task count for the teams in the source tenant, and optionally in target tenant if the team is already
provisioned.

Each Collect Team Statistics Task generates events. Events are milestones that a task achieves as it runs. For
example, when a Collect Team Statistics Task starts, an event is logged and it appears in the events list. When
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the number of teams that are selected for assessment is large, the Collect Team Statistics Task divides the total
number of teams into manageable sets. Each set is called a batch. When a batch of accounts is assessed, another
event occurs.

In this topic:

Starting a Collect Team Statistics Task
Reviewing the Collect Team Statistics Task
Reviewing the statistics collected

Reviewing the events for the Collect Team Statistics Task

Starting a Collect Team Statistics Task

1.

o o A~ w0 DN

9.

Log in to Quest On Demand and choose an organization if you have multiple organizations.
From the navigation pane, click Migrate > Projects to open the My Projects list.

Create a new project or open an existing project.

Click the Teams tile, or click Open from the Teams tile to open the Teams workspace.
Select the Teams tab and then select List View if not already selected.

Select the teams in the list from where you want to collect statistics. You can use search, filtering or
collections to quickly navigate through the list of mailboxes. You can select the check box in the table header
to select all the accounts.

Click Collect Statisticsfrom the Actions ribbon. The New Collect Statistics Task wizard starts. Each step is
described below:

Collect Statistics Options
a. Choose from the following options

+ Include collection of statistics from target tenant - select this option to include the same
teams from the target tenant and generate the Comparison Report. Statistics will be
collected for the target tenant teams only if a provision task was previously run for the teams.

¢ Collection levels:

« Basic (Fast) - collect statistics about member count and content size (in GB) for the
teams selected in the source and target tenant if provisioned.

« Advanced (Slow) - collect statistics about member count and content size (in GB),
planner count and planner task count for the teams selected in the source and target
tenant if provisioned. The task requires more time to run.

b. Click Next
Notification

a. Send notification email once the task is completed - select this option to send a notification
email when a discovery task completes.

+ Only in a case of failure - Select this option to send the email if the discovery task fails to
complete successfully.

b. Recipients - enter the email address of the recipients of this email. You can specify multiple
recipient email addresses separated by semicolon.

c. Click Next.
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10. Step 3:Schedule

a. Choose from one of three options to schedule the task. The scheduler will be activated only after you
complete the task wizard.

* Run now - task runs immediately.
* Run later - task must be started manually.

« Schedule - task will be started at a future date and time entered in the corresponding
calendar field.

b. Click Next.
11. Summary
a. Verify the task specifications as described below:

i. Name - name of the task. You can specify a custom name. Default name is Collect Team
Statistics Task.

ii. Source tenant - name of the tenant where the statistics will be collected.
iii. Target tenant - name of the target tenant in this project.

iv. Scheduled start - date and time when the task will start. Now indicates that the task will start
immediately.

b. Click Back to revise or review a previous step or click Finish to complete the task wizard and start
the task as scheduled.

12. Review the statistics collected
a. Open the Teams workspace.
b. Selectthe Teams tab and then select List View if not already selected.

c. Review the statistics collected for each team. The statistics displayed depends on the option
selected in the New Collect Team Statistics Task wizard.

Reviewing the Collect Team Statistics Task

1. Open the Tasks tab.
2. Select the Collect Statistics task for teams that you want to review.
3. Inthe task details pane that opens, the information presented is as described below:
a. Type - Type of the task. The typeis collectstatistics.
b. Created - Date and time when the task was created.
c. Modified - Date and time when the task was last updated.
d. Status - State of the task.
e. Last Operation - The action that was most recently performed in this task.

f. Schedule - Date and time when the task started. Now indicates that the task started immediately
after the task was created.

g. Events (number) - The number of events that the task encountered.

From the task details pane, click Download Premigration Report. Download and save the ZIP file
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to a suitable folder, and extract the report.

X

o Collect Team Statistics Task

collectstatistics

Created Monday, October 30, 2023 10:58 AM

Modified Monc October 3

Completed

Last Operation Statistics collected for 1 team(s) and grou

pls)
Schedule Now

‘ Copy Diagnostics

| Download Premigration Report

NOTE: Premigration reports are also available from the following tasks:

« DiscoverAll
« Discover From File

¢ Provision

Reviewing the events for the Collect Team Statistics Task

1.
2.
3.

Open the Tasks tab.
Select a Collect Statistics task for teams that you want to review.

In the task details pane that opens, click Events (number). The Events tab opens with a filtered list of events
for the selected task.

Select an event that you want to review. In the task details pane that opens, the information presented is as
described below:

a. Object - name of the team if applicable.
b. Task - name of the task.

c. Time - date and time when the event occurred.

d. Category - type of task. the value is Application.

e. Source - the workspace from where the event was generated. The value is Teams Migration.
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& EDIT COLUMNS sevents Q

Time v Description Object Name Task Name X

o Collect Statistics completed.
Statistics collected for 1

team(s)/group(s)

Today at 1:26 PM Collect Statistics completed. Statistics collected for 1 teams)/groupis)

Today at 1:26 PM ered team ‘Communications’ Communications

Today at 1:26 PM n engine version 1.2.0.7074

Todsy 3t 1:26 PM Starting Collect Statistics
Task Collect Statistics

e @ 9o e @9

Today 3t 125 PM Task has been started (Started by user)
me Wednesday, May 24, 2023 1:26 PM

Application

Teams Migration

Premigration Assessment for Teams

On Demand Migration analyzes your environment and tracks potential problems, misconfiguration, and risks that
might adversely affect the migration. Use Assessment view to see the summary reports on the discovered data and
use the automatic filters to quickly select certain items.

The following reports are available for Teams:

+ Workflow - (deprecated) Teams sorted by completed workflow
« Discovered
» Processed
» Migrated

+ Teams- Teams sorted by processing status
o Idle
« Inprogress
* Needs your attention

+ Teams By Size

+ Teams By Last Activity Time

+ Teams By Channel Count

¢ Teams By Member Count

Once you handle the issues, if any, go to List View screen. You are ready to start the migration.

Migrating Teams

When you migrate teams, files stored in the corresponding SharePoint document libraries and OneNote items
stored in asset libraries can be migrated. The SharePoint sites associated with teams may contain additional
objects that cannot be migrated with the On Demand Migration for Teams service.
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Considerations

1.

Channels are dedicated sections within a team to keep conversations organized. Channel membership can
be Standard, Private or Shared.

When teams are migrated, the account that is assigned the Migration Service role is added to the team. If
dynamic membership is enabled, the rules are modified to include this account. This temporary role is
required for migrating teams by the On Demand Migration for Teams service.

Teams in the target tenant may take up to 24 hours to be fully provisioned by Microsoft after they are created
during a Teams provisioning task. We recommend that you migrate only those teams which are provisioned
at least 24 hours before they are migrated.

When teams are migrated, the SharePoint Contents list is updated, and the Migration state of the objects is
changed to Migrated. You can review the list and use the On Demand Migration for SharePoint service to
migrate additional SharePoint objects.

When a team with same name already exists in the target tenant and the merge option is selected for
migration, contents of the note in the target tenant is overwritten with the contents from the source.

In this topic:

Configuring the project for migrating teams

o Starting a Migrate Teams Task

Configuring the project

1.

2
3.
4.
5

7.

Log in to Quest On Demand and choose an organization if you have set up multiple organizations.
From the navigation pane, click Migrate > Projects to open the My Projects list.
Create a new project or open an existing project.

Click Teams from the project tiles, or click Open from the Teams tile to open the Teams dashboard.

Click Configure Project from the dashboard menu. The Edit Project wizard starts. Each step is
described below:

Project Settings

a. Set Migration Defaults
Default Target User - Specify a user principal name (UPN) to use as the team owner when the
existing owner has no match in the target tenant.

b. Teams Migration Option
Skip private channels during provisioning and migration - select this option to prevent the
provisioning of and migration of private channels. However, if private channels are already
provisioned, this setting will be ignored and private channel content will be migrated.

Click Finish.

Starting a Migrate Teams Task

1.

2
3.
4

Log in to Quest On Demand and choose an organization if you have multiple organizations.
From the navigation pane, click Migrate > Projects to open the My Projects list.
Create a new project or open an existing project.

Click Teams from the project tiles, or click Open from the Teams tile to open the Teams dashboard.
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5. Select one or more teams from the Teams List View.

i TIP:1t is recommended to select no more than 100 teams for the task to streamline the process. You
can create several tasks that will be executed concurrently. Use search and filteringto quickly
navigate through the list of teams.

6. Click Migrate. The New Teams Migration Task wizard starts. Each step is described below:
7. Start
a. Task Name - You can specify a custom name. The default name is Migrate Teams.

b. Use the settings from an existing migration template for this task - select this option if you
have already saved a previous migration templates. if this is the first time you are migrating
mailboxes, keep this option unchecked.

« Select template - select a template that you previously created, from the dropdown list.

c. Go to Summary step - select this option to preserve the settings and go directly to the last step of
the wizard. If you do not select this option, but you have selected a template, you can step through
the wizard and edit the settings in the template.

d. Click Next.
8. Migration Options

New Teams Migration Task

File Version Options

a. Choose from the following options:

+ Channel Posts(Messages) - select this option to migrate the posts or messagesin a
channel.

« Archive - select this option to migrate and archive channel messages as an HTML
file for each channel. The HTML file is added to the file list of the team's SharePoint
site in the target tenant. A new message from the target tenant Administrator is
added to each migrated channel with a link to its HTML file. A new tab called
Conversation History is created in the target channel and the archived messages are
displayed there.

« All messages - migrate and archive all messages across all
channels in the team
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+ Messages older than 15 days - migrate and archive messages across all
channels in the team that are older than 15 days.

+ Messages older than 30 days- migrate and archive messages across all
channels in the team that are older than 30 days.

+ Messages older than 60 days - migrate and archive messages across all
channels in the team that are older than 60 days.

NOTE:

Messages that are more recent than the 15, 30 or 60 days option that is
selected will be migrated but not archived.

Links to files that are not yet migrated to the target will not work. remigrate
Teams using Channel Files to ensure the links work correctly. To learn more,
see remigrating messages and files.

If the migration task is successful and the archive HTML file is created in the
target tenant, it cannot be modified by subsequent migrations. If you attempt
another migration and select the Archive option, the Archive option is
ignored. All new and modified channel messages from the selected teams will
be migrated and posted to the corresponding team channels in the target
tenant. Messages already archived will be skipped unless they were
subsequently modified (edited or linked to replies or attachments) in the
source tenant.

If the migration task is unsuccessful and the archive file is not created,
subsequent migrations with the Archive option selected will attempt to create
an archive HTML file in the target tenant. Archive sub-options like All,
Messages older than 15 days, Messages older than 30 days or
Messages older than 60 days, are re-evaluated for all messages in the
channel. The new set of messages selected for archival may not be the same
set of messages identified in the previous archive attempt.

+ Migrate Bot Messages - select this option to migrate bot messages.

« SharePoint Content - select this option to migrate SharePoint content linked to teams
selected for migration.

« Standard (Channel files only) - select this option to migrate files, OneNote, Word,
Excel and PowerPoint tabs added to the channel.

« Standard and Customized (All SharePoint Content) - select this option to
migrate OneNote, Word, Excel, PowerPoint and List tabs added to the channel, and
site collections which includes any customized content such as descendant
websites and lists.

« Include site level term group for site migration - select this option to add site level
metadata to the target Global Term Store. The Global Term Store must be migrated
before you can use this option, otherwise an error will be logged as an event. For
more information, see Migrating the Global Term Store.
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NOTE: For better performance and accountability the Get Total File Size task is
automatically scheduled to run 24 hours after the migration task completes.

For each team that is being migrated, the task calculates the total size of files across
all channels of the team from the source and the target tenants. These totals are
displayed in the Teams List view.

If you manually start the task before 24 hours of the migration task, you may not get
accurate results. The task retains its original schedule and runs 24 hours after the
migration task completes.

o Planner - select this option to migrate the Planner buckets, tasks, comments and the
corresponding Planner tabs in teams.

+ Group Mailbox - select this option to migrate the Microsoft 365 Group mailbox.

« Team Membership - select this option to migrate team members. If this option is not
selected, team members will not be migrated. If the team member or owner was not matched
or migrated by an account migration task, a warning is reported: Cannot add *** as group ***:
User Mapping does not exist. Workaround: Match or migrate the account and then re-run the
task with this option selected.

b. Click Next.

9. File Version Options

New Teams Migration Task

Step3 of 11

a. Choose the migration option for file versions associated with teams selected for migration.

o Latest version only - select this option to migrate the most recent version of the file. All
other versions will be ignored. This is the default selection.

+ More versions - select this option to migrate additional versions of a file based on the
options described below. Large version sets take a significantly long time to migrate.

+ Number of versions - maximum number of version to migrate. The available
choices are: 2, 5, 10, 30, 60, 90 and 365. When you specify the number of versions,
additional options can be selected.

« Latest version and preceding versions - version count includes the latest
version and the preceding versions in chronological order restricted to the
Size Limit of the latest version. For example, if you choose to migrate 5
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versions, then the most recent version and 4 preceding versions will be
migrated as long as the most recent version does not exceed the selected
size limit specified.

o Latest version and daily latest from preceding days - version count
includes the latest version and the latest version from each preceding day
restricted to the Size Limit of the latest version. For example, if there are
many versions of a site and you choose to migrate 5 versions, then the most
recent version and the latest version from each of the 4 preceding days will be
migrated as long as the most recent version does not exceed the selected
size limit specified.

« Size limit - this setting is available if the Latest version and preceding
versions or the Latest version and daily latest from preceding days
option is selected. By default, the size limit is 80 MB. You can configure the
size limitation by selecting from one of the possible values in the dropdown
list. If the size of the latest file version exceeds the selected size limit, the
latest version will be migrated and previous versions will be ignored. If the
size of the latest file version does not exceed the selected size limit, then the
file and its versions will be migrated based on your selection between Latest
version and preceding versions or Latest version and daily latest from
preceding days.

« All Versions - select this option to migrate the latest version of the file, and all previous
versions if the latest version does not exceed a specified size limit. This option requires
significantly more time to migrate all the versions.

« Size limit - this setting is available if the All Versions option is selected. By default,
the size limit is 80 MB. You can configure the size limitation by selecting from one of
the possible values in the dropdown list. If the size of the latest file version exceeds
the selected size limit, the latest version will be migrated and previous versions will
be ignored. If the size of the latest site version does not exceed the selected size
limit, then the file and its versions will be migrated.

b. Click Next.

10. SharePoint Permission Options

New Teams Migration Task

SharePoint File Optio.

On Demand Migration User Guide

Microsoft Teams Migration 233



a. Select how Sharing Links permissions are migrated. Direct permissions are always migrated.

« Migrate permissions - select this option so that unique permissions associated with web,
list and list items are migrated. If you clear this option all other options in this step are
deactivated and permission migration is prevented. When permissions are not migrated, the
permissions for new migrations of web, list and list items, that are not already on the target
tenant, will be inherited from its parent. The permissions will not be changed for migrations of
content that was already migrated to the target tenant.

+ Migrate permissions only for previously migrated webs and lists - select this option to
migrate permissions for webs and lists only. Permissions will be merged with any existing
permissions on the target tenant. List item permissions are not migrated with this option
because list item permissions cannot be migrated separately from the list item. To re-migrate
list items and its permissions, re-migrate the whole list without selecting this option. Selected
objects must be in a migrated or migrated with issues state for this option work.

« Do not migrate Sharing Links permissions - select this option to ignore Sharing Links
permissions.

« Migrate Sharing Links permissions as direct permissions. - select this option to
migrate Sharing Links permissions. These permissions will be migrated as direct
permissions. The conversion and migration of Sharing Links permissions takes more time
to migrate. Migration is slower.

b. Click Next.
11. SharePoint File Options

New Teams Migration Task

Start
Migration Options

File Version Options

SharePoint Permissio
[I SharePoint File Optio.

Sensitivity Labels

a. Choose from the following options to determine how changes to list items that were previously
migrated should be remigrated:

« Refresh list items - an incremental migration is performed to repair and update the target
list with missing or new items.

« Migrate all list items - all list items are remigrated.
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b. Choose a conflict resolution option.

i NOTE:
« Conflict resolution rules are applied only to list items that have been previously
migrated.

« Conflict resolution rules will not be applied if the Migrate all list items option is
selected in the previous step. All files in the target tenant will be overwritten if all files
are migrated.

« Conflict resolution rules will not be applied to Site Pages and Site Assets system
libraries.

« Overwrite target files - all migrated files in the target tenant will be overwritten. Migration is
fastest with this option selected. For default Notebooks, target channel Notes will be
overwritten if the source and target teams and channels have the same name.

« Skip if target list item is the same version or newer - ignore listitems in the target tenant
with the same or newer version. If the item does not exist in the target tenant, a copy of the
source item will be migrated. For default Notebooks, target channel Notes will be preserved
even if the source and target teams and channels have the same name.

+ Create a copy if target list item is the same version or newer - preserve the listitem in
the target tenant with the same or newer version and migrate a copy of the source item.
When you choose this option, you must choose from one of the following file suffix options: _
Copy, _Source, _Older, _Backup, and _1. For default Notebooks, target channel Notes will
be preserved and no copies are created even if the source and target teams and channels
have the same name.

c. Migrate list and library comments - select this option to include list and library comments in the
migration task. A large number of list and library comments increase task processing time.

d. Auto re-run list item migrations to retry missing items - select this option to automatically re-run
the list item migration during list migrations to retry and repair missing items.

e. Migrate Enterprise Keyword column values - select this option to migrate Enterprise Keywords.
The Global Term store must be migrated using the SharePoint migration service. In the context of
SharePoint or Microsoft 365, enterprise keywords are terms that are part of the Term Store, which is
a centralized repository used to manage metadata (or tags) for content within the organization.

f. Click Next.

12. Sensitivity Labels
Choose how you want to migrate sensitivity labels applied to associated SharePoint content. Sensitivity
labels require specific tenant permissions. They must be discovered and matched before you can use the
following options. For more details, see the topic Sensitivity Labels.

a. Process document sensitivity labels - select this checkbox to enable sensitivity label processing
if you have already configured and matched sensitivity labels.

Encrypted documents may be inaccessible on the target tenant if
sensitivity labels that are applied to documents in the source tenant are not
processed. If a document is encrypted in the source, then it is decrypted, labels are
processed and the document is reencrypted in the target.

« Match and apply corresponding labels to documents migrated to the target - select
this option to match and apply sensitivity labels during migration. If the label in the source
document has a matching label in the target (there is a corresponding target label in the On
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Demand repository), the source label is replaced by the target label. If the label in the source
document has no matching label in the target (there is no corresponding target label in the
On Demand repository), the document is not migrated.

+ Remove sensitivity labels from documents migrated to the target - select this option
to clear the labels from migrated documents. Labels on documents in the source tenant are
not changed.

b. Click Next.
13. Archiving Options

New Teams Migration Task

n Options

on Options

nt Permissio.
SharePoint File Optio...

Sensi

ty Labels
” Archiving Options

Notification

NOTE: If you archive the source team without using On Demand Migration (e.g., by using Microsoft
tools), then you can migrate the source team and archive the target team. If you archive the source
team using On Demand Migration then you can migrate the target team but you cannot archive the
target team.

a. Archive the source team after migration - select this option to archive the source team after
migration. If you select this option you cannot archive the target team.

« Make source SharePoint site read only - this option is available if option (a) is selected.
Select this option to set the associated SharePoint site to read only for the team members.

b. Archive target team if source team is archived - select this option to archive the target team after
migration. Archived teams cannot be updated or remigrated. This option is not available if option (a)
is selected.

« Make target SharePoint site read only - this option available if option (b) is selected.
Select this option to set the associated SharePoint site to read only for the team members.

c. Click Next.
14. Notification

a. Send notification email once the task is completed - select this option to send a notification
email when a migration task completes.

« Only in a case of failure - select this option to send the email if the migration task fails to
complete successfully.

b. Recipients - enter the email address of the recipients of this email. You can specify multiple
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recipient email addresses separated by semicolon.

c. Click Next.

15. Reporting

Select the check box Generate detailed report of migration errors to generate a migration error report
when you run the migration task.

You can download the report from the Reports tab of the Teams workspace by clicking the Download link in
the Error Log column. If there are no migration errors, a download link is not available. Error reports are
retained for 30 days. After 30 days the download link is replaced with the label Expired and you can no
longer download the report. For more information about error reports, see Reports.

16. Schedule

a. Choose from one of three options to schedule the task. The scheduler will be activated only after you
complete the task wizard.

Run now - task runs immediately.
Run later - task must be started manually.

Schedule - task will be started at a future date and time entered in the corresponding
calendar field.

Priority - select a priority from the dropdown for the objects scheduled for migration with this
task . Values are: Highest, High, Medium, Low and Lowest. The default priority is Medium.
If the system is busy, the objects are queued (Migration state = Queued). When the system
accepts new migration work, objects are taken from the queue based on the assigned priority
and age in the queue.

b. Click Next.

17. Summary

a. Save task settings as a migration template - select this option to save the settings in this wizard
as a reusable migration template.

Migration Template Name - specify a name for the template. If you have changed the
settings of a preselected template, specify the same template name to apply the changes to
the template when you complete the wizard. All saved templates are displayed in the
Templates tab.

b. Verify the task specifications as described below:

Name - name of the task. You can specify a custom name. The default name is
Migrate Teams.

Source tenant - name of the tenant in this project.
Target tenant - name of the target tenant in this project.

Scheduled start - date and time when the task will start. Now indicates that the task will start
immediately.

Priority - select a priority from the dropdown for the objects scheduled for migration with this
task . Values are: Highest, High, Medium, Low and Lowest. The default priority is Medium.
If the system is busy, the teams are queued (Migration state = Queued). When the system
accepts new migration work, teams are taken from the queue based on the assigned priority
and age in the queue.

c. Click Back to revise or review a previous step or click Finish to complete the task wizard and start
the task as scheduled.
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The migration task is created. You can track its progress from the Tasks tab, view the summary on the Dashboard
or monitor alerts and notifications from the Events tab.

i IMPORTANT: The task state in the task list indicates the progress of this task. Completed state means this
task processing is completed. If the migration has any errors, the status column in the Teams List View will
indicate Migration partially failed.

Remigration

To remigrate messages, planner tasks and files, start a new teams migration task and follow the steps outlined in
Migrating Microsoft Teams. Select whether to migrate messages with attachments from the various options.

L] .
i NOTE:
« Do not reuse a previous migration task because the task options you need may be different.
+ See What We Migrate to review the Teams objects that are supported.
« Anincremental query is used automatically to find messages, tasks and files that were added or
changed.
« The initial synchronization must have completed successfully for the incremental synchronization to
succeed.
« Perform a remigration before you switch from the source to the target tenant.
« Do not delete teams in the target tenant after migration.
« Content that is updated or deleted in the source tenant cannot be synchronized with the target tenant
during remigration. Here are some examples
+ A migrated message get deleted in the source. During remigration, the corresponding
migrated message in the target will not be deleted.
+ A migrated message get updated in the source. During remigration, the corresponding
migrated message in the target will not be updated.
« A migrated Planner task's status gets updated in the source. During remigration, the
corresponding Planner task's status in the target will not be updated.
Messages

Messages that were previously migrated successfully will not be remigrated. Messages are remigrated as follows:

« New messages that are added since the last synchronization will be migrated.

+ Messages that were partially migrated, for example the attachment was unavailable during a previous
migration, will be migrated. Updates to these messages by users in the target tenant will not be overwitten.

Planner Tasks

Planner Tasks in the target tenant that are created or updated will not be impacted. Planner Tasks from the source
tenant will be remigrated as follows:
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« Previously migrated Planner Tasks that are updated on the source tenant will not be migrated to the
target tenant.

« New Planner Tasks will be migrated to the target tenant.

Files

Previously migrated list items and files with the same name and ID will be remigrated from the source
tenant as follows:

« Updates on source will be migrated to the target.
» Updates to target will be overwritten by the remigrated source items or files.
When Teams files are remigrated an incremental query retrieves files that have been added or changed in the

channels since the last synchronization. Follow the steps outlined in Migrating Microsoft Teams and select Migrate
messages and files.
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Renaming and Mapping Teams and
Groups

You can rename and map teams and M365 groups, or rename, map and merge one or more source teams (or M365
group) to a specific team (or M365 group) in the target tenant in two ways:

+ Renaming and mapping teams and groups automatically

« Renaming and mapping teams and groups manually from a file

Renaming and Mapping Teams and Groups automatically

1. Loginto Quest On Demand and choose an organization if you have set up multiple organizations.
2. From the navigation pane, click Migrate > Projects to open the My Projects list.

3. Create a new project or open an existing project.

4. Click Teams from the project tiles, or click Open from the Teams tile to open the Teams dashboard.
5

Click the Teams tab or the M365 Groups tab and select one or more teams or groups that you want to
rename and map.

6. Click More and then click Rename and Map. The New Teams & Groups Rename and Map Task wizard
starts. Each step is described below:

7. Mapping options
a. Enterthe information as described below:
» Add prefix - specify a prefix for the team or group name. Whitespaces are not supported.
« Add suffix - specify a suffix for the team or group name. Whitespaces are not supported.
b. Rename mail nick name - select this option to add a prefix or suffix to the target team or group.
c. Click Next.
8. Notification

a. Send notification email once the task is completed - select this option to send a notification
email when a mapping task completes.

« Only in a case of failure - select this option to send the email if the mapping task fails to
complete successfully.

b. Recipients - enter the email address of the recipients of this email. You can specify multiple
recipient email addresses separated by semicolon.

c. Click Next.
9. Schedule

a. Choose from one of three options to schedule the task. The scheduler will be activated only after you
complete the task wizard.

* Run now - task runs immediately.
* Run later - task must be started manually.

o Schedule - task will be started at a future date and time entered in the corresponding
calendar field.
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b. Click Next.
10. Summary
a. Verify the task specifications as described below:

i. Name - name of the task. You can specify a custom name. The default name is Rename
and Map Task.

ii. Source tenant - name of the tenant in this project.
iii. Target tenant - name of the target tenant in this project.

iv. Scheduled start - date and time when the task will start. Now indicates that the task will start
immediately.

b. Click Back to revise or review a previous step or click Finish to complete the task wizard and start
the task as scheduled.

The task is created. You can track its progress from the Tasks tab, view the summary on the Dashboard or monitor
alerts and notifications from the Events tab.

Mapping, Renaming and Merging Manually from a File

To rename Microsoft 365 groups or merge one or more source groups to a specific group in the target tenant, a CSV
file is used to indicate the mapping between source and target groups as described below.

To creating a mapping file:

1. Prepare a comma-separated values (CSV) file with the source and target group names.

i TIP: Export selected groups to a comma-separated values (CSV) and then edit this file. See
Exporting Groups for more details.

2. The header row defines the names of the source and target attribute used for mapping. Subsequent rows list
the mapping values of the attributes.
The columns are as follows:

« Source Mailnickname - unique name of the source group. The following column header variations
are supported: SourceMailNickname, Source MailNickname, Source MailNickName. The
column header is case sensitive.

« Target Mailnickname - unique name of the target group. The following column header variations
are supported: TargetMailNickname, Target MailNickname, Target MailNickName. The
column header is case sensitive. You can merge multiple source groups to a single target group
when you specify the same Target Mailnickname in a mapping file.

« Target Group Name - display name of the target group. The column header is case sensitive.
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3.

A B C

1 |Source Mailnickname Target Mailnickname Target Group Name |

2 |Corporate CompanyMNews Company News Example 1
3 |StarMarketing GalaxyMarketing Galaxy Marketing Example 2
4 |StarEvents GalaxyEvents Galaxy Marketing

5 TeamS5ales GalaxySales Galaxy Sales Group

& |Globalsales GalaxySales Galaxy Sales Group Example 3
7 |SalesMembers GalaxySales Galaxy Sales Group

Example 1: Row 2: Simple change of name.
The source group display name and mailnickname are changed.
Example 2: Rows 3 and 4: Different target groups with the same display name.

The Target Mailnicknames are different but the Target Group Names are the same. The Target
Mailnickname takes precedence and the groups will be mapped to distinct target groups but the display
name of each target group will be the same. It is recommended that you use unique display names to
avoid confusion.

Example 3: Rows 5, 6 and 7: Merge multiple source groups with the same target group.

The Target Mailnickname is the same. The source groups will be merged with the same target group with
the specified display name.

Save the CSV file.

NOTE: File names with non-ASCII characters are not supported.

To upload a mapping file:

N o o k& w0 N

Log in to Quest On Demand and choose an organization if you have multiple organizations.

From the navigation pane, click Migrate > Projects to open the My Projects list.

Create a new project or open an existing project.

Click Teams from the project tiles, or click Open from the Teams tile to open the Teams dashboard.

Click the M365 Groups tab.

Click More > Map from File. The New Mapping from File Task wizard starts. Each step is described below:
Mapping file

a. Click Browse and select the CSV mapping file. The selected file name appears next to the
Browse button.

b. Click Next.
Notification

a. Send notification email once the task is completed - select this option to send a notification
email when a mapping task completes.

« Only in a case of failure - select this option to send the email if the mapping task fails to
complete successfully.

b. Recipients - enter the email address of the recipients of this email. You can specify multiple
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recipient email addresses separated by semicolon.

c. Click Next.

9. Schedule

a. Choose from one of three options to schedule the task. The scheduler will be activated only after you
complete the task wizard.

* Run now - task runs immediately.
« Run later - task must be started manually.

« Schedule - task will be started at a future date and time entered in the corresponding
calendar field.

b. Click Next.

10. Summary

a. Verify the task specifications as described below:
i. Name - name of the task. You can specify a custom name.
ii. Source tenant - name of the tenant in this project.
iii. Target tenant - name of the target tenant in this project.

iv. Scheduled start - date and time when the task will start. Now indicates that the task will start
immediately.

b. Click Back to revise or review a previous step or click Finish to complete the task wizard and start
the task as scheduled.

The task is created. You can track its progress from the Tasks tab, view the summary on the Dashboard or monitor
alerts and notifications from the Events tab.

Discovering Chats

On Demand Migration for Teams helps you discover and migrate Chats between one or more matched users from a
source tenant to a target tenant.

In this topic:

Prerequisites

Starting a Chats Discovery Task

Reviewing the Chats Discovery Task
Reviewing the Chats Discovery Task Events

Deleting inactive users

Prerequisites

User accounts in the source tenant must be matched with user accounts in the target tenant. If new users are added
to the source tenant after the Chats discovery task completes, you must match the new users and then rerun
another Chats discovery task. For more information about matching user accounts, see Matching Accounts.
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Starting a Chats Discovery Task

The Chats discovery task returns all matched user accounts with chats.

i NOTE: Chats discovery can also return the number of chats and the most recent activity within the last 30
days. To activate this capability, you must configure Microsoft 365 for the source tenant, as described below:

1. In Microsoft 365 admin center of the source tenant, go to Settings > Org Settings and open the
Services tab.

2. Select Reports, and clear the check box Display concealed user, group, and site names in all
reports. This setting gets applied both to the usage reports in Microsoft 365 admin center and
Teams admin center.

3. Click Save changes.

To discover Chats:

1. Signin to Quest On Demand and choose an organization if you have set up multiple organizations.
From the navigation pane, click Migrate > Projects to open the My Projects list.

Create a new project or open an existing project.

Click the Teams tile, or click Open from the Teams tile to open the Teams dashboard.

Select the Teams tab and then select the Chats tab.

2 T

From the local toolbar, select Discover. The New Chats Discovery Task wizard starts. Each step is
described below:

7. Description

a. Read only. The Chats discovery task will list all user accounts that are matched with a user in the
target tenant.

b. Click Next.
8. Notification

a. Send notification email once the task is completed - select this option to send a notification
email when a discovery task completes.

+ Only in a case of failure - select this option to send the email if the discovery task fails to
complete successfully.

b. Recipients - enter the email address of the recipients of this email. You can specify multiple
recipient email addresses separated by semicolon.

c. Click Next.
9. Schedule

a. Choose from one of three options to schedule the task. The scheduler will be activated only after you
complete the task wizard.

* Run now - task runs immediately.
« Run later - task must be started manually.

« Schedule - task will be started at a future date and time entered in the corresponding
calendar field.

b. Click Next.
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10. Summary

a. Verify the task specifications as described below:

i. Name - name of the task. You can specify a custom name. The default name is
Discover chats.

ii. Source tenant - name of the tenant where the statistics will be collected.
iii. Target tenant - name of the target tenant in this project.

iv. Scheduled start - date and time when the task will start. For example, Now indicates that
the task will start immediately after you complete the wizard.

b. Click Back to revise or review a previous step.

c. Click Finish to complete the task wizard. The task will start as scheduled.

Reviewing the Chats Discovery Task

1.
2.
3.

Open the Tasks tab.
Select the Discover Chats task that you want to review.
In the task details pane that opens, the information presented is as described below:

a. Type - Type of the task. The type is discover teams.

b. Created - Date and time when the task was created.
c. Modified - Date and time when the task was last updated.
d. State - State of the task.

e. Last Operation - The action that was most recently performed in this task.

f. Schedule - Date and time when the task started. For example, Now indicates that the task started
immediately after the task was created.

g. Events (number) - Number indicates the count of events that the task encountered. The values
indicate the type of the events and the event count for each type.

Reviewing the Chats Discovery Task Events

1.
2.
3.

Open the Tasks tab.
Select the task named Discover Chats that you want to review.

In the task details pane that opens, click Events (number). The Events tab opens with a filtered list of events
for the selected task.

Select an event that you want to review. In the task details pane that opens, the information presented is as
described below:

a. Object - name of the user account if applicable.
b. Task - name of the task.

c. Time - date and time when the event occurred.
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d. Category - type of task.

e. Summary - a descriptive statement about the event.

Deleting inactive users

You can delete inactive users from the Chats list view to prevent the migration of the inactive user's personal chats.

To delete inactive users

1. Select one or more users in the list view that you want to delete.
2. Click More > Delete.
3. Click Yes in the Delete Objectspopup to confirm the action.
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Managing Chats with Collections

Migrating large numbers of chats requires careful planning. Organize the user accounts into collections to make
large chat lists more manageable.

Adding chats to Collections
You can add user accounts with chats to collections in three ways:

o Select the user accounts and create a new collection
o Select the user accounts and add to an existing collection

« Use a CSV file to create one or more chat collections

To add selected user accounts to a new collection:

1. From the project dashboard, click Open in the Teams tile to open the Teams workspace.
2. Open the Chats tab and select the user accounts that you want to add to a collection.
3. From the actions toolbar, click New Collection. The New Collection dialog opens.

x

New Collection

20 Objects have been selected to be added to the new collection.

Collection name APAC Sales

4. Enter a collection name in the Collection name field and click Save to add the selected user accounts to the
collection.

To add selected user accounts to an existing collection:

1. From the project dashboard, click Open in the Teams tile to open the Teams workspace.

2. Ifyou need to create a new collection:
a. From the top-right corner of the workspace, click Select Collection >+ New Collection
b. Enter a collection name and click Save to add this collection to the project.

3. Open the Chats tab and select the user accounts that you want to add to the collection.
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4. From the actions toolbar, click Add to Collection. The Add to existing collection dialog opens.
x
Add to existing collection

2 Objects have been selected to be added to the new collection.

Collection name v

5. Select your collection from the Collection name dropdown and click Save to add the selected user
accounts to the collection.

To create one or more collections with a CSV file:
This is a two-step process as described below:
Prepare the CSV file

i NOTE: Using a CSYV file provides the following additional benefits:

o Multiple collections can be created with the same CSV file.
« Existing collections can be specified in the CSV file to add additional user accounts

« Accounts can be listed in multiple collections

Use the format shown below to prepare the CSV file. The minimal set of columns required are shown.

i TIP: You can export the selected user accounts to a CSV file and then add the Collection column
and retain the Source UPN column. All other columns in the exported CSV file will be ignored so you
can remove those columns if you want.

A E

1 |Callection Source UPN
2 APAC 5Sales  AlexW@sourcecorp.onmicrosoft.com
3 |APAC Sales  JoniS@sourcecorp.onmicrosoft.com
4 |APAC Sales DiegoS@sourcecorp.onmicrosoft.com
5 Marketing LynneR@sourcecorp.onmicrosoft.com
& |Marketing IsaiahL@sourcecorp.onmicrosoft.com
7

» Collection - Column header for the collection name

« Source UPN - User Principal Name (UPN) of the source account.

Import the CSV file

1. Login to Quest On Demand and choose an organization if you have multiple organizations.
From the navigation pane, click Migrate > Projects to open the My Projects list.

Create a new project or open an existing project.

A 0D

Click the Teams tile, or click Open from the Teams tile to open the Teams workspace.
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Open the Chats tab.

From the actions toolbar, click More > Import Collections. The Import Collections from File dialog opens.

Select Chats from the Specify kind dropdown.
Click Browse and select the CSV file. The selected CSV file name appears.

Click Import.

NOTE: If a collection in the CSV does not exist, a new collection will be created with the name specified in
the CSV.

To verify the addition of the chat to a collection:

1.

Check the Collections column in the Chats List View that indicates the most recent collection where the
group has been added and the number of additional collections that also contain the chat.

Select a chat from the Chats List View to open the Chat Detail pane. Check the Collections property that
lists all the collections where the chat has been added.

Migrating Chats

In this topic:

Reviewing migration readiness
Considerations

Starting a Chats Migration Task
Reviewing the migration results
Recreating Conversation History Links

Troubleshooting

Reviewing Chats Migration Readiness

NOTE:Chat migrations are heavily throttled by Microsoft on source and target tenants. As a result, migration
throughput performance is very difficult to predict. Quest recommends migrating the last 15 or 30 days of
messages during the last phase of migrations. Use a separate migration task to archive some or all of the
remaining messages for users who require the messages for regulatory or business reasons.

Migration speed for chat messages may decrease with larger data volumes. Quest recommends purchasing
Chat addon licenses which are faster because archiving all remaining messages could take a considerable
amount of time.

Use the following information in the Chats list view to support your decision.

Property Value Description
Workflow Discovered On Demand has discovered the chat.
OneDrive Status Completed The OneDrive migration service has migrated the files for this user. This

must be completed for On Demand to migrate chats for this user. You
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Property Value Description

can migrate OneDrive file sharing permissions before or after the Chats
migration.

Mailbox Status Migrated User mailbox migration is complete and successful.

In addition to the information that you reviewed, verify the following:

« The temporary Migration Service accounts for source and target tenants that you will use to migrate Teams
Chat should be granted the Teams license. You should not change your temporary Migration Service
accounts before completing the migration project.

« The temporary Migration Service accounts should be granted the Global Administrator or Teams
Administrator role on the tenants for which these account are used.

» [optional] Verify that you have Microsoft Teams Private Chat licenses. Check Settings > Subscriptions.

Considerations

« OneDrive accounts must be provisioned in the target tenant.

o ltis a best practice to migrate Chats after all the content like OneDrive, Mailboxes, SharePoint, Teams, etc.,
is migrated and the user accounts are matched.

« During migration, the migration task will migrate any new messages added to Chats after completing a
Discovery task.

« Chats can be migrated multiple times. During remigration, new messages are added to previously migrated
live chats in the target, and new chats that were not migrated before are migrated.

« When you select the Archive remaining messages option in the Migration Actions step of the New Chats
Migration Task wizard, the chat archive file will be uploaded to an available OneDrive of a chat participant,
and shared with other participants. During the process, Microsoft 365 will send a notification email to the
owner of the file.

» Due to Microsoft API limitations, the discovery task is automatically run for all users during a remigration to
discover new messages and new chats. Which is why we don't recommend remigration for small users sets.

Starting a Chats Migration Task

1. Log in to Quest On Demand and choose an organization if you have set up multiple organizations.
From the navigation pane, click Migrate > Projects to open the My Projects list.

Create a new project or open an existing project.

Click Teams from the project tiles, or click Open from the Teams tile to open the Teams workspace.

Select the Chats tab and select the user accounts whose chats you want to migrate.

I

Select Migrate from the action ribbon. The New Chats Migration Task wizard starts. Each step is
described below:

7. Start
a. Task Name - You can specify a custom name. The default name is Migrate chats.

b. Use the settings from an existing migration template for this task - select this option if you
have already saved a previous migration templates. if this is the first time you are migrating
mailboxes, keep this option unchecked.
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Select template - select a template that you previously created, from the dropdown list.

c. Go to Summary step - select this option to preserve the settings and go directly to the last step of
the wizard. If you do not select this option, but you have selected a template, you can step through
the wizard and edit the settings in the template.

d. Click Next.

8. Migration Options

New Chats Migration Task

Start
Migration Options

Migration Actions

Select this option to migrate chats with unmatched or deleted users.
¥| Migrate chats with unmatched or deleted users

Select this option to migrate Chat messages irrespective of the value of the OneDrive Status column in the Chats list
view. This can be used when OneDrive unts are migrated by tools other than On Demand Migration. Links to
OneDrive files attached to chat messages will work when the OneDrive account has been migrated and the files are
successfully migrated to the OneDrive account in the target tenant.

Skip OneDrive status check

Select this option to skip migration of external users in chats. If unselected, external users will get notifications
during chat migration.

¥ Avoid adding external users to target chats in migration

a. Select one or more options as described below:

Migrate chats with unmatched and deleted users - select this option to migrate the chats
with users that have not been matched with a user the target tenant, or deleted in the source
tenant because they have left the organization. The information about the user from the
source tenant is used to migrate the chat.

If this option is not selected, chats that include unmatched or deleted users will not be
migrated. For example, if John chats with Dave, and Dave's user account has deactivated
because he left the organization, then any chat with user Dave will not be migrated.

Skip OneDrive status check - select this option to migrate Chat messages irrespective of
the value of the OneDrive Status column in the Chats list view. This is helpful because
OneDrive accounts could be migrated by tools other than On Demand Migration, and the
OneDrive Status column indicates New instead of Completed. Links to OneDrive files
attached to chat messages will work when the OneDrive account has been migrated and the
files are successfully migrated to the OneDrive account in the target tenant.

Avoid adding external users to target chats - select this option to avoid adding external
users to the chats that are migrated to the target tenant. If this option is not selected, external
users will be added to the migrated chat and they will receive unwanted notifications.

b. Click Next.
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Migration Actions

New Chats Migration Task

Start
¥ Migrate to live chat

Migration Options
. Messages within last 15 days

I Migration Actions
Messages within last 30 days

Natification
Messages within last 60 days
¥/! Archive rermaining messages
. Last 30 days of remaining messages
Last 60 days of remaining messages
Last 90 days of remaining messages
All remaining messages
Create private chat with link to archived messages file

Rearchive and overwrite the target chat archived file if the chat was archived before

a. Select one or more action options as described below:

i. Migrate to live chat - select this option to migrate all or a subset of the chat messages from
the source tenant to the live chat in the target tenant. You choose a subset or all messages
based the date range option as defined below:

+ Messages within last 15 days - the most recent chats within the last 15 days
discovered after the last migration will be migrated.

+ Messages within last 30 days - the most recent chats within the last 30 days
discovered after the last migration will be migrated.

+ Messages within last 60 days - the most recent chats within the last 60 days
discovered after the last migration will be migrated.

Messages are merged into manageable sets and then migrated. The effect of merging
messages is described in the example below:
Consider a set of original messages in the source tenant as shown below:
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2020-10-14, 556 pm.

§  AlanSteiner 20

RTANT:
Good morning

| 0712 1022 4 (1]

URGENT!
How are you Alicia

§  AlsnSteiner 0712
Hey Alan'S

all goad

=] 2020-monthily-us-holidays-calen...

When the message set is merged and migrated, they appear in the target tenant as shown
below. The migration service determines the merge set. Messages retain their chronological
order and the time stamp is converted to GMT.

Migration Account 7/28 4:24 AM
MA
Alan Steiner Wed, 14 Oct 2020 09:55:23 GMT

Alan Steiner Wed, 14 Oct 2020 09:55:30 GMT

e, hurry dow be quick; and stay among the trees till h

Alicia Thomber Wed, 14 Oct 2020 09:56:12 GMT

Alicia Thomber Wed, 14 Oct 2020 09:56:27 GMT

Alan Steiner Wed, 14 Oct 2020 09:56:43 GMT

Alicia Thomber Wed, 14 Oct 2020 09:56:51 GMT
Mot for one minute
Alan Steiner Wed, 14 Oct 2020 09:57:13 GMT

Linto up immediate

IMPORTANT! o

Alicia Thomber Mon, 12 Jul 2021 02:22:42 GMT
Good marning

URGENT! 0

Alicia Thomber Mon, 12 Jul 2021 02:23:02 GMT
How are you Alicia

Alan Steiner Mon, 12 Jul 2021 02:26:04 GMT
Hey Alan'&

Alan Steiner Mon, 12 Jul 2021 02:27:27 GMT

Archive remaining messages - select this option to archive the rest of the chat messages.
These messages are archived as an HTML file and are uploaded to an available OneDrive
selected from chat participants. Permission to view the HTML file is granted to other chat
participants.
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NOTE: Chat migrations are heavily throttled on source and target tenants. Migration
throughput performance is very difficult to predict. Quest recommends migrating the
last 15 or 30 days of messages during the last phase of migrations. Use a separate
migration task to archive some or all of the remaining messages for users who require
the messages for regulatory or business reasons.

You can exercise greater granular control over the remaining messages using the time-

range

options described below:

Last 30 days of remaining messages - the most recent 30 days of messages that
remain to be migrated will be archived.

Last 60 days of remaining messages - the most recent 60 days of messages that
remain to be migrated will be archived.

Last 90 days of remaining messages - the most recent 90 days of messages that
remain to be migrated will be archived.

All remaining messages - all messages that remain to be migrated will be archived.

Additional options:

Create private chat with link to archived messages file - selecting this option
creates a private chat message in the target tenant with the members of the original
chat. The chat message contains a link to the archived messages (HTML) file that is
uploaded to the Microsoft Teams Chat Files folder on an available OneDrive selected
from chat participants. Clearing this option creates the archived messages (HTML)
file with appropriate permissions without a private chat message.

The archived messages file appears in the OneDrive with the naming convention:
<chat name or first 3 member names> + current date + random
munber + <-archivedchat.html>

Thelink is named Conversation History.
* | NOTE: If there are changes to the target users' domain, UPN, alias etc., then

the archive link to the archived file will not work. To recreate the link in the
migrated chat, use the New Recreate Conversation History Link Task wizard.

Use additional Team Chats licenses for faster archiving - select this option to
increase the throughput for archiving remaining chat messages.
« This option is displayed when
« additional chat licenses are detected, and

« Migrate to live chat option is not selected.

TIP: Migration speed for chat messages may decrease with larger
data volumes. If you want to migrate live chats and use additional chat
licenses to faster archiving, then start two separate chat migration
tasks: one task for migrating live chats, and the other task for fast
archiving with additional licenses.

Rearchive and overwrite the target chat archived file if the chat was
archived below - select this option to rearchive and overwrite any previously
archived chat file in the target tenant. This option will respect the time-range
selected in previous options.
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Example 1: Assume that you are migrating chats on June 30.
If you select Migrate to live chat and Messages within 15 days, then all chat messages
from June 16 to June 30 will be migrated to the live chat in the target tenant.

June 30

remaining messages migrated

June 16

If you also select Archive remaining messages and Last 30 days of remaining
messages, any remaining chats from May 17 to June 15 will be archived as an HTML file in
the target tenant. Chats before May 17 will not be migrated.

L. June 30
remaining messages

ignored archived migrated

bay 17 June 16

If you also select Create private chat with link to archived messages file, a chat
message with a link named Conversation History is created in the chat that links to the
archived HTML file.
Example 2: Assume that you migrated and archived chat messages previously on June 30
and are migrating chats again on July 5.
If you select Migrate to live chat and Messages within 15 days, only new chats
discovered after June 30 (July 1 to July 5) will be migrated to the live chat in the target tenant
because migration service remembers the previous migration. Chats from June 21 (last 15
days) to June 30 (previous migration date) cannot be remigrated to the live chat.

June 30 July 5

ignored previously archived prev. migrated migrated

bay 17 June 16

If you also select Archive remaining messages and All remaining messages no chat
messages will be archived because you cannot archive any messages before June 30 even
though there could be messages remaining that were not previously archived.

June 30 July 5

ignored previously archived prev. migrated migrated

bay 17 June 16

b. Click Next.
10. Notification

a. Send notification email once the task is completed - select this option to send a notification
email when a migration task completes.

« Only in a case of failure - select this option to send the email if the migration task fails to
complete successfully.
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b. Recipients - enter the email address of the recipients of this email. You can specify multiple
recipient email addresses separated by semicolon.

c. Click Next.

11. Reporting
Select the check box Generate detailed report of migration errors to generate a migration error report
when you run the migration task.
You can download the report from the Reports tab of the Teams workspace by clicking the Download link in
the Error Log column. If there are no migration errors, a download link is not available. Error reports are
retained for 30 days. After 30 days the download link is replaced with the label Expired and you can no
longer download the report. For more information about error reports, see Reports.

12. Schedule

a. Choose from one of three options to schedule the task. The scheduler will be activated only after you
complete the task wizard.

¢ Run now - task runs immediately.
* Run later - task must be started manually.

« Schedule - task will be started at a future date and time entered in the corresponding
calendar field.

o Priority - select a priority from the dropdown for the objects scheduled for migration with this
task . Values are: Highest, High, Medium, Low and Lowest. The default priority is Medium.
If the system is busy, the objects are queued (Migration state = Queued). When the system
accepts new migration work, objects are taken from the queue based on the assigned priority
and age in the queue.

b. Click Next.
13. Summary

a. Save task settings as a migration template - select this option to save the settings in this wizard
as a reusable migration template.

+ Migration Template Name - specify a name for the template. If you have changed the
settings of a preselected template, specify the same template name to apply the changes to
the template when you complete the wizard. All saved templates are displayed in the
Templates tab.

b. Verify the task specifications as described below:

a. Name - name of the task. You can specify a custom name. The default name is
Migrate chats.

b. Source tenant - name of the source tenant for the chats.
c. Target tenant - name of the target tenant where the chats will be migrated.

d. Scheduled start - date and time when the task will start. For example, Now indicates that
the task will startimmediately after you complete the wizard.

c. Click Finish to complete the task wizard. The task will start as scheduled.

The migration task is created. You can track its progress from the Tasks tab, view the summary on the Dashboard
or monitor alerts and notifications from the Events tab.
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Reviewing the Migration Results

Once the migration task is complete, use the information on the Chats tab to verify the success of the migration. The
column in the chats migration list view are as follows:

« User Name - name of the user from the source tenant.
« Migration State - status of the task in the migration process. Values are as listed below:
« Discovered
« Migrating
« Partially migrated
o Partially migrated with issues
o Migrated
« Migrated with issues
» Migration failed
+ Workflow - the most recent operation performed on the group. Valid values are
« migrated - when all discovered chats have migrated.

« partially migrated - when some chats failed to migrate. The number of migrated chats is fewer than
the total number of chats.

« Migrated Chats - number of chats migrated for the user. This may be fewer than the total number of chats. If
a participant is not matched or OneDrive not migrated then migration of the chat is intentionally skipped and
the event documented on the Events tab.

« Archived Chats - indicates whether or not chats have been archived. When chats are migrated and
archived, the value changes to Yes for the selected user. Since chats can be archived only once, if you
attempt to re-archive migrated chats, a warning message appears in the migration task events.

+ Source UPN - UserPrincipalName (UPN) of the source account.

« Target UPN - UserPrincipalName (UPN) of the target account.

Recreating Conversation History Links

When there are changes to the target domain due to a domain move, changes to user UPNs, aliases etc., the link to
the archived file in private chats that are migrated to the target tenant will not work. To recreate the link in the
migrated chat, use the New Recreate Conversation History Link Task wizard as described below:

= | NOTE: The task can only recreate links for chats which were archived with the Create private chat with
link to archived messages file option in the New Chats Migration Task wizard.
1. Select the Chats tab.

2. Select More > Recreate Conversation History Link from the Actions menu. The Recreate Conversation
History Link Task wizard starts. Each step is described below:

3. Description

a. Click Next.
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4. Notification

a. Send notification email once the task is completed - select this option to send a notification
email when a migration task completes.

« Only in a case of failure - select this option to send the email if the migration task fails to
complete successfully.

b. Recipients - enter the email address of the recipients of this email. You can specify multiple
recipient email addresses separated by semicolon.

c. Click Next.
5. Schedule

a. Choose from one of three options to schedule the task. The scheduler will be activated only after you
complete the task wizard.

¢ Run now - task runs immediately.
* Run later - task must be started manually.

« Schedule - task will be started at a future date and time entered in the corresponding
calendar field.

o Priority - select a priority from the dropdown for the objects scheduled for migration with this
task . Values are: Highest, High, Medium, Low and Lowest. The default priority is Medium.
If the system is busy, the objects are queued (Migration state = Queued). When the system
accepts new migration work, objects are taken from the queue based on the assigned priority
and age in the queue.

b. Click Next.
6. Summary
a. Verify the task specifications as described below:

a. Name - name of the task. You can specify a custom name. The default name is Recreate
Conversation History Link.

b. Source tenant - name of the source tenant.
c. Target tenant - name of the target tenant.

d. Scheduled start - date and time when the task will start. For example, Now indicates that
the task will start immediately after you complete the wizard.

b. Click Finish to complete the task wizard. The task will start as scheduled.

Troubleshooting

Chats may not be successfully migrated due to a variety of reasons. Two example are described below.
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Example 1: Members of a chat have not been matched or migrated to the
target tenant.

Migration > New Migration Project - Test > Teams F Select Collection -
DASHBOARD TEAMS ~ M365GROUPS  CHATS  EVENTS
Any - Any -
Q DISCOVER ers Q Search
User Name Migration State Workflow Account Matching OneDrive Status Migrated. Source UPN Target UPN
Joni Sherman Migraticn failed @ Discovered @ Completed Q New - JeniS@M3E5x925423.0nMicrosoft.com JoniS@M365:
MOD Administrator © Discovered © nNew © New admin@M365x925423.onmicrosoft.com

This is a common case where one or more members are not available in the target tenant. In such a case, the chat
will not be migrated. In this example, the chat migration for Joni Sherman indicates a failure. The Status column
indicates Migration failed. Jonihas been chatting with the Administrator. However the Administrator account
has not been matched or migrated to the target tenant.

When you inspect the migration task details, it will indicate a failure. You can click the event icons to get more
information about the failure.

x
o Migrate Chats
Type migratechats
Created Tuesday, July 13, 2021 10:36 PM
Modified Tuesday, July 13, 2021 10:36 PM
Status Completed
Last Operation  Migrated 0 chat(s)
Schedule Now
Chats (1) New a
In Progress 0]
Failed e
Completed 0
Events (8) 002

Resolution: When accounts are missing from the target tenant, you must map or migrate the account and rerun the
chat migration task.
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Example 2: An error in a chat message prevents all subsequent chat messages
from being migrated.

Migration » New Migration Project - Test » Teams = Select Collection -
DASHBOARD TEAMS M365 GROUPS CHATS EVENTS TASKS
Any - Any -
Q DISCOVER MIGRATE E3 NEW COLLECTION 2 EXPORT 2 users, 1selected |Q
(] User Name & Migration State Workflow Account Matching OneDrive Status Migrated Chats
(] Joni Sherman Migration parti... @ Ppartially Migra... @ Completed Q New 3
(] MOD Administrator @ completed @ completed @ new 5

In this example, chats for Joni Sherman indicate a migration problem. The Status column indicates Migration
partially failed. There are 36 chat messages but only 3 messages could be migrated. The migration task
completes successfully but no more messages are migrated. The service account that is used to migrate the chat
remains as a member of the chat in the target tenant.

When you inspect the migration task, you will notice that the task has completed successfully, but there are error
events in the task detail.

The Events list will indicate the error event, but more importantly you will notice that no more messages are
migrated after the error event.

Resolution: Inspect the chat messages of the user and resolve the issue. Then rerun the migration task for the same
user. If you are unable to address the issues with chat messages, contact Quest Technical Support.
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Microsoft 365 Groups Migration

On Demand Migration for Teams securely migrates content for Microsoft 365 Groups without Teams
functionality across Microsoft 365 tenants. You can also use this dashboard for migration of Microsoft Teams
and associated Microsoft 365 Groups migration (see Microsoft Teams Migration). Microsoft Teams migration
requires additional licensing.

The basic Microsoft 365 Groups (without associated Teams) migration process consists of the following steps:

# Step
1 Create a new migration project or open an existing project.
2 Grant necessary permissions in case these permissions are not already granted.
3 Discover Microsoft 365 Groups (without associated Teams) in the source tenant. These groups

are not provisioned in the target tenant at this stage.

4 Provision groups in the target tenant.

« The temporary Migration Service account in the source tenant will be added to all source
Microsoft 365 Groups as a member

« The temporary Migration Service account in the target tenant will be added to all migrated
target Microsoft 365 Groups as a member and owner.

These accounts can be removed from groups after the migration is completed.
5 Migrate Microsoft 365 Groups without Teams functionality

6 Automatically migrate files associated with content. All files associated